
KUKA System Technology
KUKA.WorkVisual 5.0
For KUKA System Software 8.2, 8.3 and 8.5
For VW System Software 8.2 and 8.3

Issued: 12.07.2018
KST WorkVisual 5.0 V7
KUKA Deutschland GmbH



KUKA.WorkVisual 5.0

2/230 | www.kuka.com KST WorkVisual 5.0 V7 | Issued: 12.07.2018

© Copyright 2018
KUKA Deutschland GmbH
Zugspitzstraße 140
D-86165 Augsburg
Germany

This documentation or excerpts therefrom may not be reproduced or disclosed to third parties
without the express permission of KUKA Deutschland GmbH.
Other functions not described in this documentation may be operable in the controller. The user
has no claims to these functions, however, in the case of a replacement or service work.
We have checked the content of this documentation for conformity with the hardware and soft-
ware described. Nevertheless, discrepancies cannot be precluded, for which reason we are not
able to guarantee total conformity. The information in this documentation is checked on a regu-
lar basis, however, and necessary corrections will be incorporated in the subsequent edition.
Subject to technical alterations without an effect on the function.
KIM-PS5-DOC
Translation of the original documentation

Publication: Pub KST WorkVisual 5.0 (PDF) en

PB7090

Book structure: KST WorkVisual 5.0 V7.1

BS6610

Version: KST WorkVisual 5.0 V7



Contents

1 Introduction.............................................................................................. 10
1.1 Target group.......................................................................................................... 10
1.2 Representation of warnings and notes................................................................. 10
1.3 Trademarks............................................................................................................ 11
1.4 Licenses................................................................................................................. 11
1.5 Terms used............................................................................................................ 11

2 Product description................................................................................. 12
2.1 Overview of WorkVisual........................................................................................ 12
2.2 Additional software................................................................................................ 13
2.3 Intended use of WorkVisual.................................................................................. 13

3 Safety......................................................................................................... 14

4 Installation................................................................................................ 16
4.1 PC system requirements....................................................................................... 16
4.2 System requirements, robot controller.................................................................. 16
4.3 Installing WorkVisual............................................................................................. 16
4.4 Uninstalling WorkVisual......................................................................................... 18
4.5 Creating and starting a portable version.............................................................. 18

5 Graphical user interface......................................................................... 20
5.1 Overview of the graphical user interface.............................................................. 20
5.2 Displaying/hiding windows..................................................................................... 21
5.3 Repositioning the windows.................................................................................... 21
5.4 Displaying different views of the user interface................................................... 23
5.5 Displaying/hiding buttons....................................................................................... 24
5.6 Button bar.............................................................................................................. 24
5.7 Message window window...................................................................................... 28
5.8 Project structure window....................................................................................... 29
5.9 Cell configuration window..................................................................................... 30
5.9.1 Repositioning objects............................................................................................ 30
5.10 Resetting the graphical user interface.................................................................. 31

6 Operation.................................................................................................. 32
6.1 Starting WorkVisual............................................................................................... 32
6.2 Opening a project.................................................................................................. 32
6.3 Creating a new project.......................................................................................... 33
6.3.1 Creating a new empty project............................................................................... 33
6.3.2 Creating a project with a template....................................................................... 33
6.3.3 Creating a project on the basis of an existing project......................................... 33
6.4 Saving project information..................................................................................... 34
6.5 Saving the project................................................................................................. 34
6.6 Closing the project................................................................................................ 35
6.7 Closing WorkVisual................................................................................................ 35
6.8 Importing device description files.......................................................................... 35
6.9 Catalogs................................................................................................................. 36
6.9.1 Updating the DtmCatalog (catalog scan)............................................................. 36

KUKA.WorkVisual 5.0

KST WorkVisual 5.0 V7 | Issued: 12.07.2018 www.kuka.com | 3/230



6.9.2 Inserting a catalog in a project............................................................................. 36
6.9.3 Adding a catalog................................................................................................... 37
6.9.4 Removing a catalog from the project................................................................... 37
6.9.5 Catalog descriptions (8.2)..................................................................................... 37
6.9.6 Catalog descriptions (8.3 or higher)..................................................................... 38
6.10 Inserting an element in the project....................................................................... 38
6.11 Removing an element from the project................................................................ 39
6.12 Inserting a robot controller.................................................................................... 39
6.13 Setting the robot controller to active/inactive....................................................... 40
6.14 Changing the values “Firmware version” and/or “Number of I/Os...................... 41
6.15 Assigning a robot to the robot controller.............................................................. 41
6.16 Activating additional controller settings................................................................. 42
6.16.1 Setting the cycle time of the Transfer application................................................ 42
6.16.2 Activating the brake test....................................................................................... 43
6.16.3 Changing the number of TOOL and BASE coordinate systems......................... 43
6.17 Configuring the brake test..................................................................................... 44
6.18 Inserting a safety option and/or PROCONOS...................................................... 45
6.19 Inserting hardware components............................................................................ 45
6.20 Inserting an external axis...................................................................................... 47
6.21 Editing machine data for external axes (8.2)....................................................... 48
6.22 Editing machine data (8.3 or higher).................................................................... 49
6.23 Comparing kinematic systems (and accepting differences)................................. 51
6.24 Updating machine data......................................................................................... 54
6.25 Exporting kinematic systems to a catalog............................................................ 54
6.26 Editing TOOL and BASE coordinate systems...................................................... 55
6.26.1 Opening tool/base management........................................................................... 55
6.26.2 Configuring tool/base management...................................................................... 57
6.26.3 TOOL and BASE coordinate systems.................................................................. 57
6.26.4 Objects................................................................................................................... 58
6.26.5 Updating TOOL and BASE coordinate systems.................................................. 60
6.26.6 Importing TOOL and BASE coordinate systems.................................................. 60
6.26.7 Converting TOOL and BASE coordinate systems............................................... 61
6.26.8 Exporting objects to a catalog.............................................................................. 61
6.26.9 Importing objects from a catalog.......................................................................... 62
6.26.10 Copying and pasting measurement data.............................................................. 62
6.26.11 Displaying usages of TOOL and BASE coordinate systems............................... 63
6.27 Comparing files...................................................................................................... 63
6.28 Copying data from a file to the project................................................................ 63
6.28.1 Copying data from a DAT file to the project with WorkVisual............................. 64
6.29 Defining cells online.............................................................................................. 65
6.29.1 Opening the cell definition.................................................................................... 65
6.29.2 Configuring a cell definition................................................................................... 66
6.29.3 Editing cells........................................................................................................... 66
6.30 Option packages.................................................................................................... 67
6.30.1 Option profiles....................................................................................................... 67
6.30.2 Creating and activating an option profile.............................................................. 69
6.30.3 Installing an option package in WorkVisual.......................................................... 69
6.30.4 Updating an option package................................................................................. 70
6.30.5 Uninstalling the option package............................................................................ 70

KUKA.WorkVisual 5.0

4/230 | www.kuka.com KST WorkVisual 5.0 V7 | Issued: 12.07.2018



6.30.6 Loading an option package from a robot controller............................................. 71
6.30.7 Inserting an option package in a project.............................................................. 71
6.30.8 Removing an option package from the project.................................................... 72
6.30.9 Adding a device from an option package to the robot controller........................ 73
6.30.10 Exporting files from an option package................................................................ 74
6.31 Inspecting projects................................................................................................. 74
6.31.1 Creating an inspection plan.................................................................................. 76
6.31.2 Configuring a predefined inspection function....................................................... 77
6.31.3 Executing an inspection plan................................................................................ 78
6.31.4 Inspecting multiple projects simultaneously.......................................................... 79
6.32 Managing updates................................................................................................. 80
6.32.1 Opening the Update Manager.............................................................................. 80
6.32.2 Adding a robot controller....................................................................................... 81
6.32.3 Adding multiple robot controllers at the same time............................................. 81
6.32.4 Saving and loading the list of robot controllers................................................... 82
6.32.5 Entering user credentials...................................................................................... 83
6.32.6 Displaying information about the update jobs...................................................... 83
6.33 Making an update bundle..................................................................................... 84
6.33.1 Creating an update bundle................................................................................... 84
6.33.2 Adding option packages to the update bundle and configuring them................. 86
6.33.3 Adding instructions to the update bundle and configuring them......................... 87
6.33.4 Changing settings for the update bundles........................................................... 88
6.34 Distributing updates over the network.................................................................. 89
6.34.1 Creating a rollout................................................................................................... 89
6.34.2 Adding robot controllers to the rollout.................................................................. 91
6.34.3 Entering user credentials...................................................................................... 92
6.34.4 Starting a rollout.................................................................................................... 93
6.34.5 Displaying information about the completed update job...................................... 93
6.35 Exporting a subproject.......................................................................................... 94
6.36 Importing a subproject........................................................................................... 94
6.37 Changing predefined properties of WorkVisual.................................................... 95
6.37.1 Configuring booting and saving characteristics.................................................... 95
6.37.2 Configuring keyboard shortcuts............................................................................ 96
6.37.3 Changing the user interface language................................................................. 96
6.37.4 Configuring additional editors................................................................................ 97
6.37.5 Configuring the comparison of kinematic systems............................................... 97
6.37.6 Configuring code generation................................................................................. 98
6.38 Print functions........................................................................................................ 99

7 Start-up...................................................................................................... 100
7.1 Establishing a connection to the robot controller................................................. 100

8 Safety configuration................................................................................ 101
8.1 Safety configuration in WorkVisual....................................................................... 101
8.2 Editing the local safety configuration.................................................................... 101
8.3 Parameters of the local safety configuration........................................................ 102
8.3.1 “General” tab (8.2)................................................................................................. 102
8.3.2 “General” tab (8.3 or higher)................................................................................. 103
8.3.3 “Axis monitoring” tab (8.3 or higher).................................................................... 104

KUKA.WorkVisual 5.0

KST WorkVisual 5.0 V7 | Issued: 12.07.2018 www.kuka.com | 5/230



8.3.3.1 Parameter Braking time........................................................................................ 105
8.3.3.2 Parameter: Maximum velocity T1......................................................................... 106
8.3.3.3 Checking the limits for the maximum axis velocity in T1 mode.......................... 107
8.4 Importing the safety configuration (SCG import).................................................. 109
8.5 Exporting the safety configuration (SCG export)................................................. 109
8.6 Importing a safety configuration (XML import)..................................................... 110
8.7 Exporting the safety configuration (XML export).................................................. 112
8.8 Comparing the safety configuration...................................................................... 112
8.9 Resetting the safety configuration........................................................................ 113

9 Field bus configuration........................................................................... 114
9.1 Overview of field buses......................................................................................... 114
9.2 Field bus set-up..................................................................................................... 114
9.2.1 Overview: field bus set-up.................................................................................... 114
9.2.2 Inserting a field bus master in a project.............................................................. 115
9.2.3 Configuring the field bus master........................................................................... 115
9.2.4 Inserting devices manually into the bus............................................................... 116
9.2.5 Configuring devices............................................................................................... 116
9.2.6 Automatically inserting devices into the bus (Bus Scan)..................................... 116
9.3 Editing field bus signals........................................................................................ 117
9.3.1 Signal Editor.......................................................................................................... 118
9.3.2 Changing the bit width of signals......................................................................... 119
9.3.3 Swapping signals (reversing the byte order)........................................................ 120
9.3.4 Changing the data type......................................................................................... 121
9.3.5 Changing signal names......................................................................................... 121
9.4 Mapping the bus I/Os............................................................................................ 122
9.4.1 I/O Mapping window.............................................................................................. 122
9.4.2 Buttons in the I/O Mapping window..................................................................... 123
9.4.3 Mapping input to output........................................................................................ 124
9.4.4 Mapping bus inputs to bus outputs by means of I/O linking (8.2)...................... 125
9.4.5 Mapping bus inputs to bus outputs using the transfer application (8.3 or high-

er)........................................................................................................................... 126
9.4.6 Multiple mapping or reverse mapping of signals via I/O linking.......................... 127
9.4.7 Searching for assigned signals............................................................................. 127
9.4.8 Grouping signals.................................................................................................... 128
9.4.9 Editing analog KRC signals.................................................................................. 129
9.5 Exporting the bus configuration............................................................................ 129

10 Long texts................................................................................................. 131
10.1 Displaying / editing long texts............................................................................... 131
10.2 Importing long texts............................................................................................... 131
10.3 Exporting long texts............................................................................................... 132

11 Configuring KUKA buses: controller bus, system bus, extension
bus............................................................................................................. 134

11.1 Overview................................................................................................................ 134
11.2 Configuring the KUKA bus (8.2)........................................................................... 134
11.2.1 Inserting devices on the KUKA bus (8.2)............................................................. 134
11.2.2 Checking the device settings................................................................................ 136
11.2.3 Connecting devices on the KUKA bus................................................................. 136

KUKA.WorkVisual 5.0

6/230 | www.kuka.com KST WorkVisual 5.0 V7 | Issued: 12.07.2018



11.2.4 “Topology” tab........................................................................................................ 137
11.2.5 Inserting the wagon driver configuration.............................................................. 138
11.3 Configuring the KUKA bus (8.3 or higher)........................................................... 139
11.4 Assigning FSoE slave addresses......................................................................... 139
11.4.1 FSoE addresses.................................................................................................... 142
11.4.2 Determining the serial number for the Lenze KSP/KPP...................................... 143
11.4.3 Determining the serial number of the RDC.......................................................... 143

12 RoboTeam................................................................................................. 145

13 Programming............................................................................................ 146
13.1 Creating a program............................................................................................... 146
13.2 Importing a program.............................................................................................. 146
13.3 Searching and replacing within files..................................................................... 146
13.4 KRL Editor............................................................................................................. 147
13.4.1 Opening a file in the KRL Editor.......................................................................... 147
13.4.2 KRL Editor user interface...................................................................................... 148
13.4.3 Zooming in/out....................................................................................................... 149
13.4.4 Configuring KRL Editor......................................................................................... 149
13.4.5 Edit functions......................................................................................................... 150
13.4.5.1 General edit functions........................................................................................... 150
13.4.5.2 Snippets – Fast entry of KRL instructions........................................................... 151
13.4.5.3 Renaming a variable............................................................................................. 152
13.4.5.4 Offsetting points..................................................................................................... 152
13.4.5.5 Modifying values of external axes........................................................................ 153
13.4.5.6 Modifying TOOL and BASE coordinate systems................................................. 155
13.4.5.7 Auto-complete........................................................................................................ 156
13.4.6 Folds...................................................................................................................... 156
13.4.7 Jumping to the declaration of a variable.............................................................. 157
13.4.8 Displaying all uses of a variable........................................................................... 157
13.4.9 Quickfix correction................................................................................................. 157
13.4.9.1 Correcting or automatically declaring undeclared variables................................ 158
13.4.9.2 Removing unused variables.................................................................................. 158
13.4.9.3 Standardizing the upper/lower case in a variable name..................................... 159
13.4.10 Creating user-specific snippets............................................................................. 160
13.5 Working online with the KRC Explorer................................................................. 162
13.5.1 Opening the working directory in the KRC Explorer............................................ 163
13.5.2 KRC Explorer user interface................................................................................. 164
13.5.2.1 Button bar in KRC Explorer.................................................................................. 164
13.5.2.2 Icons in KRC Explorer.......................................................................................... 165
13.5.3 Configuring KRC Explorer..................................................................................... 166
13.5.4 General edit functions........................................................................................... 166
13.5.5 Creating a new file with template......................................................................... 167
13.5.6 Transferring changes to the robot controller........................................................ 167
13.5.7 Loading changes from the robot controller.......................................................... 168
13.5.8 Restoring the state of the robot controller........................................................... 169
13.5.9 Comparing files...................................................................................................... 169
13.5.10 Copying data from a file to the working directory................................................ 170
13.5.11 Copying data from a DAT file to the working directory with WorkVisual............ 170

KUKA.WorkVisual 5.0

KST WorkVisual 5.0 V7 | Issued: 12.07.2018 www.kuka.com | 7/230



13.6 Debugging programs............................................................................................. 171
13.6.1 Overview of the debugging mode......................................................................... 172
13.6.2 Starting the debugging mode................................................................................ 173
13.6.3 Monitoring variables.............................................................................................. 174
13.6.4 Ending the debugging mode................................................................................. 176

14 Transferring and activating a project.................................................... 177
14.1 Generating code.................................................................................................... 177
14.2 Pinning a project................................................................................................... 178
14.3 Assigning the robot controller to the real robot controller................................... 178
14.4 Transferring the project to the robot controller..................................................... 180
14.5 Activating a project................................................................................................ 183
14.5.1 Activating a project (in WorkVisual)...................................................................... 183
14.6 Checking the safety configuration of the robot controller.................................... 185
14.7 Loading the project from the robot controller....................................................... 186
14.8 Comparing projects (and accepting differences).................................................. 186
14.9 Copying data from a different project................................................................... 189
14.10 Updating the project.............................................................................................. 192

15 Diagnosis.................................................................................................. 194
15.1 Project analysis..................................................................................................... 194
15.1.1 Analyzing a project automatically for errors......................................................... 194
15.1.2 Configuring the project analysis function.............................................................. 195
15.2 Trace...................................................................................................................... 195
15.2.1 Configuring and starting the trace recording........................................................ 196
15.2.2 Importing a trace configuration............................................................................. 196
15.2.3 Exporting a trace configuration............................................................................. 197
15.2.4 Modifying default settings of the trace configuration........................................... 197
15.2.5 “Trace configuration” window................................................................................ 198
15.2.5.1 “General” tab......................................................................................................... 198
15.2.5.2 “Trigger” tab........................................................................................................... 199
15.2.5.3 “I/O” tab................................................................................................................. 200
15.2.5.4 “Configuration” tab................................................................................................. 201
15.2.5.5 “Advanced configuration” tab................................................................................ 202
15.2.6 Importing a trace recording................................................................................... 203
15.2.7 Displaying a trace recording................................................................................. 204
15.2.8 “Trace Analysis (Oscilloscope)” window............................................................... 205
15.2.8.1 “Channels” tab....................................................................................................... 205
15.2.8.2 “Oscilloscope” tab.................................................................................................. 206
15.2.9 Panning and zooming the oscilloscope display................................................... 207
15.2.10 Creating a screenshot of the oscilloscope display............................................... 208
15.3 Recording network traffic...................................................................................... 208
15.4 Displaying messages and system logs of the robot controller............................ 210
15.4.1 MessageLogs tab.................................................................................................. 211
15.4.2 “SystemLogs” tab.................................................................................................. 212
15.5 Displaying diagnostic data about the robot controller.......................................... 213
15.5.1 Diagnostic data for the transfer application module............................................ 215
15.6 Displaying online system information................................................................... 216

16 KUKA Service........................................................................................... 219

KUKA.WorkVisual 5.0

8/230 | www.kuka.com KST WorkVisual 5.0 V7 | Issued: 12.07.2018



16.1 Requesting support............................................................................................... 219
16.2 KUKA Customer Support...................................................................................... 219

Index 227

KUKA.WorkVisual 5.0

KST WorkVisual 5.0 V7 | Issued: 12.07.2018 www.kuka.com | 9/230



1 Introduction

1.1 Target group

This documentation is aimed at users with the following knowledge and
skills:

• Advanced knowledge of the robot controller system
• Advanced knowledge of bus technologies

For optimal use of our products, we recommend that our customers
take part in a course of training at KUKA College. Information about the
training program can be found at www.kuka.com or can be obtained di-
rectly from our subsidiaries.

1.2 Representation of warnings and notes

Safety

These warnings are relevant to safety and must be observed.

DANGER
These warnings mean that it is certain or highly probable that death or
severe injuries will occur, if no precautions are taken.

WARNING
These warnings mean that death or severe injuries may occur, if no
precautions are taken.

CAUTION
These warnings mean that minor injuries may occur, if no precautions
are taken.

NOTICE
These warnings mean that damage to property may occur, if no pre-
cautions are taken.

These warnings contain references to safety-relevant information or
general safety measures.
These warnings do not refer to individual hazards or individual precau-
tionary measures.

This warning draws attention to procedures which serve to prevent or rem-
edy emergencies or malfunctions:

SAFETY INSTRUCTION
The following procedure must be followed exactly!

Procedures marked with this warning must be followed exactly.

Notices

These notices serve to make your work easier or contain references to
further information.

Tip to make your work easier or reference to further information.
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1.3 Trademarks

Windows is a trademark of Microsoft Corporation.
Pentium is a trademark of Intel Corporation.
Step 7 is a trademark of Siemens AG.
PC WORX is a trademark of Phoenix Contact.

1.4 Licenses

This KUKA software product uses open-source software. The licensing
terms are displayed during installation of the KUKA software product.

1.5 Terms used

Term Description

CK Customer-built Kinematics

DTM Device Type Manager

KCP KUKA Control Panel

General name for KUKA teach pendants

KLI KUKA Line Interface

The KLI is the Ethernet interface of the ro-
bot controller for external communication. It
is a physical interface and can contain mul-
tiple virtual interfaces. The KLI is
configured in the KUKA System Software.

KRL KUKA robot programming language (KUKA
Robot Language)

KSI KUKA Service Interface

Interface on the CSP on the control cabinet

The WorkVisual PC can either connect to
the robot controller via the KLI or it can be
plugged into the KSI.

KSS KUKA System Software

KUKA smartHMI Name of the graphical user interface for the
(V)KR C4 robot controller

KUKA smartPAD Name of the KCP for the (V)KR C4 robot
controller

OPS Offline Programming System

Also called “Office PC”.

Safety options Generic term for options which make it pos-
sible to configure additional safe monitoring
functions in addition to the standard safety
functions.

Example: SafeOperation
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2 Product description

2.1 Overview of WorkVisual

The WorkVisual software package is the engineering environment for
KR C4-controlled robotic cells. It offers the following functionalities:

• Configuring and connecting field buses
• Programming robots offline
• Configuring machine data
• Configuring RoboTeams offline
• Editing the safety configuration
• Editing TOOL and BASE coordinate systems
• Defining robot cells online
• Transferring projects to the robot controller
• Loading projects from the robot controller
• Comparing a project with another project and accepting differences

where necessary
• Merging projects
• Inspecting projects
• Managing long texts
• Managing option packages
• Managing updates
• Diagnostic functionality
• Online display of system information about the robot controller
• Configuring traces, starting recordings, evaluating traces (with the os-

cilloscope)
• Creating and editing KRL programs
• Editing the file system of the robot controller online
• Debugging KRL programs

WorkVisual 5.0 can be installed on the PC at the same time as a lower
version of WorkVisual. Only one version can be run at any given time,
however. WorkVisual 5.0 also contains a program for creating a portable
version.

Fig. 2-1: WorkVisual graphical user interface
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2.2 Additional software

The WorkVisual software package contains the following additional soft-
ware:

Name Description

Backup
Manager

Software with which projects, option packages and RDC
data can be backed up and restored. Following
installation of WorkVisual, it is available as standard in the
directory C:\Program Files (x86)\KUKA\WorkVisual [...]
\Tools\BackupTools. This software can also be used to
perform backups on multiple robot controllers simultane-
ously. Further information about this software is contained
in the file Readme.txt.

Project ex-
tractor

Software with which files from the WorkVisual project can
be extracted to a freely selected directory. Following in-
stallation of WorkVisual, it is available as standard in the
directory C:\Program Files (x86)\KUKA\WorkVisual [...]
\Tools\ProjectExtractor. Further information about this soft-
ware is contained in the file Readme.txt.

2.3 Intended use of WorkVisual

Use

The WorkVisual software package is intended exclusively for the configu-
ration, programming and diagnosis of a KUKA industrial robot or custom-
er-specific kinematic system.
Each version of the WorkVisual software package may be operated exclu-
sively in accordance with the specified system requirements.

Misuse

Any use or application deviating from the intended use is deemed to be
misuse and is not allowed. KUKA Deutschland GmbH is not liable for any
damage resulting from such misuse. The risk lies entirely with the user.
Examples of such misuse include:

• Configuration of a kinematic system that is neither a KUKA industrial
robot nor a customer-specific kinematic system

• Operation of WorkVisual not in accordance with the specified system
requirements
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3 Safety

This documentation contains safety instructions which refer specifically to
the software described here. The fundamental safety information for the
industrial robot can be found in the “Safety” chapter of the Operating and
Programming Instructions for System Integrators or the Operating and
Programming Instructions for End Users.

The “Safety” chapter in the operating and programming instructions of
the KUKA System Software (KSS) must be observed. Death to per-
sons, severe injuries or considerable damage to property may other-
wise result.

WARNING
WorkVisual can be used with write access to modify outputs in the ro-
bot controller, without this being noticed by any persons located inside
the system.
In the test modes, such access is not permitted. Outputs of the robot
controller must not be modified using WorkVisual (“Single Point of Con-
trol” principle)! Death to persons, severe injuries or considerable dam-
age to property may otherwise result.

WARNING
WorkVisual can be used with write access to modify programs, I/O as-
signments, signal declarations and other parameters in the robot con-
troller. The following applies here:
New or modified programs must always be tested first in Manual Re-
duced Velocity mode (T1).
After modifications to the industrial robot, existing programs must al-
ways be tested first in Manual Reduced Velocity mode (T1). This ap-
plies to all components of the industrial robot and includes modifica-
tions to the software and configuration settings. In particular, this also
applies when a WorkVisual project has been activated on the robot
controller.

WARNING
After importing a safety configuration or parts thereof, the safety config-
uration must be checked! If this is not done, this can lead to the possi-
bility of the robot being operated with incorrect data when the project is
transferred to the real robot controller. Death to persons, severe injuries
or considerable damage to property may result.

WARNING
When activating a project on the KUKA smartHMI, an overview is dis-
played of the changes which will be made in comparison to the project
that is still active on the robot controller.
If changes are listed in the overview under the heading Safety-relevant
communication parameters, this means that the behavior of the
Emergency Stop and “Operator safety” signal may have changed com-
pared with the previous project.
After activation of the project, the Emergency Stop and the “Operator
safety” signal must be checked for safe functioning. If the project is ac-
tivated on several robot controllers, this check must be carried out for
every robot controller. Failure to carry out this check may result in
death to persons, severe injuries or considerable damage to property.
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WARNING
After activation of a project on the robot controller, the safety configura-
tion must be checked there! If this is not done, the robot will possibly
be operated with incorrect data. Death, injuries or damage to property
may result.
(>>> 14.6 "Checking the safety configuration of the robot controller"
Page 185)

WARNING
If the activation of a project fails, an error message is displayed in
WorkVisual. In this case, one of the following measures must be
carried out:
• Either: Activate a project again (the same one or a different one).
• Or: Reboot the robot controller with a cold restart.
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4 Installation

4.1 PC system requirements

Hardware

Minimum requirements

• PC with Pentium IV processor, min. 1500 MHz
• 2 GB RAM
• 200 MB free hard disk space
• DirectX-compatible graphics card with a resolution of 1024x768 pixels

Recommended specifications

• PC with Pentium IV processor or higher and 2500 MHz
• 4 GB RAM
• 1 GB free hard disk space
• DirectX-compatible graphics card with a resolution of 1280x1024 pixels

Software

• Windows 7
• Or: Windows 10

If Multiprog is to be interfaced with WorkVisual:

• KUKA.PLC Multiprog5-51 5.0 must be installed.
• Multiprog must be licensed.

4.2 System requirements, robot controller

Software

• KUKA System Software 8.2, 8.3 or 8.5
• Or VW System Software 8.2 or 8.3

4.3 Installing WorkVisual

Precondition

• Local administrator rights

Procedure

1. Start the program setup.exe.
2. If the following component is not yet installed on the PC, an installa-

tion wizard opens:

• .NET Framework 4.6.1

Follow the instructions in the installation wizard. .NET Framework is in-
stalled.

3. If the following component is not yet installed on the PC, an installa-
tion wizard opens:

• SQL Server Compact 3.5

Follow the instructions in the installation wizard. SQL Server Compact
3.5 is installed.
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4. If the following components are not yet installed on the PC, an instal-
lation wizard opens:

• Visual C++ Runtime Libraries
• WinPcap

Follow the instructions in the installation wizard. Visual C++ Runtime
Libraries and/or WinPcap is installed.

5. The WorkVisual […] Setup window opens. Click on Next.
6. Accept the license agreement and click on Next.
7. Click on the desired installation type.

(>>>  "Installation types" Page 18)

Only carry out step 8 if the type Custom has been selected.
Otherwise, continue with step 9.

8. The Custom Setup window opens.

Fig. 4-1: Custom Setup window

a. If required, select a different installation directory with Browse.... If
Browse… is grayed out: Select the WorkVisual Development En-
vironment level in the tree. Browse… is then enabled.

b. Select the desired languages in the tree. Only those languages
that are installed here are available later for switching languages
on the user interface.

Icon Description

Will be installed.

Will be installed, including subelements (not rel-
evant for language selection)

Will not be installed.

c. Continue with Next.
9. Click on Install. WorkVisual is installed.
10. Once installation is completed, click on Finish to close the installation

wizard.
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Installation types

Type Installation directory Languages

Typical Default directory English and the lan-
guage of the operating
system are installed.

Custom Selectable Selectable from list

Complete Default directory All are installed

Only those languages that are installed are available later for switching
languages on the user interface.
Default directory: C:\Program Files (x86)\KUKA\WorkVisual […]

4.4 Uninstalling WorkVisual

It is advisable to archive all relevant data before uninstalling a software
package.

Precondition

• Local administrator rights
• The setting Show hidden files, folders and drives is activated in

Windows Explorer.

Procedure

1. In the Windows Start menu, delete the entry WorkVisual […] under
Control Panel > Remove Program.

The remaining steps are only necessary if the entire user configura-
tion is to be deleted.

2. Delete the WorkVisual […] folder in the directory C:\User\Username
\My Documents.

3. In the directory C:\ProgramData\KUKA Roboter GmbH, delete the fold-
ers DeviceDescriptions and WorkVisual.

4.5 Creating and starting a portable version

Description

As an alternative to a normal installation, a portable version of WorkVisual
can be generated and executed. The portable version can be run from a
USB stick, for example.

User-specific directories, such as the Projects folder, are located within
the directory of the portable version.

Precondition

In order for the portable version to be run-capable, the following compo-
nents must be installed on the PC:

• .NET Framework 4.6.1
• SQL Server Compact 3.5
• Visual C++ Runtime Libraries
• WinPcap
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Procedure

1. Open the directory Tools\PortableCreator on the WorkVisual CD-ROM.
2. Start the program PortableCreator.exe. The program WorkVisual

portable creator opens.
3. Click on … and select the directory in which the portable version is to

be created.
4. Only if a subdirectory with the name of the version is to be created:

Activate the check box Create a sub directory with the build label.
5. Only if an existing directory is to be overwritten: Activate the check

box Overwrite existing destination directory.
6. Click on Extract. The portable version is created. Once this has been

completed, a link is displayed at the bottom of the window.
7. Click on the link or navigate manually to the directory.
8. Start the program WorkVisual.exe. The portable version is started.
9. Close the program WorkVisual portable creator.
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5 Graphical user interface

5.1 Overview of the graphical user interface

Not all elements on the graphical user interface are visible by default, but
they can be shown or hidden as required.
There are other windows and editors available in addition to those shown
here. These can be displayed via the Window and Editors menus.

Fig. 5-1: Overview of the graphical user interface

Item Description

1 Menu bar

2 Button bars

(>>> 5.5 "Displaying/hiding buttons" Page 24)

(>>> 5.6 "Button bar" Page 24)

3 Editor area

If an editor is open, it is displayed here. More than one editor
can be open simultaneously – as shown here in the example.
In this case, they are stacked one on top of the other and can
be selected via tabs.

4 Help button

5 Project structure window

(>>> 5.8 "Project structure window" Page 29)
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Item Description

6 Catalogs window

All inserted catalogs are displayed in this window. The ele-
ments in the catalogs can be inserted on the Hardware or Ge-
ometry tabs in the Project structure window.

7 Workspaces window

(>>> 5.4 "Displaying different views of the user interface"
Page 23)

8 Message window window

(>>> 5.7 "Message window window" Page 28)

9 Properties window

If an object is selected, its properties are displayed in this win-
dow. The properties can be changed. Individual properties in
gray boxes cannot be changed.

10 WorkVisual project analysis icon

(>>> 15.1 "Project analysis" Page 194)

5.2 Displaying/hiding windows

Procedure

1. Select the menu item Window. A list of available windows opens.
2. Click on a window in the list in order to display or hide it on the

graphical user interface.

5.3 Repositioning the windows

Precondition

• The desired window is displayed on the graphical user interface.

Procedure

Free positioning of windows:

1. Right-click in the title bar of the window. A context menu is opened.
2. Select the option Floating.
3. Grip the window by the title bar and move it to the desired position on

the graphical user interface.

If the mouse pointer is positioned over the edges or corners of the win-
dow, arrows appear which can be dragged to make the window larger or
smaller.

Fixed positioning of windows:

1. Right-click in the title bar of the window. A context menu is opened.
2. Select the option Dockable.
3. Grip the window by the title bar and move it to the desired position on

the graphical user interface.

• Anchor points are displayed at the right, left, top and bottom of the
user interface.

• If the window is moved over another fixed window, an anchor
cross is displayed.
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(>>>  "Anchor cross" Page 22)
4. Drag the window onto an anchor point or the cross. The window is

now anchored.

Automatic hiding and displaying of anchored windows:

1. Right-click in the title bar of the window. A context menu is opened.
2. Select the option Auto-Hide. The window is hidden. A tab with the

name of the window remains at the edge of the user interface.
3. To show the window again, move the mouse pointer over the tab.
4. To hide the window again, move the mouse pointer off the window. If

necessary, click on an area outside the window.

The Auto-Hide option creates more space for working in other areas of
the user interface. Nonetheless, the window can still be quickly shown
again at any time.

There is a pin symbol in the title bar of the window.

• Alternatively, Auto-Hide can also be activated or deactivated by click-
ing on this pin symbol.

Fig. 5-2: Pin symbol

Anchor cross

If a window is moved over another fixed window, an anchor cross is dis-
played.

Fig. 5-3: Anchor cross

Depending on which side of the anchor cross the window is dragged, it is
then anchored on this side of the previously window.
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If the window is dragged over to the center of the anchor cross, both win-
dows are anchored one on top of the other. Tabs are displayed under-
neath the windows, making it possible to switch between windows.

Fig. 5-4: Windows anchored on top of each other

To move windows that are anchored one on top of the other:

• Dragging on a tab moves only the corresponding window.
• Dragging on the title bar moves the whole stack of windows.

5.4 Displaying different views of the user interface

Description

The WorkVisual user interface can be displayed in 2 different views.
These can be selected via the menu item View or via the Workspaces
window.
The views are tailored to different types of work:

View Type of work

Configuration and
start-up

Area for project-related work

e.g. cell configuration, I/O mapping and work
with the KRL Editor.

Programming and
diagnosis

Area for project-independent work

e.g. monitoring, recording and work with the
KRC Explorer.

The functions in this view are only available
when there is no project opened.

Each view can be adapted separately to the needs of the user. Examples:

• Position the button bars differently in each view.
• Hide the message window in one view and not in another.

Procedure

To display the Workspaces window:

• Select the menu sequence Window > Workspaces.

Fig. 5-5: “Workspaces” window
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To reset the current view to the default settings:

• Select the menu sequence Window > Reset active workspace.

To reset all views to the default settings:

• Select the menu sequence Window > Reset all workspaces.

5.5 Displaying/hiding buttons

Description

The individual buttons can be added or removed. In this way, the button
bar can be tailored to the needs of the user.

Procedure

1. Click on the arrow on the right of the button bar.

Fig. 5-6: Example: File button bar: Click on the arrow on the right

2. The menu item Add or Remove Buttons is displayed. Click on this,
and then on the submenu item [BarName].

3. An overview of all the buttons in this bar is displayed. Click on a but-
ton in the overview in order to add or remove it.

Fig. 5-7: Example: File button bar: Overview

5.6 Button bar

Button Name / description

New...

Opens a new, empty project.

Open project

Opens the Project Explorer.
Save project

Saves the project.
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Button Name / description

Cut

Deletes the selected element from its original position and
copies it to the clipboard.

Copy

Copies the selected element to the clipboard.

Paste

Inserts the cut or copied element at the selected position.

Delete

Deletes the selected element.

Opens the Add Point dialog.

Opens a window in which an element can be selected and
added to the tree structure. Which element is available de-
pends on what is selected in the tree structure.

The button is only active if an element is selected on the
Hardware or Files tab in the Project structure window.

Set as active controller / Reset active controller

Sets a robot controller to active/inactive.

The button is only active if a robot controller is selected in
the Project structure window.

Configuration proposal...

Opens a window in which WorkVisual proposes complete
hardware configurations that match the existing kinematic
systems. The user can select which proposal matches the
real configuration and apply this configuration to the project

Undo

Undoes the last action.

Restore

Redoes the action that was undone.

Settings...

Opens a window with the hardware data.

The button is only active if a device is selected on the
Hardware tab in the Project structure window.

Connect with device

Establishes a connection with a field bus device.

The button is only active if the field bus master is selected
on the Hardware tab in the Project structure window.

Disconnect from device

Terminates the connection with a field bus device.

Scan Topology...

Scans a bus.

Abort last action

Cancels certain actions, e.g. a bus scan.

The button is only active if a cancelable action is running.
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Button Name / description

Monitor...

Currently without function.

Diagnosis...

Currently without function.

Device list and names

Opens the Available devices window.

The button is only active if the PROFINET node is
selected on the Hardware tab in the Project structure
window.

Topology

Opens the Topology... window.

The button is only active if the PROFINET node is
selected on the Hardware tab in the Project structure
window.

Port list

Opens the Port list window.

The button is only active if the PROFINET node is
selected on the Hardware tab in the Project structure
window.

Perform network capture...

WorkVisual can record communication data from interfaces
of the robot controller. This button opens the corresponding
window.

Tool/base management

Opens a graphic editor for managing the TOOL and BASE
coordinate systems.

(>>> 6.26.1 "Opening tool/base management" Page 55)

Open machine data configuration

Opens an editor for editing the machine data.

The button is only active if a kinematic system is selected
on the Hardware tab in the Project structure window.

Brake test configuration

Opens the Brake test configuration window.

Mapping editor

Opens the I/O Mapping window.

The local safety configuration of the controller

Opens the local safety configuration of the current robot
controller.

Drive configuration

Opens a graphic editor for adapting the drive channels.

KRL Editor

Opens the selected file in the KRL Editor.
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Button Name / description
The button is only active if a file is selected on the Files
tab in the Project structure window which can be opened
with the KRL Editor.

Symbol Table Editor

Opens the Symbol Table Editor window.

Cell configuration

Opens the Cell configuration window.

Format document

Indentations, line breaks, etc. are adapted throughout the
file to conform to the standard. The applicable standard de-
pends on the file format.

Inserts a semicolon at the beginning of the selected line.
The selected row is thus turned into a comment.

Removes the semicolon from the beginning of the selected
line. The selected row is thus turned into code.

Opens all folds in the currently displayed file.

(>>> 13.4.6 "Folds" Page 156)

Closes all folds in the currently displayed file.

(>>> 13.4.6 "Folds" Page 156)

Opens the advanced clipboard, from which an element can
be pasted at the marked point.

Deploy...

Transfers the project to the robot controller.

Generate code

(>>> 14.1 "Generating code" Page 177)

Help

Opens the Help.

Only in the Programming and diagnosis workspace:

Button Name / description

Establishes a connection to the working directory of the re-
al robot controller.

(>>> 13.5.1 "Opening the working directory in the KRC Ex-
plorer" Page 163)

Opens the Cell definition window.

(>>> 6.29.1 "Opening the cell definition" Page 65)

Restores the state of the working directory of the real robot
controller.

(>>> 13.5.8 "Restoring the state of the robot controller"
Page 169)

Transfers the changes in the working directory from Work-
Visual to the real robot controller.

(>>> 13.5.6 "Transferring changes to the robot controller"
Page 167)

Loads changes from the robot controller.
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Button Name / description
(>>> 13.5.7 "Loading changes from the robot controller"
Page 168)

Starts the debugging mode.

(>>> 13.6.2 "Starting the debugging mode" Page 173)

Ends the debugging mode.

(>>> 13.6.4 "Ending the debugging mode" Page 176)

Opens the Online system information window.

(>>> 15.6 "Displaying online system information"
Page 216)

Opens the Update manager window.

Opens a window in which a rollout can be created.

(>>> 6.34.1 "Creating a rollout" Page 89)

Opens a window in which an update package can be cre-
ated.

(>>> 6.33.1 "Creating an update bundle" Page 84)

Opens the Diagnostic monitor window.

(>>> 15.5 "Displaying diagnostic data about the robot con-
troller" Page 213)

Opens the Trace configuration window.

(>>> 15.2.5 "“Trace configuration” window" Page 198)

Opens the Trace Analysis (Oscilloscope) window.

(>>> 15.2.8 "“Trace Analysis (Oscilloscope)” window"
Page 205)

Opens the Log view window.

(>>> 15.4 "Displaying messages and system logs of the ro-
bot controller" Page 210)

The following buttons are only available when an OPS is used:

Button Description

Starts the program.

Stops the program.

Resets the program.

(>>> 13.6.1 "Overview of the debugging mode" Page 172)

5.7 Message window window

Messages are displayed here. The following options can be set in the
message window:
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Fig. 5-8: “Message window” window

Item Description

1 Filter

The following filters can be set:

• Errors: Only error messages are displayed.
• Warnings: Only warnings are displayed.
• Messages: Only information messages are displayed.

2 The desired language can be selected here.

3 Category

• Editor: Displays errors in the KRL code of the file currently
open in the KRL Editor window.

• Message history: Displays all messages except errors re-
lating to KRL code.

Note: Messages are not automatically deleted, even if they re-
fer to a temporary state that is no longer active. Messages can
be deleted by right-clicking on them and selecting the option
Delete all.

5.8 Project structure window

The Project structure window contains the following tabs:

Hardware

The Hardware tab shows the relationship between the various devices.
Here, the individual devices can be assigned to a robot controller.

Geometry

The Geometry tab displays all the geometrical objects used in the project
in a tree structure (kinematic systems, tools, base objects). The properties
of the objects can be edited.
If objects need to be linked geometrically, e.g. if a robot is to be assigned
to a KUKA linear unit: this must be done here on the Geometry tab
(Drag&Drop).

Files

The Files tab contains the program and configuration files belonging to
the project.
Coloring of file names:

• Files generated automatically (with Generate code function): gray
• Files inserted manually in WorkVisual: blue
• Files transferred to WorkVisual from the robot controller: black
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5.9 Cell configuration window

Call

• Select the menu sequence Editors > Cell configuration.

Description

The Cell configuration window displays graphically certain geometric ob-
jects that are present in the project (robot controllers and kinematic sys-
tems). The objects can be linked together, e.g. a robot can be assigned to
a robot controller. This is done by clicking on one of the objects and hold-
ing down the mouse button. The mouse pointer is then dragged to the
other object and released there.
If a robot is linked to a different kinematic system, the type of link to be
made can be selected via a pop-up window, e.g. whether the robot is to
stand on the flange of the other kinematic system (geometric relationship)
or whether the robot is to be able to track the other kinematic system (kin-
ematic relationship).

Fig. 5-9: Objects in the Cell configuration window

Item Description

1 The dotted blue frame indicates that the object is selected.

2 The connecting line indicates that the KL is assigned to the ro-
bot controller.

3 The connecting line indicates that the robot is mounted on the
KL.

5.9.1 Repositioning objects

Procedure

1. Move the mouse pointer onto the text over the object.
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2. When the mouse pointer turns into a cross, click on it and drag the
object to the desired position.

5.10 Resetting the graphical user interface

Description

All the settings affecting the graphical user interface and its behavior that
the user has made in WorkVisual can be reset to the default state (as af-
ter installation).
This includes changes to the button bars, windows that have been dis-
played or hidden, and settings made in the Options window.

Procedure

1. Select the menu sequence Window > Reset configuration.
2. Close WorkVisual and restart it.
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6 Operation

6.1 Starting WorkVisual

Procedure

1. Double-click on the WorkVisual icon on the desktop.
2. When WorkVisual is started for the first time, a catalog scan is auto-

matically executed. An exception is EtherNet/IP if an EDS file was im-
ported. After this, the catalog scan must be repeated.
(>>> 6.9.1 "Updating the DtmCatalog (catalog scan)" Page 36)

6.2 Opening a project

Description

This procedure is used to open a project.
Projects can also be opened from older versions of WorkVisual. WorkVisu-
al creates a backup copy of the older project and then converts the
project. Before this happens, a dialog is displayed requesting the user to
confirm the conversion.

Procedure

1. Select the menu sequence File > Open project.
Or: Click on the Open project button.

2. The WorkVisual Project Explorer opens. On the left, the Open
project tab is selected. A list of projects is displayed.
Select a project and click on Open. The project is opened.

Fig. 6-1: Project Explorer

Alternative procedure

1. Select the menu sequence File > Recently opened projects. A sub-
menu containing recently opened projects is opened.

2. Select a project. The project is opened.

Projects which are located on a robot controller and have not yet been
saved on this PC can be loaded in WorkVisual and opened there. To do
this, a different procedure must be used:
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(>>> 14.7 "Loading the project from the robot controller" Page 186)

6.3 Creating a new project

6.3.1 Creating a new empty project

Procedure

1. Click on the New… button. The Project Explorer is opened. On the
left, the Create project tab is selected.

2. Select the Blank project template.
3. Enter a name for the project in the File name box.
4. The default directory for projects is given in the Location box. If re-

quired, select a different directory.
5. Click on the New button. A new, empty project is opened.

6.3.2 Creating a project with a template

Procedure

1. Click on the New… button. The Project Explorer is opened. On the
left, the Create project tab is selected.

2. Select the desired template in the Available templates area of the
tab.

3. Enter a name for the project in the File name box.
4. The default directory for projects is given in the Location box. If re-

quired, select a different directory.
5. Click on the New button. The new project is opened.

Templates

The templates available for selection include:

Template Description

Blank project Blank project

KR C4 project This project contains a KR C4 controller and
the catalog KRL Templates.

VKR C4 project This project contains a VKR C4 controller and
the catalog VW Templates.

For templates with controller:
If the real robot controller is a VKR C4 retrofit, or if certain options are
used, this must be activated in WorkVisual.
(>>> 6.16 "Activating additional controller settings" Page 42)

6.3.3 Creating a project on the basis of an existing project

Procedure

1. Click on the New… button. The Project Explorer is opened. On the
left, the Create project tab is selected.

2. Select the desired project in the Available projects area of the tab.
3. Enter a name for the new project in the File name box.

KUKA.WorkVisual 5.0

KST WorkVisual 5.0 V7 | Issued: 12.07.2018 www.kuka.com | 33/230

O
pe

ra
tio

n



4. The default directory for projects is given in the Location box. If re-
quired, select a different directory.

5. Click on the New button. The new project is opened.

6.4 Saving project information

Description

If required, the user can assign information to the project. The following
information can be saved:

• A description
• A preview image (screenshot)

It is also possible to set the time after which the project on the robot con-
troller is deleted if it has not been activated. This setting is only valid for
projects that have never yet been activated. Projects that have already
been activated are never deleted. If nothing is changed here, the project
is never deleted.
The following information is saved and displayed as standard:

• Name
• Current file location
• Version
• Creation date and WorkVisual version
• Change date and WorkVisual version
• Installed option packages

Precondition

• A project is open.

Procedure

1. Select the menu sequence Extras > Project info. A window opens.
2. Select a time period in the Time for activation: box (optional).
3. Enter a description in the Description: box (optional).
4. Click on Change picture ... (optional). Navigate to the image and se-

lect it. Confirm with Open.
5. Click on OK. The window is closed and the project information is

saved.

6.5 Saving the project

Description

Projects have the file format WVS ("WorkVisual Solution").
A project can be saved with one of the following functions:

• Save: Saves the open project.
• Save as: This function is used to save a copy of the open project.

The open project itself is closed and remains unchanged.

Procedure for Save

• Select the menu sequence File > Save.
Or click on the Save project button.
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Procedure for Save as

1. Select the menu sequence File > Save as.
The Save as window is opened. A file location for the project can be
selected here.

2. Enter a name in the File name box and click on the Save button.

6.6 Closing the project

Procedure

• Select the menu sequence File > Close.
If changes have been made, a request for confirmation is displayed,
asking if the project should be saved.

6.7 Closing WorkVisual

Procedure

• Select the menu sequence File > Exit.
If a project is open, a request for confirmation is displayed, asking if
the project should be saved.

6.8 Importing device description files

Description

To be able to use a device in WorkVisual, WorkVisual requires the device
description file for this device.

The device description files must be obtained from the manufacturer of
the devices.

Precondition

• There is no project open.

Procedure

1. Select the menu sequence File > Import / Export. A window opens.
2. Select Import device description file. and click on Next >.
3. Click on Search.... Another window opens.
4. Select the required file format.

In the case of devices for bus systems, the type EtherCAT ESI must
be selected.

5. Navigate to the directory in which the device description files are loca-
ted.

6. Select the files to be imported and click on Open. A list is displayed
of the device description files that are to be imported.

7. Confirm with Next >. A list is displayed of the devices that are to be
imported.

8. Click on Finish. The devices are imported.
9. Close the window.

The imported files are now available in the DtmCatalog.
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6.9 Catalogs

6.9.1 Updating the DtmCatalog (catalog scan)

Description

This procedure is used to update the DtmCatalog. An update only has to
be carried out if an EDS file for EtherNet/IP has been imported.

Precondition

• There is no project open.

Procedure

1. Select the menu sequence Extras > DTM Catalog Management....
The DTM Catalog Management window opens.

2. Click on Search for installed DTMs. WorkVisual searches the PC for
relevant files. The search results are displayed.

3. Under Known DTMs, select the required files and click on the Right
arrow button.
If all files are to be accepted, click on the Double right arrow button.

4. The selected files are displayed under Current DTM Catalog. Click on
OK.

Fig. 6-2: DTM Catalog Management

6.9.2 Inserting a catalog in a project

Description

The catalogs contain all the elements that are required to generate pro-
grams. In order to be able to use a catalog, it must first be inserted in the
project.

Procedure

1. Select the menu sequence File > Catalog management.... A window
opens.
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2. Double-click on the desired catalog in the Available catalogs area.
The catalog is now displayed in the Project catalogs area.

3. Close the window.
The catalog has been inserted in the project. It is now available in the
Catalogs window.

6.9.3 Adding a catalog

Description

Catalogs created using the WorkVisual catalog editor can be added to the
catalogs in WorkVisual.

Procedure

1. Select the menu sequence File > Catalog management.... A window
opens.

2. Click on the  button in the bottom left-hand corner. A window
opens.

3. Select the desired catalog and click on Open.
4. Close the window. The catalog is now available in the Catalogs win-

dow.

6.9.4 Removing a catalog from the project

Procedure

1. Select the menu sequence File > Catalog management.... A window
opens.

2. Double-click on the catalog to be removed in the Project catalogs
area. The catalog is now displayed in the Available catalogs area.

3. Close the window.

6.9.5 Catalog descriptions (8.2)

Which catalogs are available depends on whether a robot controller with
version 8.2, 8.3 or 8.5 is used.

Catalog Catalog contains ...

DtmCatalog Device description files

Note: The robot controller must already have
been set once as the active controller in order
for this catalog to be used.

KRL templates KRL program templates

KukaControllers Robot controllers, hardware components for
robot controllers, safety options, PROCONOS
option

KukaExternalAxes KUKA linear units, KUKA turn-tilt table

External Kinematics Templates:

Templates for external kinematic systems that
are not supplied by KUKA. These templates
can be used if the machine data belonging to
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Catalog Catalog contains ...
the kinematic system are only available in the
form of XML files.

KUKARobots[…] KUKA robots

Catalogs are available for various different
mains voltages (specification in brackets).

KukaSpecialRobots KUKA robots for special applications

• Food, Foundry, Clean Room
MGU_Motor-Gear-
Unit

KUKA motor/gear units

An element from this catalog is used if a non-
KUKA external axis fitted with a KUKA motor/
gear unit is used with the real controller.

Motor_als_Kinematik KUKA motors

An element from this catalog is used if a non-
KUKA external axis fitted with a KUKA motor
is used with the real controller.

VW Templates VW program templates

6.9.6 Catalog descriptions (8.3 or higher)

Which catalogs are available depends on whether a robot controller with
version 8.2, 8.3 or 8.5 is used.

Catalog Catalog contains ...

Options All options that are installed in WorkVisual

DtmCatalog Device description files

Note: The robot controller must already have
been set once as the active controller in order
for this catalog to be used.

KRL templates KRL program templates

KukaControllers Robot controllers, hardware components for
robot controllers, safety options, PROCONOS
option

KukaExternalKine-
matics[…]

KUKA linear units, KUKA positioners

Catalogs are available for various different
mains voltages (specification in brackets).

KukaRobots[…] KUKA robots

Catalogs are available for various different
mains voltages (specification in brackets).

VW Templates VW program templates

6.10 Inserting an element in the project

Description

The procedure for inserting an element, e.g. a robot controller, is descri-
bed separately for each individual element in this documentation. The
Drag&Drop procedure is described.
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In addition to Drag&Drop, the elements can usually also be inserted via
the context menu. This procedure is not additionally mentioned in the indi-
vidual descriptions, but is described here in general terms.
An element can be inserted into a project via the Project structure or
Cell configuration window.

Procedure: Project structure

1. Right-click on the node in the tree structure under which the element
is to be inserted. The type of node depends on the specific element
concerned. The context menu is opened.

2. Select the Add… option from the context menu. A window opens.
3. Select the desired element in the window and accept it with Add or

OK.

Procedure: Cell configuration

1. Right-click in the empty area in the Cell configuration window. The
context menu is opened.

2. Select the Add… option from the context menu. A window with cata-
logs opens.

3. Select the catalog in which the desired element file is located.
4. Select the element and confirm with Add.

6.11 Removing an element from the project

Description

Inserted elements can be removed again from all tabs in the Project
structure window. Some elements that are present as standard cannot be
deleted, however. The tree structure itself cannot be removed.
All elements that are present as standard can be removed again from the
Cell configuration window.

Procedure

• Right-click on the element. Select Delete from the context menu.
Or:

• Select the element. Select the menu sequence Edit > Delete.
Or:

• Select the element. Click on the Delete button in the toolbar, or press
the Delete key on the keyboard.

6.12 Inserting a robot controller

Description

One or more robot controllers can be inserted in a project.

Precondition

• The catalog KukaControllers is available.

Procedure: Project structure

1. Select the Hardware tab in the Project structure window.
2. Select the required robot controller in the KukaControllers catalog.
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3. Drag the robot controller to Cell: Hardware view on the Hardware
tab.

Procedure: Cell configuration

1. Select the required robot controller in the KukaControllers catalog.
2. Drag the robot controller into the Cell configuration window by

means of Drag&Drop.

If the real robot controller is a VKR C4 retrofit, or if certain options are
used, this must be activated in WorkVisual.
(>>> 6.16 "Activating additional controller settings" Page 42)

6.13 Setting the robot controller to active/inactive

Description

Most settings, actions and configurations performed in the Configuration
and start-up workspace are only possible if a robot controller is active.
Furthermore, they apply to the currently active robot controller (e.g. set-
tings in the safety configuration and I/O mappings).

If a project contains more than one robot controller, ensure that the cor-
rect robot controller is active.

An active robot controller can be recognized as follows:

• Text is bold
• Icon has a green check mark

Precondition

• A robot controller has been added.

Procedure

Setting the robot controller as the active controller:

1. Double-click on the inactive robot controller on the Hardware tab in
the Project structure window.
Or: Double-click on the inactive robot controller in the Cell configura-
tion window.

2. Only if the robot controller is set to active for the first time: A window
opens.

• Firmware version box: Enter the version of the KUKA/VW System
Software that is installed on the real robot controller: e.g. “8.2.15”.

• Number of I/Os box: Select the maximum number of inputs/
outputs used on the robot controller.

The values can be changed subsequently. The correct values are nec-
essary for code generation and project deployment.
(>>> 6.14 "Changing the values “Firmware version” and/or “Number of
I/Os" Page 41)

3. Click on OK to save.

Instead of double-clicking, it is also possible to right-click on the robot
controller. A context menu is opened. Select the option Set as active
controller.
Setting the robot controller to inactive:
For a small number of actions in WorkVisual, it is necessary to set the ro-
bot controller to inactive. If these actions are started, a message is dis-
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played to inform the user that the robot controller must first be set to inac-
tive.

1. Save the project.
2. Double-click on the active robot controller on the Hardware tab in the

Project structure window.
Or: Double-click on the active robot controller in the Cell configura-
tion window.

Instead of double-clicking, it is also possible to right-click on the robot
controller. A context menu is opened. Select the option Reset active con-
troller.

6.14 Changing the values “Firmware version” and/or “Number of I/Os

Description

When the robot controller is set to active for the first time, the values
Firmware version and Number of I/Os must be adapted or confirmed.
(>>> 6.13 "Setting the robot controller to active/inactive" Page 40)
The values can be changed subsequently. The correct values are neces-
sary for code generation and project deployment.

Procedure

1. Save the project.
2. Right-click on the robot controller on the Hardware tab in the Project

structure window.
Or: Right-click on the robot controller in the Cell configuration win-
dow.

3. Select Controller options from the context menu. The Controller op-
tions window opens.

4. Enter the new value in the Firmware version box: e.g. “8.2.16”.
And/or: In the Number of I/Os box, select a different number.

5. Click on OK to save.

6.15 Assigning a robot to the robot controller

Precondition

• The catalog containing the required robot has been inserted in the
Catalogs window.

Procedure: Project structure

1. Select the Hardware tab in the Project structure window.
2. Select the required robot in the KukaRobots[…] catalog in the Cata-

logs window.
3. Drag the robot onto the robot controller in the Hardware tab. (Not on-

to the node Unassigned active devices.)
The robot is now displayed underneath the robot controller.

Procedure: Cell configuration

1. Select the required robot in the KukaRobots[…] catalog in the Cata-
logs window.

2. Drag the robot onto the robot controller in the Cell configuration win-
dow. The robot is inserted and assigned to the robot controller.
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6.16 Activating additional controller settings

Description

If one of the following options is used, it must be activated and set in
WorkVisual:

• Transformer ((V)KR C4)
• Air conditioner ((V)KR C4)
• Fast Measurement inputs ((V)KR C4)
• Retrofit interface E2/E7 (VKR C4)
• Transfer application

(>>> 6.16.1 "Setting the cycle time of the Transfer application"
Page 42)

• Force brake test (only for 8.2 and 8.3)
(>>> 6.16.2 "Activating the brake test" Page 43)

• Tools and bases
(>>> 6.16.3 "Changing the number of TOOL and BASE coordinate
systems" Page 43)

Precondition

• The project contains a robot controller.
• Only for Fast Measurement inputs ((V)KR C4): A robot has been as-

signed to the robot controller.

Procedure

1. Select the robot controller in the Project structure or Cell configura-
tion window.

2. Select the menu sequence Editors > Additional controller settings.
The Additional controller settings window opens.

3. Activate the check boxes for the options used or set the desired val-
ues.

4. Save the project.

6.16.1 Setting the cycle time of the Transfer application

Description

The Transfer application is used to transfer data from one field bus to
another. The cycle time of this data transfer can be set manually or auto-
matically.

The larger the number of mappings and the shorter the cycle time, the
higher the CPU load will be. The maximum number of possible map-
pings and the minimum possible cycle time have been chosen to en-
sure that the maximum possible CPU load resulting from the transfer
application only places a minor load on the system. With certain system
variants and configurations, however, it is nonetheless possible for the
system to become overloaded. It is therefore recommended at start-up
to use the diagnostic monitor to check the CPU load arising from the
transfer application.
(>>> 15.5.1 "Diagnostic data for the transfer application module"
Page 215)
If the CPU load is greater than 5%, it is recommended to activate auto-
matic adaptation of the cycle time.
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Fig. 6-3: Transfer application

Item Description

1 Automatic adaptation of cycle time

• Check box active: The cycle time is automatically adjusted
by the robot controller, but is not faster than 4 ms.

• Check box not active: The cycle time can be entered
manually in the Cycle time box.

2 Manual setting of the cycle time

• 4 … 1000 ms

6.16.2 Activating the brake test

Description

The option Force brake test can be used to activate the brake test man-
ually if it is not automatically active. The brake test is automatically active
if a safety option is installed and safe monitoring is active.

If the brake test is not automatically active, the operator must carry out
a hazard assessment to determine whether it is necessary to activate
the brake test for the specific application.

If the robot has been configured as being mounted on the flange of a
linear unit, the brake test for the linear unit is automatically active.

Option Description

Force brake
test

• Check box active: The brake test is active.
• Check box not active: The brake test is activated

if a safety option is installed and the safe monitor-
ing is activated. In all other cases, the brake test is
deactivated.

6.16.3 Changing the number of TOOL and BASE coordinate systems

Option Description

Number of tools Number of TOOL coordinate systems

• 16 … 128

Default value: 16

Number of bases Number of BASE coordinate systems

• 32 … 128

Default value: 32
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6.17 Configuring the brake test

This functionality is only available for robot controllers with version 8.5.

If the brake test is not automatically active, the operator must carry out
a hazard assessment to determine whether it is necessary to activate
the brake test for the specific application.

If the brake test is active, the operator must perform a hazard assess-
ment to determine the following:
• Which axes need to be tested
• What cycle time needs to be defined

It is irrelevant whether the brake test is automatically active or it is acti-
vated manually. The hazard assessment is required in both cases.

If the robot has been configured as being mounted on the flange of a
linear unit, the brake test for the linear unit is automatically active.

Precondition

• A project is open.

Procedure

1. Select the Hardware tab in the Project structure window.
2. Select the robot controller, a kinematic system or an axis.
3. Select the menu sequence Editors > Brake test configuration.
4. Activate the check boxes for the options used or set the desired val-

ues.

If changes are made here, the checksum of the brake test changes.
The new checksum is indicated with blue text. After the checksum
has been changed, the user group “Safety maintenance” or higher
is required to activate the project on the robot controller.

5. Save the project.

Description

Option Description

Activate brake
test

• Check box active: The brake test is active.
• Check box not active: The brake test is activa-

ted if a safety option is installed and the safe
monitoring is activated. In all other cases, the
brake test is deactivated.

Hours cycle
time

The cycle time specifies the interval at which the
brake test is to be executed.

Select axes for
brake test:

The robot axes and external axes for which the
brake test is to be executed can be selected here.
As standard, none of the robot axes is selected.

Note: The following external axes cannot be selec-
ted:

• External axes that are simulated
• External axes with axes that are configured as

couplable
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Option Description

• External axes with motors that are grouped to-
gether into a coupling group

6.18 Inserting a safety option and/or PROCONOS

Description

If a safety option (e.g. SafeOperation) and/or PROCONOS is used on the
real robot controller, these options must also be inserted into the WorkVi-
sual project.

Precondition

• The catalog KukaControllers is available.

Procedure: Project structure

1. Select the Hardware tab in the Project structure window.
2. Expand the Options node in the KukaControllers catalog.
3. Drag the option onto the Options node on the Hardware tab.

When the option has been inserted, the version number is also displayed
to the right of the name. It is always the compatible version for the robot
controller.

Procedure: Cell configuration

1. Right-click on the robot controller in the Cell configuration window
and select the option Add… from the context menu.

2. Select the option on the KukaControllers tab and accept it with Add.
The option is inserted into the Project structure window.

6.19 Inserting hardware components

Description

The standard hardware components for the robot controller are automati-
cally present under the Controller components node.
If further components are present in the real robot controller, these must
be added here. This can be done in one of the following ways:

• The components can be inserted individually.
• Or (from 8.3 onwards): WorkVisual can propose complete hardware

configurations, one of which can be selected. The proposal always in-
cludes the hardware for all robots and external kinematic systems as-
signed to the robot controller.

Precondition

• The catalog KukaControllers is available.

Procedure

Inserting an individual component

1. Select the Hardware tab in the Project structure window.
2. Select the desired component in the KukaControllers catalog.
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3. Drag the component onto the Controller components node on the
Hardware tab.

As of 8.3: Selecting a configuration proposal

1. Select the Hardware tab in the Project structure window.
2. Select the Controller components node and click on the Configura-

tion proposal... button.
The Configuration proposal window opens. The commonest configu-
ration for this controller and the associated kinematic systems is dis-
played.

3. If this configuration corresponds to the real configuration, confirm with
Accept. The configuration is inserted in the Controller components
node.
If not, expand the Further proposals area and click on the matching
configuration. It is now displayed in the upper part of the window and
can be accepted.

Configuration proposal

Fig. 6-4: “Configuration proposal” window

Item Description

1 The selected proposal is displayed here.

• Black text: Component that is already present under Con-
troller components and which would remain present if the
proposal is accepted.

• Green text: Component which would be inserted.
• Crossed-out component: Component which would be re-

moved.

2 Items 3 and 4 can be displayed or hidden by clicking on the
arrow.

3 Here the proposals displayed under item 4 can be filtered. If no
filter is entered, all possible configurations for this controller
and the associated kinematic systems are displayed.
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Item Description

4 This box can be expanded to display the list of proposals. Click
on a proposal to select it.

6.20 Inserting an external axis

Preparation

In order for an external axis to be inserted into the project, the file struc-
ture of the robot controller must be present on the Files tab in the
Project structure window. This can be achieved as follows:

• Do not create a new project in WorkVisual, but load the initial project
from the robot controller.
(Via File > Browse for project.)
(>>> 14.7 "Loading the project from the robot controller" Page 186)

• Or: Transfer the project to the robot controller. Then transfer it back to
WorkVisual via the menu sequence Extras > Comparing projects.
(>>> 14.8 "Comparing projects (and accepting differences)" Page 186)

Precondition

• The required catalog has been inserted in the Catalogs window.
• The robot controller has been set as the active controller.

Procedure Project structure

1. Select the Hardware tab in the Project structure window.
2. Select the external axis in the catalog in the Catalogs window.
3. Drag the external axis onto the robot controller in the Hardware tab.

(Not onto the node Unassigned active devices.)
The external axis is now displayed underneath the robot controller.

4. Double-click on the external axis. The Machine data configuration
editor is opened.

5. For 8.2 only:
In the Axis ID: box in the area General axis-specific machine data,
specify which drive the external axis is assigned to in the real cell.

6. If required: Edit the other parameters.
(>>>  "Editor (8.2)" Page 49)
(>>>  "Editor (8.3 or higher)" Page 50)

7. If the external axis needs to be linked geometrically to a kinematic
system:

a. Select the Geometry tab.
b. Assign the kinematic systems to each other as required by means

of Drag&Drop.
Example 1: If a KUKA linear unit has been added, drag the robot
onto the linear unit.
Example 2: If a servo gun (KUKA.ServoGun package) has been
added that is to be used on the robot flange, drag the gun onto
the Flange Base node of the robot.

Procedure Cell configuration

1. Select the catalog for the external axis in the Catalogs window.
2. Select the desired external axis.
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3. Drag the external axis onto the robot controller in the Cell configura-
tion window. The external axis is inserted and assigned to the robot
controller.

4. Double-click on the external axis. The Machine data configuration
editor is opened.

5. For 8.2 only:
In the Axis ID: box in the area General axis-specific machine data,
specify which drive the external axis is assigned to in the real cell.

6. If required: Edit the other parameters.
(>>>  "Editor (8.2)" Page 49)
(>>>  "Editor (8.3 or higher)" Page 50)

7. If the external axis needs to be linked to a kinematic system:

a. Click on a kinematic system and hold down the mouse button.
b. Drag the mouse pointer to the other kinematic system and release

the mouse button. A pop-up window opens. The type of link is de-
fined here:
{0} should follow {1}: Kinematic relationship
Place {0} on flange of {1}: Geometric relationship
The geometry is adapted automatically.

6.21 Editing machine data for external axes (8.2)

Depending on the firmware version of the robot controller (8.2, 8.3 or
higher), a different editor opens for editing machine data. If the robot
controller has not yet been assigned a firmware version, the editor for
firmware version 8.3 or higher opens.

Description

If a robot controller with version 8.2 is part of the project, only the ma-
chine data of external axes can be edited.

The machine data must be edited using the procedure described here,
i.e. via the editor. Direct editing of files, e.g. $machine.DAT, is not per-
mitted in WorkVisual. The files are overwritten with the data from the
editor during code generation.

Precondition

• The robot controller has been set as the active controller.

Procedure

1. Double-click on any kinematic system on the Hardware tab in the
Project structure window. The editor is opened.
Or: Double-click on any kinematic system in the Cell configuration
window. The editor is opened.

2. In the editor, select the kinematic system that is to be edited.
3. Edit the machine data as required.
4. Save the project to accept the changes.
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Editor (8.2)

Fig. 6-5: Machine data configuration editor (8.2)

Item Description

1 Here, select the kinematic system that is to be edited.

2 The product name of the selected kinematic system is dis-
played here. The box cannot be edited.

3 With one exception, this button never needs to be pressed. If
an import is necessary, WorkVisual performs this automatically
at the relevant time.

Exception: If an XML file with machine data for a non-KUKA
kinematic system has been added on the Files tab using Add
external file, then the machine data must subsequently be im-
ported manually from the XML file in a second step. This is
done using this button.

4 These boxes have no effect.

5 The machine data of the selected kinematic system are dis-
played here, sorted by axis.

6 The data belonging to each heading can be displayed or hid-
den by clicking on the arrow.

7 Motor data

The data can be displayed by clicking on the box.

6.22 Editing machine data (8.3 or higher)

Depending on the firmware version of the robot controller (8.2, 8.3 or
higher), a different editor opens for editing machine data. If the robot
controller has not yet been assigned a firmware version, the editor for
firmware version 8.3 or higher opens.
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Description

Each kinematic system and each subordinate element belonging to it has
its own editor with the respective data. A subordinate element can be an
axis or a motor, for example. More than one editor can be open simulta-
neously.

The machine data must be edited using the procedure described here,
i.e. via the editor. Direct editing of files, e.g. $machine.DAT, is not per-
mitted in WorkVisual. The files are overwritten with the data from the
editor during code generation.

Procedure

1. On the Hardware tab in the Project structure window, double-click
on the element to be edited. The editor is opened.
Or: In the Cell configuration window, double-click on the element to
be edited. The editor is opened.

2. Edit the machine data as required.
3. Save the project to accept the changes.

Editor (8.3 or higher)

Information about the individual machine data can be found in the doc-
umentation Configuration of Kinematic Systems.
Information about the system variables for the warm-up can be found in
the Operating and Programming Instructions for System Integra-
tors for the KUKA System Software.

System variables of the BOOL type are displayed in WorkVisual with a
check box:
• TRUE = Check box active
• FALSE = Check box not active

Fig. 6-6: Machine data configuration editor (8.3 or higher)
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Item Description

1 The name of the kinematic system is displayed here.

2 The parameter groups for this kinematic system are displayed
here. Clicking on one group shows this group in the parameter
display and hides all other groups.

3 This selection box indicates which groups are currently shown
in the parameter display. The selection list contains all the ex-
isting groups. The groups can be displayed or hidden using the
check boxes.

4 The parameter display can be filtered here. The filter refers to
the parameter name. No distinction is made between upper-
case and lower-case letters.

Example: If a1 is entered, only those parameters are displayed
which have a1 or A1 in their names.

5 Parameter display (area with gray background)

The parameters are sorted by group. They can be edited. If a
parameter is changed, the value is displayed in blue until the
change is saved. In addition, the tab of the editor is then
marked with an asterisk (not shown) until the change is saved.

6 Graphics files can be loaded here. Once a file has been loa-
ded, a minus symbol is also displayed, which can be used to
delete it again.

The graphic is shown here. Only one graphic is displayed at a
time. If several files are loaded, a selection box is displayed for
toggling between the graphics.

Formats: JPG, JPEG, PNG, BMP

6.23 Comparing kinematic systems (and accepting differences)

Description

A kinematic system in WorkVisual can be compared with another kinemat-
ic system. This may be a kinematic system in a catalog or in a different
project. The differences are clearly listed. The user can decide for each
individual difference whether to retain the state of the current kinematic
system or to adopt the state of the other kinematic system.

Precondition

• The kinematic system that is to be compared is contained in the open
WorkVisual project.

Procedure

1. Expand the tree structure of the robot controller on the Hardware tab
in the Project structure window.

2. Right-click on the kinematic system and select Compare kinematic
machines. Then select the desired option:

• From open catalog: if the kinematic system to be compared is in
an open catalog. The kinematic systems are compared and the dif-
ferences are displayed in an overview . Continue with step 5.

• Select catalog: if the kinematic system to be compared is in a
catalog that is not open. Continue with step 3.
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• Select project: if the kinematic system to be compared is in a dif-
ferent project. Continue with step 3.

3. A window opens. Select the catalog or project in which the kinematic
system is located and click on Open.

4. Open the tree structure, select the kinematic system and click on
Compare. The differences between the kinematic systems are dis-
played in an overview .

5. For each difference, select whether to retain the state of the current
kinematic system or to adopt the state of the comparison kinematic
system. This does not have to be done for all the differences at one
go.
If suitable, the default selection can also be accepted.

6. Click on Merge to accept the changes.
7. Repeat steps 5 to 6 as required. This makes it possible to work

through the different areas bit by bit.
8. Close the Compare kinematic machines window.

Comparison

The differences between the kinematic systems are displayed in an over-
view. For each difference, the user can select which state to accept. The
default setting is as follows:

• For all parameters that are present in the kinematic system in the
open project and have been altered, the state of this kinematic system
is selected.

• For all parameters that are not present in the kinematic system in the
open project, the state of the comparison kinematic system is selec-
ted.
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Fig. 6-7: Example: overview of differences

Item Description

1 The node for the kinematic system. The different areas are represented by subno-
des. The nodes can be expanded to display the comparisons.

• In each line, place a check mark in the box for the value that should be trans-
ferred.

• A check mark next to Not available means that the parameter will not be
transferred, or that it will be deleted from the kinematic system if already
present.

• If a check box is activated for a node, the check boxes for all subordinate pa-
rameters are also automatically activated.
If a check box is deactivated for a node, the check boxes for all subordinated
parameters are also automatically deactivated.
The subordinate parameters can also be edited individually, however.

• A filled-in box means: at least one of the subordinate parameters is selected,
but not all.

2 State of the kinematic system in the project that is open in WorkVisual

3 State of the comparison kinematic system

4 Back arrow: The focus in the display jumps to the previous difference.

Collapsed nodes are automatically expanded.

5 Forward arrow: The focus in the display jumps to the next difference.

Collapsed nodes are automatically expanded.
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Item Description

6 Check box active: Only the areas containing differences are displayed. All other
areas are hidden.

7 Transfers the selected changes to the kinematic system in the open project.

8 Click on a marking. The focus of the display jumps to the corresponding differ-
ence.

6.24 Updating machine data

Description

The machine data of a kinematic system in WorkVisual can be updated
order to, for example, adopt the changes from a newer version of the cat-
alog element. The differences are clearly listed. The user can decide for
each individual difference whether to retain the current state of the kine-
matic system or to adopt the state of the newer version. The result of the
comparison is structured in the same way as the result of the comparison
for the kinematic systems (>>> Fig. 6-7).

Precondition

• The kinematic system for which the machine data are to be updated is
contained in the open WorkVisual project.

Procedure

1. Expand the tree structure of the robot controller on the Hardware tab
in the Project structure window.

2. Right-click on the kinematic system and select Update machine data.
The states are compared and the differences are displayed in an over-
view.

3. For each difference, select whether to retain the state of the current
kinematic system or to adopt the state of the newer version. This does
not have to be done for all the differences at one go. If suitable, the
default selection can also be accepted.

4. Click on Merge to accept the changes.
5. Repeat steps 3 and 4 as required. This makes it possible to work

through the different areas bit by bit.
6. Close the Compare kinematic machines window.

6.25 Exporting kinematic systems to a catalog

Description

This procedure can be used to export kinematic systems to a catalog. In
this way, the kinematic systems can be used in different projects.

Precondition

• A project is open.

Procedure

1. Right-click on (any) kinematic system on the Hardware tab in the
Project structure window and select Export kinematic system from
the context menu. A window opens.
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2. All controllers and kinematic systems in the project are displayed in a
tree structure. Activate the check boxes next to the kinematic systems
that are to be exported. Confirm with Next >.

3. Select a file location for the catalog. The catalog ExportedKinema-
ticsCatalog.afc is selected by default.

4. If required, deactivate the check box next to Replace already
existing kinematics in catalog..

5. Click on Finish. The kinematic systems are exported.
6. If the export was successful, this is indicated by the following

message in the Export kinematics to catalog. window: Catalog ex-
port successful.
Close the window.

6.26 Editing TOOL and BASE coordinate systems

WARNING
Changing the numbers of TOOL and BASE coordinate systems may af-
fect programs that have already been created and positions that have
already been taught. Changing the number of a TOOL coordinate sys-
tem can result in unexpected robot motions. If TOOL and BASE coordi-
nate system numbers are changed, it must be noted that all programs
containing these TOOL and BASE coordinate systems may also need
to be adapted.

6.26.1 Opening tool/base management

Description

The Tool/base management editor can be used to create, edit and delete
TOOL and BASE coordinate systems. The coordinate systems can also
be assigned to a different number by means of Drag&Drop.
Objects can be created, edited and deleted in the Available tools and
bases area. An object can contain one or more elements. These
elements can be assigned to a number in the area of the TOOL and
BASE coordinate systems by means of Drag&Drop.
Objects can be exported to a catalog, enabling them to be used in other
projects and on other controllers.

Procedure

• Select the menu sequence Editors > Tool/base management.
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Editor

Fig. 6-8: Tool/base management editor

Item Description

1 Assigned BASE coordinate system

(>>> 6.26.3 "TOOL and BASE coordinate systems" Page 57)

2 Assigned TOOL coordinate system

(>>> 6.26.3 "TOOL and BASE coordinate systems" Page 57)

3 The groups of TOOL and BASE coordinate systems that exist
in this project are displayed here. Clicking on one group shows
this group in the display and hides all other groups.

4 This selection box indicates which groups are currently shown
in the display. The selection list contains all the existing
groups. The groups can be displayed or hidden using the
check boxes.

5 Creates a new TOOL coordinate system on this controller.

6 Number of available TOOL coordinate systems

The number can be changed: (>>> 6.16.3 "Changing the num-
ber of TOOL and BASE coordinate systems" Page 43)

7 Creates a new BASE coordinate system on this controller.

8 Number of available BASE coordinate systems

The number can be changed: (>>> 6.16.3 "Changing the num-
ber of TOOL and BASE coordinate systems" Page 43)

9 Creates a new object.

An object can contain one or more elements.

10 Objects that have been created or imported in this project

The objects can be edited or deleted here.

(>>> 6.26.4 "Objects" Page 58)
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6.26.2 Configuring tool/base management

Here it is possible to set whether the message displayed when deleting
TOOL and BASE coordinate systems should be suppressed.

Procedure

1. Select the menu sequence Extras > Options.... The Options window
is opened.

2. On the left of the window, in the Tool and base management folder,
select the subitem ToolBaseEditor.
The corresponding settings are now displayed on the right of the win-
dow.

3. Make the desired setting.
4. Click on OK to confirm. The setting is applied.

6.26.3 TOOL and BASE coordinate systems

Description

Fig. 6-9: TOOL coordinate system in the Tool/base management edi-
tor

1 Displays the coordinate system data
2 Deletes the coordinate system

Procedure

Create TOOL or BASE coordinate system:

1. Click on the  button. A window opens.
2. Enter a name for the coordinate system in the Name box.
3. If the data are known: open the Details box and enter the calibration

data.
4. Only in the case of TOOL coordinate systems: enter the payload data

and select which reaction is to be carried out in the event of an over-
load or underload.

Selection Description

None No reaction

Warning The robot controller generates the following status
message: Overload/underload calculated when check-
ing robot load (Tool {no.}).
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Selection Description

Stop robot The robot controller generates an acknowledgement
message with the same content as that generated
under Warning. The robot stops with a STOP 2.

5. Click on OK. The data are saved.

Edit TOOL or BASE coordinate system:

1. Double-click on the coordinate system. A window opens.
2. Modify the name and data as required.
3. If changes are to be accepted for all programs: Set the check mark at

Adapt usages in all KRL files.
4. Click on OK. The data are saved.

Delete TOOL or BASE coordinate system:

• Click on the  button and confirm the message with Yes. The coordi-
nate system is deleted.

6.26.4 Objects

Description

Elements of type FRAME (for bases and workpieces on the robot flange)
and TCP (for tools on the robot flange and fixed tools) can be created in
an object.

Fig. 6-10: Objects

1 Object
2 Element of type TCP
3 Element of type FRAME
4 Buttons for creating and deleting elements
5 Creates a new object

The type of element as well as its geometric context determine the area
to which the element can be assigned.
Tools on the robot flange and fixed tools are assigned to the area of the
TOOL coordinate systems. Bases and workpieces on the robot flange are
assigned to the area of the BASE coordinate systems.

Geometric
context

Element type
TCP 

Element type
FRAME 

Area assigned
to

FLANGE Tool on the ro-
bot flange

Workpiece on
the robot flange

TOOL

WORLD Fixed tool Base BASE
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Fig. 6-11: Geometric context

Fig. 6-12: Assigning the elements

Item Description

1 The icon indicates that the element is from an object. Hovering
with the mouse over the icon displays a tool tip with the path
to the object.

Procedure

Create object:

1. Click on the  button. A window opens.
2. Enter a name for the object in the Object box.
3. Click on OK. The object is created.

Add an element to the object:

1. For elements of type TCP: Click on the  button. A window opens.

For elements of type FRAME: Click on the  button. A window
opens.
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2. Enter a name for the element in the Name box.
3. If the data are known: open the Details box and enter the measure-

ment data. In the case of elements of type TCP, enter the load data
as well.

4. Click on OK. The data are saved.

Delete object:

• Click on the  button. The object is deleted.

Edit element:

1. Double-click on the element. A window opens.
2. Modify the name and data as required.
3. Click on OK. The data are saved.

Delete element:

• Click on the  button. The element is deleted.

6.26.5 Updating TOOL and BASE coordinate systems

Description

If the data of the TOOL and BASE coordinate systems differ on the robot
controller and in WorkVisual, the data in WorkVisual can be updated. For
example, this allows tools and bases calibrated on the robot controller to
be directly transferred to WorkVisual. The project does not have to be loa-
ded from the controller again for this.

Precondition

• Network connection to the real robot controller

Procedure

1. Right-click on the robot controller on the Hardware tab in the Project
structure window.
or: Right-click on the robot controller in the Cell configuration win-
dow.

2. Select Update > Tools and bases in the context menu. The data are
loaded into the project and saved.

6.26.6 Importing TOOL and BASE coordinate systems

Description

Changes to the data of the TOOL and BASE coordinate systems which
have been carried out directly in the $config.DAT file can be imported into
the project.

If the changes are simply saved and an import is not carried out, the
data are overwritten with the content from the editor Tool/base man-
agement during the subsequent code generation.

Procedure

1. Expand the tree structure of the robot controller on the Files tab in the
Project structure window.

2. Right-click on $config.DAT (under KRC\R1\System) and select Import
tools and bases. The data are loaded into the project and saved.
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6.26.7 Converting TOOL and BASE coordinate systems

Description

Elements can be converted in the area of TOOL and BASE coordinate
systems. A tool can be converted into a workpiece, and vice versa. A
base can be converted into a fixed tool, and vice versa.
During conversion, an object is also created so that the element can be
used in other projects and on other controllers.

Procedure

Convert tool to workpiece:

• Right-click on the tool and select Convert to workpiece.
The tool is converted into a workpiece and automatically assigned to
the robot flange on the Geometry tab. In the area Available tools
and bases, an object is created which contains the workpiece as an
element of type FRAME.

Convert workpiece to tool:

• Right-click on the workpiece and select Convert to tool.
The workpiece is converted into a tool and automatically assigned to
the robot flange on the Geometry tab. In the area Available tools
and bases, an object is created which contains the tool as an
element of type TCP.

Convert base to fixed tool:

• Right-click on the base and select Convert to external tool.
The base is converted into a fixed tool and automatically assigned to
the WORLD coordinate system on the Geometry tab. In the area
Available tools and bases, an object is created which contains the
base as an element of type TCP.

Convert fixed tool to base:

• Right-click on the fixed tool and select Convert to base.
The fixed tool is converted into a base and automatically assigned to
the WORLD coordinate system on the Geometry tab. In the area
Available tools and bases, an object is created which contains the
fixed tool as an element of type FRAME.

6.26.8 Exporting objects to a catalog

Description

This procedure can be used to export objects to a catalog. In this way,
the objects can be used in different projects and on different controllers.

Precondition

• A project is open.

Procedure

1. Right-click on (any) object on the Geometry tab in the Project struc-
ture window and select Export tool from the context menu. A window
opens.

2. All cells and objects in the project are displayed in a tree structure.
Activate the check boxes next to the objects that are to be exported.
Confirm with Next >.
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3. Select a file location for the catalog. The catalog ExportedKinema-
ticsCatalog.afc is selected by default.

4. If required, deactivate the check box next to Replace already
existing kinematics in catalog..

5. Click on Finish. The objects are exported.
6. If the export was successful, this is indicated by the following

message in the Export tool to catalog window: Catalog export suc-
cessful.
Close the window.

6.26.9 Importing objects from a catalog

Precondition

• The catalog with the object is inserted in the project.

Procedure

1. Select the Geometry tab in the Project structure window.
2. Depending on the desired geometric context, drag the object either on-

to the node World or onto the Flange Base on the Geometry tab.
3. Some of the elements it contains are added directly to the area of the

TOOL and BASE coordinate systems. They are, however, not as-
signed and are thus displayed in red. Assign these elements to the
desired numbers by means of Drag&Drop.

6.26.10 Copying and pasting measurement data

Description

The measurement data of a tool or base can be copied and pasted else-
where. Data can also be copied to the clipboard or pasted from it.

The source and target type can be different. For example, the measure-
ment data from a TOOL coordinate system can be inserted into a
BASE coordinate system. Only the data also present in the target type
are inserted.

The data structure can be created by the user, e.g. on the basis of data
from CAD systems. The required layout of the data structure can be seen
by copying the data of a coordinate system and pasting it into a text edi-
tor.

Example

{X 100.0,Y 0.0,Z 200.0,A 0.0,B 0.0,C 0.0}
{M 3.0,CM {X 200.0,Y 0.0,Z 150.0,A 0.0,B 0.0,C 0.0},J {X
0.05,Y 0.0325,Z 0.0625}}

Procedure for copying

• Right-click on the TOOL or BASE coordinate system and select Copy
measurement data. The data are copied to the clipboard.

Procedure for pasting

• Right-click on the TOOL or BASE coordinate system and select Paste.
The data are pasted from the clipboard.
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6.26.11 Displaying usages of TOOL and BASE coordinate systems

Procedure

1. Right-click on the TOOL or BASE coordinate system and select Find
usages.

2. The Find usages window opens. A tab with the name of the coordi-
nate system is displayed in this window. All uses are listed there in
detail (file with path, line number, etc.)

3. If required: Double-click on a line in the list. The program containing
the coordinate system opens and the corresponding position is
marked.

6.27 Comparing files

Description

This procedure is used to compare a file in the file structure of the robot
controller with a file on the local hard drive.

Any appropriate software can be used for the comparison. It must be
installed and configured in WorkVisual, however.
(>>> 6.37.4 "Configuring additional editors" Page 97)

Procedure

1. Expand the file structure of the robot controller on the Files tab in the
Project structure window.

2. Right-click on the desired file, select Compare with... from the context
menu and select the desired editor. A window opens.

3. Navigate to the path where the file for comparison is located.
4. Select the file and confirm with Open. The files are opened with the

desired editor and the differences are marked.

6.28 Copying data from a file to the project

Description

This procedure can be used to copy data from a file on the local hard
drive to the project.

Any software can be used for this. It must be installed and configured
in WorkVisual, however.
(>>> 6.37.4 "Configuring additional editors" Page 97)
In the case of DAT files, WorkVisual can also be used:
(>>> 6.28.1 "Copying data from a DAT file to the project with WorkVisu-
al" Page 64)

Procedure

1. Expand the file structure of the robot controller on the Files tab in the
Project structure window.

2. Right-click on the desired file, select Merge with... from the context
menu and select the desired editor. A window opens.

3. Navigate to the path where the file from which the data are to be cop-
ied is located.

4. Select the file and confirm with Open. The files are opened with the
desired editor and the differences are displayed.
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5. Accept the desired differences and save the file.
6. Close the editor or click on Exit in WorkVisual.

6.28.1 Copying data from a DAT file to the project with WorkVisual

Description

This procedure can be used to copy data from a DAT file on the local
hard drive to the project.

Procedure

1. Expand the file structure of the robot controller on the Files tab in the
Project structure window.

2. Right-click on the DAT file and select Merge with... > WorkVisual in
the context menu. A window opens.

3. Navigate to the path where the file from which the data are to be cop-
ied is located.

4. Select the file and confirm with Open. The files are compared and a
window with an overview of the differences is displayed.

5. For each difference, select whether to retain the data of the file in the
project or to copy the data from the local file. This does not have to
be done for all the differences at one go.

6. Click on Merge to accept the selected changes.
7. Once all desired differences have been accepted, close the [Merge]

window.
8. Save the project.

Fig. 6-13: Example: Overview of differences in the files

Item Description

1 Button bar

(>>>  "Button bar" Page 65)

2 Status of the file in the project
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Item Description
The differences are highlighted by means of markings.

3 Difference from local file

4 Overview of changes

• Always activate the check box of the line that is to be accepted.

5 Status of local file

The differences are highlighted by means of markings.

Button bar

Button Description

Updates the data in the files

Note: The button is only relevant if one or both of the files is
additionally opened in another editor and changes are made
there.

Accepts all data of the file from the project

Accepts all data from the local file

Accepts only data that are added from the local file

Accepts only data that are added from the local file and
modified

Displays all elements that are identical in both files

Displays all elements that are different in both files

Displays all elements that are not present in the file from the
project

Displays all elements that are not present in the local file

6.29 Defining cells online

6.29.1 Opening the cell definition

Description

Cells can be edited online in the Cell definition editor. Cells can be cre-
ated, edited and deleted. Robot controllers can be assigned to a cell. Fur-
thermore, robot controllers can also be moved to different cells by means
of Drag&Drop.
Robot controllers can also be deleted from cells. In this case, the robot
controllers are moved back to their original cell. The same applies if a cell
containing one or more robot controllers is deleted.

Deleted cells cannot be restored. If a deleted cell is required again, it
must be created again.

Precondition

• Network connection to the real robot controller
• The real robot controller and the KUKA smartHMI are running.
• Programming and diagnosis workspace
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Procedure

1. Select the desired cells in the Cell view window.
2. Select the menu sequence Editors > Cell definition. The Cell defini-

tion window opens. The selected cells are displayed and can now be
edited.

Editor

Fig. 6-14: Cell definition editor

Item Description

1 Cell with robot controller

2 Buttons for editing the cell

6.29.2 Configuring a cell definition

Here it is possible to set whether certain messages displayed during the
definition of cells should be suppressed.

Procedure

1. Select the menu sequence Extras > Options.... The Options window
is opened.

2. On the left of the window, in the Online workspace folder, select the
subitem Cell definition editor.
The corresponding settings are now displayed on the right of the win-
dow.

3. Make the desired settings.
4. Click on OK to confirm. The settings are saved.

6.29.3 Editing cells

Precondition

• The Cell definition editor is open.
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Procedure

Create new cell:

1. Select a robot controller in a cell and drag it into the empty area. A
window opens.

2. Enter a name for the cell and confirm it with OK. A new cell with this
robot controller is created.

Add a robot controller to the cell:

1. Click on the  button in the cell. A window opens.
2. In the list, select the robot controller that is to be added.
3. Click on OK. The robot controller is added to the cell.

Rename cell:

1. Click on the  button in the cell. A window opens.
2. Change the name of the cell and confirm with OK. The cell is re-

named.

Delete cell:

• Click on the  button in the cell. The cell is deleted and the robot
controllers in this cell receive a new cell of their own. These cells are
named by default with the Windows name of the robot controller.

Delete a robot controller in a cell:

1. Position the mouse pointer on the robot controller in the cell. The 
button is displayed.

2. Click on the  button. The robot controller is deleted from the cell
and receives a new cell of its own. This cells is named by default with
the Windows name of the robot controller.

6.30 Option packages

6.30.1 Option profiles

Description

Option profiles can be used to install different versions of option packages
in WorkVisual and to manage them in a structured manner. Exception:
Option packages with additional software that is installed on the WorkVisu-
al PC must have the same version in every option profile.
The Default option profile is available as standard. It cannot be renamed
or deleted.

Option packages can only be installed in the active option profile. The
active option profile cannot be renamed or deleted.
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Fig. 6-15: Option profiles – overview

Item Description

1 Button bar (>>>  "Button bar" Page 68)

2 Option profiles

3 Installed option packages

Button bar

Button Description

• Button above the option profiles: Creates a new option
profile

• Button above the option packages: Installs one or more
option packages in the active option profile

Note: Alternatively, option packages can be inserted and
installed by means of Drag&Drop.

Renames the selected option profile

• Button above the option profiles: Deletes the selected
option profile

• Button above the option packages: Uninstalls the selec-
ted option package

Duplicates the selected option profile

Activates the selected option profile
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6.30.2 Creating and activating an option profile

Procedure

1. Select the menu sequence Extras > Option package management....
The Option package management window opens.

2. Click on the  button above the option profiles.
3. Enter a name and confirm it with the Enter key.

4. Select the option profile and click on the  button.
5. Confirm the prompt to reboot WorkVisual with Yes. WorkVisual is re-

started and the option profile is activated. Option packages can now
be installed in this option profile.

6.30.3 Installing an option package in WorkVisual

Description

Option packages can be installed in WorkVisual. This makes it possible to
insert the catalog of the option package in the individual projects, if re-
quired. The option package is then available for use in this project.
Advantage: if a project is transferred to a number of robot controllers, the
settings relevant to the package only need to be carried out once in Work-
Visual and not on each individual robot controller.
The option package also contains the option package documentation and
the licenses. If the option package is installed in WorkVisual, these are
available in the corresponding folders under the option package on the
Options tab in the Catalogs window. An option package can also contain
additional files. If this is the case, the additional files can be found in the
Extras folder.
On installation, the option package is checked for compatibility and de-
pendencies. If there are conflicts, a message is displayed.

Precondition

• The option package is available as a KOP file.
The KOP file is located on the data storage medium with the option
package.

Procedure

1. Select the menu sequence Extras > Option package management....
The Option package management window opens.

2. Click on the  button above the right-hand box. The Select the
package to be installed window opens. Navigate to the path where
the option package is located and select it. Click on Open.
Alternatively: Drag the desired option package or multiple option pack-
ages from Windows Explorer to the Option package management
window by means of Drag&Drop.

3. The Installing {0} option package(s) window is opened and the
package is installed.
Once the operation has been completed, the package is displayed in
the Option package management window.

4. Only if the message The application needs to be restarted in order
to complete the installation. is displayed: Click on the Restart but-
ton. WorkVisual restarts.
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5. Only if the message stated in the previous step is NOT displayed:
Close the Option package management window.

The option package is now available in the Options catalog.
If the KOP file contains device description files, these are now available in
WorkVisual. It is not necessary to perform a catalog scan.

6.30.4 Updating an option package

Description

Only option packages which do not contain an expansion for WorkVisual
(e.g. an additional editor) can be updated. Other option packages must
first be uninstalled before the new version can be installed.
For the user, it is not apparent beforehand whether a package is updata-
ble or not. The update process can be started nonetheless. If the previous
version has to be uninstalled first, WorkVisual displays a message to this
effect.

Procedure

1. Select the menu sequence Extras > Option package management....
The Option package management window opens.

2. Click on the  button above the right-hand box. The Select the
package to be installed window opens. Navigate to the path where
the option package is located and select it. Click on Open.
Alternatively: Drag the desired option package or multiple option pack-
ages from Windows Explorer to the Option package management
window by means of Drag&Drop.

3. The Installing {0} option package(s) window opens and one of the
following messages is displayed:

• Update of {0} (version: {1}) is not possible because the option
package contains a WorkVisual add-in. - Uninstall package {0}
(version: {1}) - Restart WorkVisual - Install package {2} (ver-
sion: {3})
Close the window and uninstall the package. Then install the new
version.

• The option package is already installed. Would you like to up-
date/downgrade from version {0} to version {1}?
Confirm the message with OK.
The option package is installed. If the KOP file contains new de-
vice description files, the Update catalog window opens and
closes during this operation.

4. Close the Option package management window.

6.30.5 Uninstalling the option package

Procedure

1. Select the menu sequence Extras > Option package management....
The Option package management window opens.

2. Select the option package and click on the  button located above
the box with the installed option packages.

3. Only if Uninstalled is displayed next to the name of the option pack-
age: Close the Option package management window.
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Uninstallation is now complete. No further steps are necessary.
4. Only if the message The application needs to be restarted in order

to complete the installation. is displayed: Click on the Restart but-
ton. WorkVisual restarts.

If an option package that is used in a project is uninstalled, WorkVisual
displays the following warning in the message window if the project is
opened again. The following option packages of the project are not
installed in WorkVisual: {0}. To use the options, install them.

6.30.6 Loading an option package from a robot controller

Only option packages that are contained in the active project on the ro-
bot controller can be downloaded.

Precondition

• Network connection to the real robot controller
• The real robot controller and the KUKA smartHMI are running.
• Programming and diagnosis workspace

Procedure

1. In the Cell view window, activate the check box for the desired robot
controller. The robot controller is now selected.

2. Select the menu sequence Editors > System information editor.
The Online system information window opens. An entry is displayed
for the selected robot controller.

3. The option packages installed on the robot controller are displayed in
the Options column. Activate the check box for the desired option
package. Multiple option packages can be selected.

4. Click on Download selected options in the Commands column. A
window opens.

5. Select a storage location for the option package and confirm it with
OK. The option package is loaded from the robot controller and saved
at the selected location.

6.30.7 Inserting an option package in a project

This action is not necessary if a device is added to the project from the
option package. In this case, the option package is also inserted auto-
matically.

Description

In order to be able to use an option package on the real robot controller,
it must be inserted into the project in WorkVisual.
On insertion, the option package is checked for compatibility with the set
controller version. If the project already contains option packages, the de-
pendencies in relation to these option packages are also checked. If con-
flicts are detected during the check, a message is displayed and the inser-
tion is aborted.

If a project containing an option package is transferred to the robot
controller, the procedure differs from the normal deployment procedure.
Further information can be found in the section on project deployment.

KUKA.WorkVisual 5.0

KST WorkVisual 5.0 V7 | Issued: 12.07.2018 www.kuka.com | 71/230

O
pe

ra
tio

n



Precondition

• The option package is installed in WorkVisual.
• A project is open.

Procedure Project structure

1. Select the Hardware tab in the Project structure window.
2. Right-click on the Options node and select Add….
3. A window opens. Select the catalog Options.
4. Select the option package and click on the Add button.
5. A window opens. The files being added or modified are indicated in

the window.
6. Click on OK. The window closes and the project is saved.

The option package is now displayed in the Options node.

Alternative procedure

1. In the Options catalog, expand the node of the option package.
2. Drag the option package onto the Options node on the Hardware tab.
3. A window opens. The files being added or modified are indicated in

the window.
4. Click on OK. The window closes and the project is saved.

The option package is now displayed in the Options node.

Procedure Cell configuration

1. Right-click on the robot controller in the Cell configuration window
and select Add….

2. A window opens. Select the catalog Options.
3. Select the option package and click on the Add button.
4. A window opens. The files being added or modified are indicated in

the window.
5. Click on OK. The window closes and the project is saved.

The option package is now displayed in the Options node in the
Project structure window.

6.30.8 Removing an option package from the project

Description

Before an option package is removed, a check is carried out to see if
there are dependencies on other option packages. Dependent option
packages will also be removed automatically.

Precondition

• The robot controller has not been assigned any devices from this op-
tion package.
Any devices assigned must first be removed.

Procedure

1. Select the Hardware tab in the Project structure window.
2. Expand the Options node. All the option packages contained in the

project are displayed.
3. Right-click on the option package to be removed and select Delete.
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4. A window opens. The files being removed or modified are indicated in
the window. If dependent option packages are also being deleted, this
is indicated here.

5. Click on OK. The window closes and the project is saved.
The option package is removed from the Options node.

6.30.9 Adding a device from an option package to the robot controller

Description

In order to be able to use devices from the option package on the real ro-
bot controller, the devices must be inserted into the project in WorkVisual.
A device is a catalog element to which the following configurations can be
assigned:

• Configuration of the device
• Bus configuration
• I/O connections
• Long texts

Weld power sources from KUKA.ArcTech and sensors from KUKA.Seam-
Tech Tracking are devices, for example.

Precondition

• The option package is installed in WorkVisual.
• A project is open.
• Only if a device with a bus configuration and/or I/O connections is to

be inserted:
No robot controller has been set to active.

Procedure

1. Select the Hardware tab in the Project structure window.
2. Right-click on the robot controller and select Add….
3. A window opens. Select the Options tab and open the catalog of the

option package.
4. Select the required device from the list and click on the Add button.
5. If there are already configurations assigned to the device, a message

is displayed asking if these configurations are to be transferred to the
project.
Select Yes or No as appropriate.

6. If I/O connections were transferred together with the device, the Ad-
just signal connections window is opened.
If the signals to which the device is to be connected in accordance
with its default settings are already mapped in the current project, this
is shown in the Current conflicts: area.
(>>> Fig. 6-16)

7. If signals are displayed in the Current conflicts: area:
If desired, change the start addresses for the different I/O types until
no further conflicts are displayed.

8. Either: Click on OK. Any signals remaining in the Current conflicts:
area are now overwritten with the new connections.
A message is displayed in the message window for each overwritten
connection. This makes it easier in the case of later changes.
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Or: Click on Cancel. The device is inserted in the Project structure
window, but no signal connections are adopted.

The device is now displayed underneath the robot controller.
If bus configurations have been accepted together with the device, the de-
vice is also displayed under the Bus structure node when the robot con-
troller is set back to active.

Adjust signal connections

Fig. 6-16: Adjust signal connections – Current conflicts:

6.30.10 Exporting files from an option package

The documentation, licenses and the file ReleaseNotes_[…].txt contained
in an option package can be exported.

Precondition

• A project is open.

Procedure

1. Expand the catalog of the option package on the Options tab in the
Catalogs window.

2. Right-click on the desired file or the desired folder and select Export.
A window with a tree structure opens.

3. If further files are also to be exported: In the tree structure, activate
the check boxes for the folders that are to be exported.

4. Click on … and select the path for saving the files.
5. Confirm with Next >. The files are exported.
6. If the export was successful, this is indicated by the following mes-

sage: Successfully exported. The file location can be opened using
the specified link.

7. Close the window.

6.31 Inspecting projects

Using inspection functions, it is possible to check whether projects in
WorkVisual meet specific standards. For this, inspection plans can be cre-
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ated and executed. An inspection function is contained as standard in
WorkVisual.

Further inspection functions can be created and installed in WorkVisual
using option packages. Please contact KUKA Service for this
(>>> 16 "KUKA Service" Page 219).

Fig. 6-17: Inspection plan management – overview

Item Description

1 Button bar

(>>>  "Button bar" Page 75)

2 Inspection plan

• Green marking: All inspection functions used in the inspec-
tion plan are installed in WorkVisual.

• Red marking: The inspection plan contains inspection func-
tions that are not installed in WorkVisual.

Button bar

Button Description

Adds a new inspection plan

Switches to configuration of the selected inspection plan

Deletes the selected inspection plan

Duplicates the selected inspection plan

Executes the selected inspection plan

Exports the selected inspection plan to an XML file

Imports an inspection plan
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Button Description

Selects all inspection plans

If all inspection plans are selected, they can all be expor-
ted or deleted simultaneously.

Executes the inspection plan after code generation

Note: The button affects all projects that are opened in
WorkVisual.

Prevents project deployment if the inspection fails

Notes:

• The button is only active if the  button has been
used to configure execution of the inspection plan only
after code generation.

• The button affects all projects that are opened in Work-
Visual.

6.31.1 Creating an inspection plan

Procedure

1. Select the menu sequence Extras > Inspection plan management....

2. Click on the  button.
3. Enter a name for the inspection plan in the Name box.
4. Optional: Enter a description in the Description box.
5. Select the desired inspection function in the Available functions area.

6. Click on the  button to configure the inspection function. The inspec-
tion function is displayed in the Configured functions area.

An inspection function can be added more than once in order to ex-
ecute it with other parameters.

7. Set the parameters as required.
8. If a further inspection plan is to be created: click on Save and previ-

ous and repeat steps 2 to 7.
9. Save the inspection plan and close the window.
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Example

Fig. 6-18: New inspection plan (example)

Item Description

1 Inspection function that is contained as standard in WorkVisual

(>>> 6.31.2 "Configuring a predefined inspection function"
Page 77)

2 Button bar

(>>>  "Button bar" Page 77)

3 Inspection function that has been added to the inspection plan
and configured

Button bar

Button Description

Moves the selected inspection function upwards

Adds the selected inspection function to the inspection plan

Duplicates the selected inspection function

Removes the selected inspection function from the inspec-
tion plan

Removes all inspection functions from the inspection plan

Moves the selected inspection function downwards

6.31.2 Configuring a predefined inspection function

The inspection function Option installed in project? is contained as
standard in WorkVisual. This function checks whether an option package
is installed in the project in the configured version. If the function is added
several times to the inspection plan, the project can be checked for multi-
ple option packages.
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Precondition

• Inspection function has been added to the Configured functions
area.

Procedure

1. In the Severity: box, set the severity that is to be displayed if the in-
spection fails.

2. Optional: Enter a comment.
3. Set the other parameters as desired.

(>>>  "Parameters" Page 78)
4. Click on Save.

Parameters

Parameter Description

Invert func-
tion:

• Check box active: Option must not be installed
in the project.

• Check box not active: Option must be installed
in the project.

Option name Name of the option package

Version Version of the option package

6.31.3 Executing an inspection plan

During execution, the inspection functions are processed in the order con-
figured in the Configured functions area.

Procedure

1. Select the menu sequence Extras > Inspection plan management....
2. Click on the desired inspection plan.

3. Click on the  button. The inspection plan is executed and the result
is displayed.

Fig. 6-19: Result of the inspection

Item Description

1 Result

Clicking on the result displays details of the result.
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6.31.4 Inspecting multiple projects simultaneously

Precondition

• An inspection plan has been created.

Procedure

1. Select the menu sequence Extras > Project batch inspection.... A
window opens.

2. Carry out the settings as desired.
(>>>  "Settings" Page 79)

3. Click on Run. The inspection is carried out for all selected projects.
The result is displayed. Clicking on the result displays the inspection
plan report. This contains details of the individual results.

Settings

Setting Description

Generating ro-
bot info sheet:

• Yes: An XPS file and an XML file are created for
each project. These contain information about
the configuration.

• No: No files with information about the configura-
tion are generated.

• Exclusively: For every project, only the files with
information about the configuration are created.
The projects are not inspected.

The created files are saved in the directory specified
in the setting Report folder:.

Only execute
project inspec-
tion plans:

• Check box active: Only the inspection plans
saved in the project under C:\KRC\User\Inspec-
tionPlans are executed.

• Check box not active: The inspection plan se-
lected under Inspection plan to be executed: is
executed.

Inspection
plan to be
executed:

Inspection plan that is to be executed for all config-
ured projects. All inspection plans that have been
created in the inspection plan management are avail-
able for selection.

Path to the
projects:

Open the directory in which the projects that are to
be checked are located. Each project must be loca-
ted in a subfolder. For checking, ASZ files are pre-
ferred to WVS files.

Report folder: Directory for the individual inspection results. The re-
sult is available in both HTML and XML format. The
HTML format is used for viewing in the browser. The
XML format enables machine-based evaluation of
the results.

Maximum du-
ration of in-
spection step
execution:

Maximum time an inspection step may take before
the inspection is aborted.

Default value: 5 s
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6.32 Managing updates

This functionality is only available for robot controllers with version 8.5.

The software updates of multiple robot controllers can be managed in
WorkVisual. The controllers are displayed in a list in the Update manager
editor. The controllers can be added to this list manually or via a CSV file.

6.32.1 Opening the Update Manager

Precondition

• Programming and diagnosis workspace

Procedure

• Select the menu sequence Editors > Update manager. The Update
manager window opens.

Editor

Fig. 6-20: Update manager editor

Item Description

1 Button bar

(>>>  "Button bar" Page 81)

2 Connection state of the robot controllers

• Connected: Connection to this robot controller has been
established

• Not available: No connection to this robot controller

Note: Robot controllers with a lower System Software version
than 8.5 are indicated as Not available, even if there is a net-
work connection.

3 Name or IP address of the robot controllers

4 Status of the most recently performed update jobs

5 Filter for the Name/Address column

6 User credentials

: User credentials are available for this robot controller
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Item Description

: No user credentials are available for this robot controller

Button bar

Button Description

Imports a CSV file

Adds a controller to the list

Removes the selected controller from the list

Saves the current list in a file

Loads a list from a file

Creates a rollout with the selected controllers

(>>> 6.34.1 "Creating a rollout" Page 89)

Changes the user credentials of the robot controllers selec-
ted in the list

6.32.2 Adding a robot controller

Precondition

• Network connection to the real robot controller
• The real robot controller and the KUKA smartHMI are running.
• The Update manager window is open.

Procedure

1. In the Update manager window, click on the  button. A window
opens.

2. Enter the IP address of the robot controller in the Address box.

Or: Click on the  button. A window opens. Select the real robot con-
troller and click on the Ok button.

3. Click on Add. The robot controller is added to the list.

Alternative procedure

1. In the window Cell view, activate the check box for the desired robot
controller. It is also possible to select more than one controller by acti-
vating the check boxes.

2. If one controller has been selected: Right-click on the controller and
select Add selected controller to update manager from the context
menu.
If more than one controller has been selected: Right-click on one con-
troller and select Add checked controllers to update manager from
the context menu.

6.32.3 Adding multiple robot controllers at the same time

Description

If the data of multiple robot controllers are saved in a CSV file, they can
be imported in WorkVisual.
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Precondition

• The Update manager window is open.
• A CSV file with the data of the robot controllers is available.

Procedure

1. Click on the  button. The Import file window opens.
(>>> Fig. 6-21)

2. Click on Browse... and navigate to the directory in which the CSV file
is located.

3. Select the CSV file and click on Open. The data are loaded and dis-
played at the bottom.

4. Assign the columns in such a way that they match the data.
5. Click on Import. The data are imported and the robot controllers are

displayed in the Update manager window. If there is a network con-
nection to the robot controllers, the connection to them is established.
Additionally, information about the update jobs is loaded and dis-
played.

Fig. 6-21: “Import file” window

Item Description

1 CSV file

2 Settings for importing the CSV file

It is possible to select here, for example, whether the values in
the file are separated by commas or semicolons.

3 Imported data

In order to be able to import the data correctly, the columns in
this area must be assigned so that they match the data.

6.32.4 Saving and loading the list of robot controllers

Description

The list of robot controllers in the Update manager window can be saved
and reloaded. Additionally, the login data of the robot controllers can be
saved and reloaded. A password is required for this.
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Precondition

• The Update manager window is open.

Procedure for saving

1. Click on the  button. A window opens.
2. Enter a name for the list in the Name of the list to save box.
3. If the login data are to be saved, activate the check box by Save user

credentials and enter a password.
4. Click on Save. The list is saved.

Procedure for loading

1. Click on the  button. A window opens.
2. In the Name of the list to be loaded box, select the list to be loaded.
3. If the login data of the robot controllers in the list are to be restored:

Activate the Restore user credentials check box and enter the pass-
word.

4. Click on Load. The list is loaded.

6.32.5 Entering user credentials

Description

The user credentials of the robot controllers in the Update manager win-
dow can be entered in WorkVisual.

Precondition

• The Update manager window is open.

Procedure

1. Select the desired robot controller. If the user credentials of multiple
robot controllers are identical and all are to be entered, press the
CTRL key and select all desired robot controllers.

2. Click on the  button.
Or: Right-click and select Set user credentials from the context
menu.

3. A window opens. Enter the user name and password and confirm with
Apply. The user credentials are saved.

6.32.6 Displaying information about the update jobs

Description

Information about the update jobs that have been performed can be dis-
played in WorkVisual. The LOG files relating to a specific update job can
also be displayed.

Precondition

• Network connection to the real robot controller
• The real robot controller and the KUKA smartHMI are running.
• The Update manager window is open.
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Procedure

1. Click on the arrow next to the desired robot controller. Information
about the update jobs that have been performed is displayed.

2. Click on the selection box and select the desired update job. The in-
formation and the LOG files relating to this update job are displayed.

3. In order to open a LOG file, double-click on the LOG file.

Fig. 6-22: Example: Information about the update jobs

Item Description

1 This selection box contains all the update jobs that have been
performed.

2 LOG files relating to the selected update job

3 Clicking on the arrow displays or hides the information about
the update jobs that have been performed.

4 Excerpt from the LOG file of the update job performed most re-
cently

6.33 Making an update bundle

This functionality is only available for robot controllers with version 8.5.

In WorkVisual, it is possible to make packages with software updates for
the purpose of distributing these to multiple robot controllers at a later
time (>>> 6.34 "Distributing updates over the network" Page 89). These
packages are hereafter referred to as update bundles.

6.33.1 Creating an update bundle

Description

2 types of update bundle can be created. The Package type contains in-
structions and the software packages to be installed. An instruction can be
used to uninstall software packages, for example. The Job type contains
instructions and may also include links to software packages located on a
server, for example. To allow software packages to be installed, the server
must be accessible to the robot controllers.

Precondition

• Programming and diagnosis workspace
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Procedure

1. Select the menu sequence Editors > Bundle manager. A window
opens.

2. Select Create new bundle in the upper selection box and assign a
name in the lower selection box.

3. Use the radio buttons to select the type of the update bundle:

• Package: Contains a file with instructions and all the software
packages to be installed.

• Job: Contains a list of instructions. If an update bundle of this type
is sent to one or more robot controllers, the update bundle is
downloaded first and then the instruction is executed.

4. Confirm with OK. The update bundle is created.

Editor

Fig. 6-23: Editor for the update bundle

Item Description

1 Here the option packages can be searched for a specific
name.

2 Filter: Source of the option packages displayed

3 Refreshes the display of the option packages

4 Opens the settings for the update bundles

5 Button bar

(>>>  "Button bar" Page 86)

6 Opens the window in which the name and type of the update
bundle can be set

7 List of the option packages

8 Option packages and/or instructions in the update bundle

Note: The sequence of the option packages specified here is
observed when executing the update job. In the case of option
packages that depend on one another, the dependent option
package must be located further down the list.

9 Settings for the option packages and instructions in the update
bundle
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Button bar

Button Description

Moves the selected instruction or option package up

Adds the selected option package to the update bundle

Creates an instruction in the update bundle

Removes the selected instruction or option package from
the update bundle

Removes all selected instructions or option packages from
the update bundle

Moves the selected instruction or option package down

6.33.2 Adding option packages to the update bundle and configuring them

Precondition

• Update bundle has been created.

Procedure

1. In the Packages area, select the source from which the option pack-
ages are to be displayed:

• All: Option packages from all sources
• Local files: Option packages located in a local directory. To be

able to use this source, the directory must be specified
(>>> 6.33.4 "Changing settings for the update bundles"
Page 88).

• Active option profile: Option packages located in the active op-
tion profile.

• Network files: Option packages located on a server. To be able to
use this source, the directory on the server must be specified
(>>> 6.33.4 "Changing settings for the update bundles"
Page 88).

2. Double-click on the desired option package in the Packages area. If
multiple option packages are to be added, select the desired option
packages and click on the  button. Option packages that have been
added are shown in the Content of the bundle area.

3. Select an option package and make the desired settings under Prop-
erties of the instruction(s):
(>>>  "Settings" Page 86)

4. Carry out step 3 for each option package added to the update bundle.
5. Save the update bundle.

Settings

Name Description

Package name Name of the package

Package type Type of package. The following types are sup-
ported:

• msi
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Name Description

• kss
• option
• script: .bat, .exe, .VBS, .PS1

Desired action Action to be executed:

• Install: Install and update
• Uninstall: Uninstall

Condition Condition for executing the update job:

• Force installation: Forces installation of
this option package.

• Upgrade: Checks whether the software is
installed and whether the specified soft-
ware version is installed.

• Installation: Checks whether the software
is installed.

• User-defined: Checks whether the speci-
fied software version is installed.

Upgrade strategy Strategy for execution of the update job:

• Keep existing data: Retains the existing
data

• Discard existing data: Deletes the exist-
ing data

Error behavior Response to an error:

• Stop executing: Execution of the update
job is stopped.

• Continue executing: Execution of the up-
date job is continued.

6.33.3 Adding instructions to the update bundle and configuring them

Precondition

• Update bundle has been created.

Procedure

1. Click on the  button. A package with instructions is created in the
Content of the bundle area.

2. Select the package and make the desired settings.
(>>>  "Settings" Page 87)

3. If user-defined attributes are to be used, enter them under User-de-
fined attributes of the bundle.

4. Save the update bundle.

Settings

Properties of the instruction(s):
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Name Description

Package name Name of the package

Package type Type of package. The following types are sup-
ported:

• msi
• kss
• option
• script: .bat, .exe, .VBS, .PS1

Desired action Action to be executed:

• Install: Install and update
• Uninstall: Uninstall

Condition Condition for executing the update job:

• Force installation: Forces installation of
this option package.

• Upgrade: Checks whether the software is
installed and whether the specified soft-
ware version is installed.

• Installation: Checks whether the software
is installed.

• User-defined: Checks whether the speci-
fied software version is installed.

Upgrade strategy Strategy for execution of the update job:

• Keep existing data: Retains the existing
data

• Discard existing data: Deletes the exist-
ing data

Error behavior Response to an error:

• Stop executing: Execution of the update
job is stopped.

• Continue executing: Execution of the up-
date job is continued.

Properties of the packages:

Name Description

Version Version of the update package

Download URL Storage location of the update package. A lo-
cal directory or the path to a server can be
specified here.

Package format File format of the update package

Checksum type Type of checksum of the update package

Checksum Checksum of the update package

6.33.4 Changing settings for the update bundles

Description

The following directories can be specified or changed in the settings for
the update bundles:
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• Directory in which the update bundles are saved by default
• Local directory in which the search for option packages is to be car-

ried out
• Directory on a server

Procedure

1. Select the menu sequence Extras > Options....
Alternatively, if an update bundle has already been created: In the
Content of the bundle area of the editor for the update bundles, click

on the  button.
The Options window is opened.

2. On the left of the window, in the UpdateManagement folder, select
the subitem BundleSettings. The corresponding settings are now dis-
played on the right of the window.

3. Click on the  button and select the desired directory.
4. If a directory on a server is to be specified or changed:

a. Select the subitem NetworkShare. The corresponding settings are
now displayed on the right of the window.

b. Enter the directory on the server as well as the user name and
password for connecting to the server.

5. Confirm with OK.

6.34 Distributing updates over the network

This functionality is only available for robot controllers with version 8.5.

In WorkVisual, it is possible for packages with software updates to be dis-
tributed to multiple robot controllers. For this purpose, a rollout needs to
be created. The rollout contains the settings for distribution as well as the
robot controllers to which the software updates are to be distributed. The
robot controllers can be added to the rollout manually or via a CSV file.

6.34.1 Creating a rollout

Precondition

• Programming and diagnosis workspace

Procedure

1. Select the menu sequence Editors > Rollout manager. A window
opens.

2. Select Create new rollout... in the upper selection box and the Emp-
ty rollout template in the lower selection box.

3. Confirm with OK. A window opens.
4. Expand the selection box under Select the update bundle and select

the desired update bundle. If the desired update bundle is not dis-
played here:

a. Click on the  button next to the selection box. A window opens.
b. Navigate to the directory where the desired update bundle is loca-

ted.
c. Select the update bundle and click on Open.

KUKA.WorkVisual 5.0

KST WorkVisual 5.0 V7 | Issued: 12.07.2018 www.kuka.com | 89/230

O
pe

ra
tio

n



5. Enter a name in the Name of the rollout box.
6. If the user credentials of the robot controllers are to be saved, activate

the check box by Save user credentials and enter a password.

The user credentials are encrypted with the password. The pass-
word is not saved.

7. In the Package provision box, choose how the update bundle is to
be provided:

• Automatic: The best method is determined automatically
• By upload: WorkVisual transfers the update bundle to the robot

controllers
• By download: WorkVisual provides a download server from which

the robot controllers can download the update bundle
• None: The update bundle is not provided by WorkVisual but, for

example, by a server
8. In the Maximum number of simultaneous downloads box, enter the

maximum number of update bundles that the robot controllers can
download simultaneously.

9. Click on Create. The rollout is created.

Alternatively, the rollout can also be created in the Update manager
window.

Editor

Fig. 6-24: Editor for the rollout

Item Description

1 Button bar

(>>>  "Button bar" Page 91)

2 State of the rollout on the robot controllers

3 Name or IP address of the robot controllers

4 User credentials

: User credentials are available for this robot controller

: No user credentials are available for this robot controller
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Button bar

Button Description

Imports a CSV file

Loads a list from a file

Adds a controller to the list

Removes the selected controller from the list

Changes the settings of the rollout

Deletes the rollout

Duplicates the rollout

Starts the rollout

Changes the user credentials of the robot controllers selec-
ted in the list

6.34.2 Adding robot controllers to the rollout

Description

There are several possible methods for adding robot controllers to the roll-
out:

• Adding robot controllers manually
• Loading a list saved in the Update manager window
• Importing a list of robot controllers from a CSV file

Precondition

• A rollout has been created and opened.

Procedure

Adding robot controllers manually:

1. Click on the  button. A window opens.
2. Enter the IP address of the robot controller in the Address box.

Or: Click on the  button. A window opens. Select the real robot con-
troller and click on the Ok button.

3. Click on Add. The robot controller is added to the list.

Loading robot controllers from a stored list.

1. Click on the  button. A window opens.
2. In the Name of the list to be loaded box, select the list to be loaded.
3. If the user credentials of the robot controllers in the list are to be re-

stored: Activate the Restore user credentials check box and enter
the password.

4. Click on Load. The list is loaded.

Importing a list of robot controllers from a CSV file:

1. Click on the  button. The Import file window opens.
(>>> Fig. 6-25)

2. Click on Browse... and navigate to the directory in which the CSV file
is located.
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3. Select the CSV file and click on Open. The data are loaded and dis-
played at the bottom.

4. Assign the columns in such a way that they match the data.
5. Click on Import. The data are imported and the robot controllers are

displayed in the rollout.

Fig. 6-25: “Import file” window

Item Description

1 CSV file

2 Settings for importing the CSV file

It is possible to select here, for example, whether the values in
the file are separated by commas or semicolons.

3 Imported data

In order to be able to import the data correctly, the columns in
this area must be assigned so that they match the data.

6.34.3 Entering user credentials

Description

The user credentials of the robot controllers in the rollout can be entered
in WorkVisual.

Precondition

• A rollout has been created and opened.
• Real robot controllers have been added to the rollout.

Procedure

1. Select the desired robot controller. If the user credentials of multiple
robot controllers are identical and all are to be entered, press the
CTRL key and select all desired robot controllers.

2. Click on the  button.
Or: Right-click and select Set user credentials from the context
menu.

3. A window opens. Enter the user name and password and confirm with
Apply. The user credentials are saved.
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6.34.4 Starting a rollout

Description

When the rollout is started, the software updates are distributed to the ro-
bot controllers and installed. After execution of the rollout, a message is
displayed for each robot controller, indicating whther the installation was
successful. If an error occurred during execution on one or more robot
controllers, the execution can be restarted for these robot controllers.

Precondition

• A rollout has been created and opened.
• Real robot controllers have been added to the rollout.
• Network connections to the real robot controllers
• The real robot controllers and the KUKA smartHMI are running.

Procedure

• Click on the  button.
Alternatively: Right-click on a robot controller and select Start rollout
from the context menu.

6.34.5 Displaying information about the completed update job

Description

After execution of the rollout, information about the update job that has
been performed can be displayed for each robot controller. The LOG file
relating to a specific update job can also be displayed.

Precondition

• Network connection to the real robot controller
• The real robot controller and the KUKA smartHMI are running.
• The rollout is open.

Procedure

1. Click on the arrow next to the desired robot controller. The information
and the LOG files relating to the completed update job are displayed.

2. In order to open a LOG file, double-click on the LOG file.

Fig. 6-26: Example: information relating to the completed update job
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Item Description

1 Completed update job

2 LOG files relating to the completed update job

3 Clicking on the arrow displays or hides the information about
the update job that has been performed

4 Excerpt from the LOG file of the completed update job

6.35 Exporting a subproject

Description

This procedure enables parts of projects to be exported, e.g. a device
with or without I/O connections. Subprojects have the file format WVPS
(“WorkVisual Partial Solution”).
If the project contains a device, parts of the project can also be exported
as a catalog. Catalogs have the file format AFC. Catalogs can be pro-
cessed further with the WorkVisual catalog editor.

Precondition

• A project is open.
• The robot controller has not been set as the active controller.

Procedure

1. Select the menu sequence File > Import / Export. A window opens.
2. Select the entry Export subproject. The window is now called Export

subproject.
Click on Next >.

3. All the controllers of the project are displayed. Select the controller
from which data are to be exported and confirm with Next >.

4. A tree structure is displayed. In the tree structure, activate the check
boxes for the elements that are to be exported. Confirm with Next >.

5. Select a path for saving the subproject.
6. Optional: Change the name of the subproject.
7. Select the format in which the subproject is to be exported:

• Export as partial project: File format WVPS
• Export as catalog: File format AFC (only possible if the project

contains a device and the device has been selected in step 4)
8. Click on Finish. The subproject is exported.
9. If the export was successful, this is indicated by the following

message in the Export subproject window: Partial export success-
ful.
Close the window.

6.36 Importing a subproject

Description

This procedure can be used to import subprojects. Subprojects can, for
example, contain devices with or without I/O connections.
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Precondition

• A project is open.
• The robot controller has not been set as the active controller.

Procedure

1. Select the menu sequence File > Import / Export. A window opens.
2. Select the Import subproject entry and click on Next >.
3. Navigate to the path where the subproject is located and select it.

Click on Open.
4. If the subproject contains several robot controllers, select the one de-

sired.
5. Click on Next >. A tree structure is displayed. The check box is active

for all elements by default.
6. In the tree structure, deactivate the check boxes for the elements that

are not to be imported.

If a device has been selected which is already present in the target
project, the newer device is imported. If PROFINET settings are im-
ported which are already present in the target project, the settings
in the target project are overwritten with the settings from the sub-
project (properties, mapping and long texts).

7. Click on Finish.
8. If I/O connections which are already mapped in the current project

were transferred together with the subproject, the Adjust signal con-
nections window is opened. The signals already mapped are dis-
played under Current conflicts:. In this case, change the start ad-
dresses for the different I/O types until no further conflicts are dis-
played. Then click on OK.

9. If the import was successful, this is indicated by the following mes-
sage: Import successful
Close the window.

6.37 Changing predefined properties of WorkVisual

6.37.1 Configuring booting and saving characteristics

Procedure

1. Select the menu sequence Extras > Options.... The Options window
is opened.

2. On the left of the window, in the Project handling folder, select the
subitem Project handling.
The corresponding settings are now displayed on the right of the win-
dow.

3. Make the desired settings.
4. Confirm the changes made with OK.

Description

Subitem Project handling:
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Parameter Description

Project folder direc-
tory:

A directory can be specified here in which the
projects are to be saved by default.

Catalog directory: This specifies the directory in which the cata-
logs are saved.

If the catalogs are moved to a different direc-
tory, the directory given here must be
changed.

Start application Here it is possible to specify whether a new
project, the most recently opened project or no
project is offered for opening when WorkVisual
is started.

6.37.2 Configuring keyboard shortcuts

Procedure

1. Select the menu sequence Extras > Options.... The Options window
is opened.

2. On the left of the window, in the Environment folder, select the subi-
tem Keyboard.
The corresponding settings are now displayed on the right of the win-
dow.

3. In the Commands box, select the command for which a keyboard
shortcut is to be defined or changed.
The contents of the Commands box can be filtered:
Enter a term in the box List only commands with the following
content. Only commands whose names contain this term are now dis-
played in the Commands box.

4. Place the cursor in the New shortcut box and confirm the desired key
combination (or individual key) on the keyboard. Examples: F8 or Ctrl
+W
The keyboard shortcut is displayed in the New shortcut box.

5. Click on Assign.
6. Confirm the change with OK.

Or: If the keyboard shortcuts are already assigned, a request for con-
firmation is displayed:

• If the keyboard shortcut is to be assigned to the new command,
select Yes and confirm the changes with OK.

• If the keyboard shortcut is to remain assigned to the old com-
mand, select No.
Close the window by selecting Cancel. Or delete the keyboard
shortcut from the New shortcut box using the Esc key, and enter
a different one.

6.37.3 Changing the user interface language

Description

Which languages are available here depends on which languages were in-
stalled with WorkVisual.
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Procedure

1. Select the menu sequence Extras > Options.... The Options window
is opened.

2. On the left of the window, select the Localization folder.
The corresponding settings are now displayed on the right of the win-
dow.

3. Select the required language in the Language box. Confirm with OK.
4. Close and restart WorkVisual.

6.37.4 Configuring additional editors

Description

Additional editors are configured using this procedure. These editors can
be used to open, compare and merge files. The first editor in the list is
the default editor.

Various editors are already preconfigured by default. These are not in-
cluded in the scope of supply of WorkVisual however. They can there-
fore only be used if they have been installed beforehand.

Procedure

1. Select the menu sequence Extras > Options.... The Options window
is opened.

2. On the left of the window, in the Additional editors folder, select the
desired subitem.
The corresponding settings are now displayed on the right of the win-
dow.

3. Click on the + button at the top right. A new program is added.
4. Enter the name of the program in the Name box.
5. In the File extension box, enter the file formats that are to be opened

with the program.
6. Click on the … button next to the Program box and select the EXE

file of the program.
7. Optionally: Enter one or more parameters in the Parameter box. The

Right arrow button displays an explanation of the parameters.

Further information about calling an external editor using the com-
mand line can be found in the vendor’s documentation for the ex-
ternal editor.

8. Confirm the changes made with OK.
9. If the editor is to be used as the default editor: Use the Up arrow but-

ton to move the editor to the top of the list.

6.37.5 Configuring the comparison of kinematic systems

Procedure

1. Select the menu sequence Extras > Options.... The Options window
is opened.

2. On the left of the window, select the Compare and merge folder. The
corresponding settings are now displayed on the right of the window.

3. Make the desired settings. Confirm with OK.
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Description

Setting options in the Compare and merge folder:

Option Description

Use Expert View • Check box active: The results of the compari-
son are displayed in a detailed list.

• Check box not active: The results of the com-
parison are displayed in the normal list.

Create log file • Check box active: During the comparison, a
log file is created automatically.

• Check box not active: During the comparison,
no log file is created.

6.37.6 Configuring code generation

Description

Here the setting can be made to determine whether code generation is af-
fected if not all options are installed in the same version in WorkVisual as
in the project.

If an option package is only installed in the project and the rule is de-
activated, the files specifically for the option package can be deleted.
We recommend always installing the option packages in WorkVisual as
well.
Exception: If an option package is not available as a KOP file, the op-
tion package cannot be installed in WorkVisual. In this case, the rule
can be deactivated.
The same option package version must be installed in the project and
in WorkVisual, as there may otherwise be errors during project deploy-
ment.

Option Description

Prevent code
generation if
not all options
are installed in
the necessary
version.

• Check box active: Code generation is aborted if
not all options are installed in the same version
in WorkVisual as in the project.

• Check box not active: Code generation is exe-
cuted, even if not all options are installed in the
same version in WorkVisual as in the project. A
warning is displayed in the message window for
each option package that is not installed in Work-
Visual.

Default setting: Check box active

Procedure

1. Select the menu sequence Extras > Options.... The Options window
is opened.

2. On the left of the window, in the Rules folder, select the subitem
Code generation. The corresponding setting is now displayed on the
right of the window.

3. Make the desired change and confirm with OK.
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6.38 Print functions

The procedure described here can be used to print the following:

• I/O connections
• Long texts
• Safety configuration
• Information about the configuration

Procedure

1. Select the menu sequence File > Print.... The Print window is
opened.

2. Select the desired printer in the Printer area. If required, change the
printer settings.

3. In the Document area, select the relevant checkboxes to indicate
what should be printed.

4. If required, first display the print preview: To do this, click on the Pre-
view button.
Close the print preview again.

5. Click on the Print button to start printing.

It is also possible to print directly from the print preview, via the button
with the printer symbol. In this case, the standard printer is used.
Changes to the printer settings are not possible.

Description

Print window, Documents area:

Check box Description

Global This function is not yet assigned.

Cell If this check box is activated, all robot control-
lers belonging to this cell are automatically ac-
tivated. Individual controllers can be deactiva-
ted again manually.

Controller […] If this check box is activated, all documents
belonging to this robot controller are automati-
cally selected for printing. Individual docu-
ments can be removed manually from the se-
lection.

Documents:

Connection list Prints the I/O connections defined in the I/O
Mappings window.

Long texts If long texts have been defined in various lan-
guages, it is also possible to select which lan-
guages should be printed.

Safety configuration The printout contains a date and signature box
and can be used as a sign-off sheet for the
safety acceptance procedure.

Robot info sheet The printout contains information about the
configuration, e.g. main programs and subpro-
grams used, tools and bases, load data, instal-
led option packages, etc.
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7 Start-up

7.1 Establishing a connection to the robot controller

Description

The WorkVisual PC can be connected to the robot controller either via the
KUKA Line Interface (KLI) or the KUKA Service Interface (KSI).

The KSI interface is only available in System Software version 8.3 or
higher.

Depending on the option and controller variant, the interfaces can be at
different locations. Further information is contained in the documenta-
tion for the robot controller.

Procedure

1. Configure the interface to be used.

• KLI: A prerequisite for the communication between the robot con-
troller and the WorkVisual PC is that both systems with the re-
spective interface are in the same network.
Information about the configuration of the KLI can be found in the
Operating and Programming Instructions for System Integra-
tors for the KUKA System Software.

• KSI: On the WorkVisual PC, set the IP address to be automatically
obtained. The robot controller assigns the WorkVisual PC an IP
address and establishes the connection as soon as the PC is con-
nected to the interface.

2. Connect the WorkVisual PC to the configured interface.

Fig. 7-1: Example: connection between WorkVisual PC and robot con-
troller

1 WorkVisual PC 3 Robot controller
2 Network cable
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8 Safety configuration

8.1 Safety configuration in WorkVisual

The safety configuration in WorkVisual comprises the following areas:

Area Description

Local safety configu-
ration

The local safety configuration comprises the
parameters in the Local safety configuration
window. The parameters can be edited.

Safety-relevant com-
munication parame-
ters

These include the parameters relevant to safe
communication within a robot network.

The safety-relevant communication parameters
cannot be displayed or edited directly. Howev-
er, various actions in WorkVisual have an ef-
fect on the safety-relevant communication pa-
rameters, e.g. if a RoboTeam is configured.

When a project is transferred to the real robot controller, the entire safety
configuration is always transferred at the same time.

8.2 Editing the local safety configuration

Description

A newly added robot controller is without a local safety configuration in
WorkVisual. A robot controller without a local safety configuration can be
recognized by the fact that the text of the Safety controller node on the
Hardware tab in the Project structure window is grayed out.
The robot controller is automatically assigned a local safety configuration
in WorkVisual when the Local safety configuration window is opened.
The robot controller is assigned a local safety configuration during code
generation, if none has been assigned already.
The local safety configuration can be edited in WorkVisual. The changes
always apply to the robot controller which is currently set as active.

Precondition

• The robot controller has been set as the active controller.
• A robot has been assigned to the robot controller.

Procedure

1. Double-click on the node Safety controller on the Hardware tab in
the Project structure window. The Local safety configuration win-
dow is opened.

2. If a safety option, e.g. SafeOperation, is used:

a. Select the Global parameters area on the General tab.
b. Set the check mark in the Safe monitoring check box there. Only

then can the monitoring functions be edited.
3. Edit the parameters of the safety configuration as required.
4. Close the Local safety configuration window.
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8.3 Parameters of the local safety configuration

The standard parameters are described here. Information about param-
eters which refer to a particular safety option can be found in the docu-
mentation for the specific safety option.

8.3.1 “General” tab (8.2)

Hardware options

Parameter Description

Customer interface Select here which interface is used:

• ProfiSafe
• SIB
• SIB, Extended SIB
• SIB with operating mode output
• SIB with operating mode output, Exten-

ded SIB
This option is available with System Soft-
ware version 8.2.4 or higher.

The following interfaces are available with the
controller variant “KR C4 compact”:

• ProfiSafe
• X11

Input signal for pe-
ripheral contactor
(US2)

• Deactivated: The peripheral contactor is
not used. (Default)

• By external PLC: The peripheral contactor
is switched by an external PLC via input
US2.

• By KRC: The peripheral contactor is
switched in accordance with the motion en-
able. If motion enable is present, the con-
tactor is energized.

Notes:

• For robot controllers with peripheral con-
tactors and the “UL” option, this parameter
must be set to By KRC.

• For robot controllers with no peripheral
contactors, this parameter is deactivated
(default setting) and is not displayed.

Operator safety ac-
knowledgement

If the “Operator Safety” signal is lost and set
again in Automatic mode, it must be acknowl-
edged before operation can be continued.

• By acknowledgement button: Acknowl-
edgement is given, for example, by an ac-
knowledgement button (situated outside
the cell). Acknowledgement is communica-
ted to the safety controller. The safety con-
troller re-enables automatic operation only
after acknowledgement.
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Parameter Description

• External unit: Acknowledgement is given
by the system PLC.

Change log

Every modification to the local safety configuration and every saving oper-
ation are automatically logged. The log is displayed here.

Machine data

The machine data of the safety controller are displayed here.

It is not necessary to press the Import machine data button. There
are currently no applications in which this is necessary.

Communication parameters

The Profinet Safety ID is displayed here. This is required if the robot con-
troller is used as a PROFINET device. The ID can be changed when Pro-
fiSafe is selected as the customer interface.

8.3.2 “General” tab (8.3 or higher)

Hardware options

Parameter Description

Customer interface Select here which interface is used:

• Automatic
• SIB with operating mode output

Input signal for pe-
ripheral contactor
(US2)

• Deactivated: The peripheral contactor is not used. (Default)
• By external PLC: The peripheral contactor is switched by an ex-

ternal PLC via input US2.
• By KRC: The peripheral contactor is switched in accordance with

the motion enable. If motion enable is present, the contactor is
energized.

Notes:

• For robot controllers with peripheral contactors and the “UL” op-
tion, this parameter must be set to By KRC.

• For robot controllers with no peripheral contactors, this parameter
is deactivated (default setting) and is not displayed.

The system variable $US2_VOLTAGE_ON indicates the status of the
peripheral voltage US2:

• TRUE: Voltage is switched on.
• FALSE: Voltage is switched off.

Operator safety ac-
knowledgement

If the “Operator Safety” signal is lost and set again in Automatic
mode, it must be acknowledged before operation can be continued.

• By acknowledgement button: Acknowledgement is given, for
example, by an acknowledgement button (situated outside the
cell). Acknowledgement is communicated to the safety controller.
The safety controller re-enables automatic operation only after ac-
knowledgement.

• External unit: Acknowledgement is given by the system PLC.

KUKA.WorkVisual 5.0

KST WorkVisual 5.0 V7 | Issued: 12.07.2018 www.kuka.com | 103/230

S
af

et
y 

co
nf

ig
ur

at
io

n



Change log

Every modification to the local safety configuration and every saving oper-
ation are automatically logged. The log is displayed here.

Machine data

The machine data of the safety controller are displayed here.

It is not necessary to press the Import machine data button. There
are currently no applications in which this is necessary.

Communication parameters

The Profinet Safety ID is displayed here. This is required if the robot con-
troller is used as a PROFINET device. The ID can be changed when the
PROFINET Device Stack is activated.

8.3.3 “Axis monitoring” tab (8.3 or higher)

Editable parameters

The following parameters can be set for each axis. It is not generally nec-
essary to change the default values, however.

Parameter Description

Braking time Duration of the axis-specific braking ramp
monitoring for safety stop 1 and safety stop 2

Default: 1,500 ms

(>>> 8.3.3.1 "Parameter Braking time"
Page 105)

Maximum velocity
T1

Maximum velocity in T1

• Rotational axes: 1.00°… 100.00°/s
Default: 30 °/s

• Linear axes: 1.00 … 1,500.00 mm/s
Default: 250 mm/s

This parameter enables a servo gun, for ex-
ample, to be calibrated in T1 with a higher ve-
locity than 250 mm/s.

Note: The Cartesian velocities at the flange
and at the TCP are monitored independently
of this parameter and cannot exceed
250 mm/s.

(>>> 8.3.3.2 "Parameter: Maximum velocity
T1" Page 106)

Position tolerance Tolerance for standstill monitoring in the case
of safe operational stop. The axis may still
move within this tolerance when a safe opera-
tional stop is active. 

• Rotational axes: 0.001 … 1 °
Default: 0.01 °

• Linear axes: 0.003 - 3 mm
Default: 0.1 mm
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WARNING
Following modifications to the Maximum velocity T1 parameter, the
new value must be checked. The new value must also be checked if it
is smaller than the previous value.
(>>> 8.3.3.3 "Checking the limits for the maximum axis velocity in T1
mode" Page 107)

8.3.3.1 Parameter Braking time

Description

If a safety stop 1 or 2 occurs, the safety controller monitors the braking
process. Among other things, it monitors whether the axis-specific velocity
remains below its monitoring ramp. If the velocity is too high, i.e. if the
ramp is violated, then the safety controller triggers a safety stop 0.
The monitoring ramp can be specified using the parameter Braking time.

The parameter Braking time modifies the monitoring ramp. It does not
modify the actual time required by the kinematic system for braking.

WARNING
Only alter the default time if it is necessary to do so. This might be re-
quired, for example, in the case of very heavy machines and/or very
heavy loads as these cannot stop within the default time.
The safety recovery technician must check whether and to what extent
the Braking time value needs to be modified in each specific applica-
tion. He must also check whether the modification makes additional
safety measures necessary, e.g. installation of a gate lock.

The monitoring ramp is determined as follows:

• The robot controller subtracts 200 ms from the value of the parameter
Braking time (taking into account the brake closing time). The result
is the monitoring time. For example, the default value of 1 500 ms re-
sults in a monitoring time of 1 300 ms.
When this time has elapsed, another monitoring function begins:

• The ramp has plateaus of 300 ms at the start and end.
The plateau at the start is always 106% of the rated speed of the
axis. The plateau at the end is always 10.6 %.

Fig. 8-1: Monitoring ramp

1 Velocity profile during braking (example)
2 Monitoring ramp (default value Braking time 1 500 ms)
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3 From this moment on, standstill monitoring begins.
vrs Rated speed of the axis (rs = "rated speed")

t Time

The value “0” on the time axis is the moment at which the
safety stop 1 or 2 begins.

Limitations

• Braking time can be configured separately for each axis; at the mo-
ment of braking, however, the value used for all axes is always the
highest value entered.
Recommendation: for greater transparency, enter the same value for
all axes.

• The parameter Braking time usually has no effect in T1, since it re-
fers to the axis-specific monitoring. In T1, however, there is another
(non-configurable) monitoring function for the Cartesian velocity on the
flange. This is usually stricter.

Value increased

If the value Braking time is increased, this has the following effect:
The monitoring ramp becomes longer and flatter, i.e. monitoring is now
less strict. There is now a lower probability that a braking process will vio-
late the ramp.

Fig. 8-2: Example: value is increased

1 Velocity profile during braking (example)
2 Monitoring (lower Braking time value)
3 Monitoring (higher Braking time value)

Value reduced

If the value “Braking time” is reduced, this has the following effect:
The monitoring ramp becomes shorter and steeper, i.e. monitoring is now
stricter. There is now a higher probability that a braking process will vio-
late the ramp.

8.3.3.2 Parameter: Maximum velocity T1

Description

The safety controller monitors whether the maximum velocity in T1 re-
mains below the configured values even for axes which are configured as
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couplable or grouped together in coupling groups. Axes which are config-
ured as couplable or grouped together in coupling groups are not dis-
played in the safety configuration. To be able to alter the configured val-
ues for these axes, the coupling must be temporarily canceled.

WARNING
Only alter the default value if it is necessary to do so. This can be the
case, for example, when positioning welding guns if these are to be
moved at process velocity in T1 mode.
The safety recovery technician must check whether and to what extent
the Maximum velocity T1 value needs to be modified in each specific
application. He must also check whether the modification makes addi-
tional safety measures necessary, e.g. installation of a gate lock.

Procedure

1. Select the menu sequence Editors > Drive configuration.
2. Right-click on the coupling axes or the coupling group and select Dis-

able axis coupling or Remove coupling group from the context
menu. The coupling is canceled. For the coupling axes, this step must
be carried out for each axis individually.

3. On the Axis monitoring tab, modify the value of the Maximum ve-
locity T1 parameter as desired for the individual axes.

4. In the Drive configuration window, right-click on the motors to be
coupled.

5. Select Enable axis coupling or Create coupling group in the con-
text menu. The motors are now displayed as coupling axes or a cou-
pling group again.

8.3.3.3 Checking the limits for the maximum axis velocity in T1 mode

Description

Following modifications to the parameter Maximum velocity T1, the new
value must be checked. The new value must also be checked if it is
smaller than the previous value.
To perform the check, the value is intentionally exceeded using a test pro-
gram. The safety controller then stops the robot.

Procedure

Checking the limit for rotational axes:

SAFETY INSTRUCTION
The following procedure must be followed exactly!

1. Create a test program in which the axis velocity is intentionally excee-
ded (e.g. by moving axis A1 at 25°/s although it is configured with 20°/
s).

a. Calculate the axis velocity $VEL_AXIS[x].
(>>>  "Example calculation of $VEL_AXIS" Page 108)

b. Enter the axis velocity $VEL_AXIS[x] in the test program.
2. Execute the test program in T1 mode.

The safety controller stops the robot.
If the robot is stopped by the safety controller, a message with mes-
sage number 15xxx is displayed.
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3. If the robot does not stop, or if either no message or a message from
a different number range is displayed, this indicates that the value for
Maximum velocity T1 has been incorrectly configured or that values
have been programmed in the test program that are not appropriate
for the configured maximum value.
Check the configuration and the test program, correct if necessary and
check the limit again.

Checking the limit for linear axes:

SAFETY INSTRUCTION
The following procedure must be followed exactly!

1. Create a test program in which the axis velocity is intentionally excee-
ded (e.g. by moving a linear axis at 110 mm/s although it is configured
with 100 mm/s).

2. Execute the test program in T1 mode.
The safety controller stops the robot.
If the robot is stopped by the safety controller, a message with mes-
sage number 15xxx is displayed.

3. If the robot does not stop, or if either no message or a message from
a different number range is displayed, this indicates that the value for
Maximum velocity T1 has been incorrectly configured or that values
have been programmed in the test program that are not appropriate
for the configured maximum value.
Check the configuration and the test program, correct if necessary and
check the limit again.

Example calculation of $VEL_AXIS

Calculate the axis velocity $VEL_AXIS[x] as follows:
$VEL_AXIS[x] = (VTest / Vmax) * 100 = (25°/s / 360°/s) * 100 = 7

Element Description

x Number of the axis

Vtest Desired test velocity (in this example, 25°/s)

Unit: °/s

Vmax Maximum axis velocity according to the data sheet of
the robot

Unit: °/s

Enter the calculated axis velocity $VEL_AXIS[x] in the test program:

...
PTP {A1 -30}
HALT
$VEL_AXIS[1] = 7
PTP {A1 30}
...
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8.4 Importing the safety configuration (SCG import)

WARNING
After importing a safety configuration or parts thereof, the safety config-
uration must be checked! If this is not done, this can lead to the possi-
bility of the robot being operated with incorrect data when the project is
transferred to the real robot controller. Death to persons, severe injuries
or considerable damage to property may result.
To avoid this, the current safety configuration on the robot controller
can be compared with the safety configuration in the SCG file.
(>>> 8.8 "Comparing the safety configuration" Page 112)

Precondition

• The robot controller has been set as the active controller.

Procedure

1. Select the menu sequence File > Import / Export. A window opens.
2. Select Import local safety configuration and click on Next.
3. Navigate to the path where the SCG file is located and select it. Click

on Open.
4. Click on Finish.
5. If the configuration was imported successfully, this is indicated by a

message. Close the window.

8.5 Exporting the safety configuration (SCG export)

Description

The local safety configuration can be exported as an SCG file. This file
contains all the parameters for the safety configuration. Exporting is al-
ways possible, irrespective of whether a safety option is installed or not.
Only saved values of the safety configuration are exported. Values that
have been changed but not saved are not included in the export.

Precondition

• The robot controller has been set as the active controller.

Procedure

1. Select the menu sequence File > Import / Export. A window opens.
2. Select Export local safety configuration and click on Next.
3. Click on Browse… and specify a directory.
4. Specify a file name, select the file type SCG and click on Save.
5. Click on Finish.
6. If the configuration was exported successfully, this is indicated by a

message. Close the window.
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8.6 Importing a safety configuration (XML import)

WARNING
After importing a safety configuration or parts thereof, the safety config-
uration must be checked! If this is not done, this can lead to the possi-
bility of the robot being operated with incorrect data when the project is
transferred to the real robot controller. Death to persons, severe injuries
or considerable damage to property may result.

Description

Certain parts of the local safety configuration can be imported as an XML
file. These are:

• Cell area configuration
• Monitoring spaces (Cartesian spaces and/or axis spaces)
• Properties of the tools
• Global parameters

In order to generate an XML file for importing, the user has the following
options:

• Export the current safety configuration of the robot controller to an
XML file and edit it. In this way it is possible to ensure that the format
of the XML file is correct for a subsequent import (>>> 8.7 "Exporting
the safety configuration (XML export)" Page 112).

• Generate the XML file on the basis of the XML schema C:\Program
Files (x86)\KUKA\WorkVisual [Version number]\Schemes\SafetyConfi-
gImport.xsd, e.g. using a script programmed by the user.

The following points must be observed when editing the XML files:

• The XML schema defines the structure of the XML file for the import.
For individual parameters, the XML schema allows higher values than
the installed version of the safety option.

• Parameters and values that are not supported by the current safety
option are not imported. During the import, WorkVisual generates a
message to this effect.

It is also possible to import safety configurations in the system soft-
ware. Information about this can be found in the documentation of the
safety options (e.g. SafeOperation).

Precondition

• The robot controller has been set as the active controller.
• The safety option SafeOperation or SafeRangeMonitoring is used.

Procedure

1. Save the project. (Do not close.)
2. Select the menu sequence File > Import / Export. A window opens.
3. Select Import local safety configuration and click on Next >.
4. Click on Search…. Navigate to the path where the XML file is located

and select it. Click on Open.
5. Click on Next >. In the background, the window Local safety config-

uration is opened, if not already open.
6. If there are errors: error messages are displayed in the import window.

The import cannot be carried out until these errors have been elimina-
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ted. Rectify the errors in the XML file, repeat the XML import and save
the safety configuration.

7. If there are no errors: the differences between the existing values and
those to be imported are displayed in the Import window
(>>> Fig. 8-3).

8. Check all values.
If not all of the required safety functions are configured correctly, or if
the wrong XML file was selected, cancel the XML import.

• Rectify the error in the XML file and repeat the XML import.
• OR: Select the correct XML file and repeat the XML import.

9. Click on Import. The data are now imported.
10. When the import is finished, this is indicated by the following mes-

sage: The local safety configuration was imported successfully.
Close the window.

11. Check the safety configuration. The modified values are displayed in
blue in the Local safety configuration window.

12. Save the project to accept the imported data.

The imported data are only accepted when the project is saved.
This also means that imported data can be discarded by closing the
project without saving.

Parameter comparison view

Fig. 8-3: Example: Displaying the differences

Color Meaning

Blue With this element (or its child elements), the existing value
differs from the value to be imported.

Black With this element (including all its child elements), the ex-
isting value is identical to the value to be imported.

If the check mark is set in the Show import column, the Import value
column is displayed. The values contained in the XML file are displayed in
this column.
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8.7 Exporting the safety configuration (XML export)

Description

Certain parts of the local safety configuration can be exported as an XML
file. These are:

• Cell configuration
• Monitoring spaces (Cartesian spaces and/or axis spaces)
• Properties of the tools
• Global parameters

The XML file always contains all the parameters which are contained in
the exported parts of the safety configuration.
Exporting is always possible, irrespective of whether a safety option is in-
stalled or not. However, an export only makes sense if a safety option is
installed.
The current safety configuration of the robot controller is exported. If the
safety configuration contains unsaved changes, these are also exported.
If invalid values are entered in the safety configuration, the export is abor-
ted with an error message (plausibility error).

It is also possible to export safety configurations in the system soft-
ware. Information about this can be found in the documentation of the
safety options (e.g. SafeOperation).

Precondition

• The robot controller has been set as the active controller.

Procedure

1. Select the menu sequence File > Import / Export. A window opens.
2. Select Export local safety configuration and click on Next.
3. Click on Browse… and specify a directory.
4. Specify a file name, select the file type XML and click on Save.
5. Click on Finish.
6. If the configuration was exported successfully, this is indicated by a

message. Close the window.

8.8 Comparing the safety configuration

Description

To avoid importing an undesired safety configuration, the current safety
configuration on the robot controller can be compared with the safety con-
figuration in the SCG file.

Procedure

1. Load the active project from the robot controller in WorkVisual.
(>>> 14.7 "Loading the project from the robot controller" Page 186)

2. Import the safety configuration (SCG file).
(>>> 8.4 "Importing the safety configuration (SCG import)" Page 109)

3. Export parts of the safety configuration (XML file) out of the project.
(>>> 8.7 "Exporting the safety configuration (XML export)" Page 112)

4. Close the project. (Do not transfer to the robot controller.)
5. Reload the active project from the robot controller.

KUKA.WorkVisual 5.0

112/230 | www.kuka.com KST WorkVisual 5.0 V7 | Issued: 12.07.2018

S
af

et
y 

co
nf

ig
ur

at
io

n



6. Import the parts of the safety configuration from step 3 into the
project.
(>>> 8.6 "Importing a safety configuration (XML import)" Page 110)

7. Compare the parts of the safety configuration with one another.
8. If the parts of the safety configuration are as required, import the safe-

ty configuration (SCG file) and transfer it to the robot controller.

8.9 Resetting the safety configuration

Description

This procedure can be used to reset the safety configuration. This may be
necessary, for example, if the system software is to be changed to a ver-
sion whose safety configuration is not compatible with the current one. In
this way, only the safety configuration is recreated – all other settings in
the project are retained.
When the safety configuration is reset, all settings are reset to the default
settings and the project is automatically saved. This process cannot be
undone.

Precondition

• The robot controller has not been set as the active controller.

Procedure

1. Right-click on the node Safety controller on the Hardware tab in the
Project structure window.

2. Select Reset in the context menu.
3. Answer the request for confirmation with Yes. The safety configuration

is reset.
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9 Field bus configuration

9.1 Overview of field buses

The following field buses can be configured with WorkVisual:

Field bus Description

PROFINET An Ethernet-based field bus. Data exchange is car-
ried out on a client-server basis. PROFINET is instal-
led on the robot controller.

PROFIBUS Universal field bus which enables communication be-
tween devices from different manufacturers without
special interface adaptations. Data exchange is car-
ried out on a master-slave basis.

DeviceNet CAN-based field bus used primarily in automation
technology. Data exchange is carried out on a mas-
ter-slave basis.

EtherNet/IP An Ethernet-based field bus. Data exchange is car-
ried out on a client-server basis. EtherNet/IP is in-
stalled on the robot controller.

EtherCAT An Ethernet-based field bus suitable for real-time re-
quirements.

VARAN slave Field bus that can be used to establish communica-
tion between a VARAN controller and a KR C4 con-
troller.

For configuration of a field bus, the documentation of the field bus is
required.

9.2 Field bus set-up

9.2.1 Overview: field bus set-up

Step Description

1 Install the device description files on the PC.

(>>> 6.8 "Importing device description files" Page 35)

2 Insert the DTM Catalog in the Catalogs window.

(>>> 6.9.2 "Inserting a catalog in a project" Page 36)

3 Insert the field bus master in the project.

(>>> 9.2.2 "Inserting a field bus master in a project"
Page 115)

4 Configure the field bus master.

(>>> 9.2.3 "Configuring the field bus master" Page 115)

5 Add the devices to the bus, i.e. insert them under the field
bus master.

(>>> 9.2.4 "Inserting devices manually into the bus"
Page 116)

or:
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Step Description
(>>> 9.2.6 "Automatically inserting devices into the bus
(Bus Scan)" Page 116)

6 Configure the devices.

(>>> 9.2.5 "Configuring devices" Page 116)

7 Edit the field bus signals

(>>> 9.3 "Editing field bus signals" Page 117)

8 The bus I/Os can now be mapped.

(>>> 9.4 "Mapping the bus I/Os" Page 122)

9.2.2 Inserting a field bus master in a project

Precondition

• The device description files are inserted in the DTM Catalog (Catalog
Scan).

• The robot controller has been added and set as active.

Procedure

1. Expand the tree structure on the Hardware tab in the Project struc-
ture window until the Bus structure node is visible.

2. Select the required field bus master in the DTM Catalog window and
drag it onto the Bus structure node.

9.2.3 Configuring the field bus master

Precondition

• The field bus master is inserted in the project.
• The robot controller has been set as the active controller.

Procedure

1. Right-click on the field bus master on the Hardware tab in the Project
structure window.

2. Select Settings… from the context menu. A window opens with
device data.

3. Set the data as required and save with OK.

NOTICE
The following address ranges are used by default by the robot control-
ler for internal purposes. IP addresses from this range must not there-
fore be assigned by the user. 
• 192.168.0.0 … 192.168.0.255
• 172.16.0.0 … 172.16.255.255
• 172.17.0.0 … 172.17.255.255

Information about settings for particular bus systems can be found in
the documentation for these bus systems.
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9.2.4 Inserting devices manually into the bus

NOTICE
The inserted device must correspond to the actual device used in reali-
ty. Substantial damage to property may otherwise result.

Precondition

• The devices are inserted in the DTM Catalog.
• The field bus master is inserted in the bus structure.
• The robot controller has been set as the active controller.

Procedure

1. Expand the tree structure on the Hardware tab in the Project struc-
ture window until the field bus master is visible.

2. Select the required device in the DTM Catalog and drag it onto the
field bus master.

3. If necessary, repeat step 2 for further devices.

9.2.5 Configuring devices

Precondition

• The device has been added to the bus.
• The robot controller has been set as the active controller.

Procedure

1. Right-click on the device on the Hardware tab in the Project struc-
ture window.

2. Select Settings… from the context menu. A window with the device
data is opened.

3. Set the data as required and save with OK.

NOTICE
The following address ranges are used by default by the robot control-
ler for internal purposes. IP addresses from this range must not there-
fore be assigned by the user. 
• 192.168.0.0 … 192.168.0.255
• 172.16.0.0 … 172.16.255.255
• 172.17.0.0 … 172.17.255.255

Information about settings for particular bus systems can be found in
the documentation for these bus systems.

9.2.6 Automatically inserting devices into the bus (Bus Scan)

Description

The bus scan is available for Interbus and EtherCAT.
The bus devices can be inserted automatically. For this, the user can start
a scan in WorkVisual to determine which devices are connected to the re-
al bus. The corresponding devices are then inserted automatically into the
bus structure in WorkVisual.
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In contrast to manual insertion, this procedure is faster and less suscepti-
ble to error.

Precondition

• The devices are inserted in the DTM Catalog.
• The field bus master is inserted in the bus structure.
• The robot controller has been set as the active controller.
• Network connection to the real robot controller
• The devices are connected to the real robot controller.

There are further preconditions depending on the bus system used. In-
formation about this is contained in the documentation for the different
bus systems.

Procedure

1. Expand the tree structure of the robot controller on the Hardware tab
in the Project structure window.

2. Right-click on the field bus master. Select the option Scan Topolo-
gy… and then select a channel. The Topology Scan Wizard window
is opened.

3. Click on Continue to start the scan. When the scan is completed,
WorkVisual displays all the devices found in the window on the left.
Each device is represented by a number (= product code).

4. Select a device. In the window on the right, WorkVisual displays a list
of the device description files which have the same product code.

5. If the list contains a number of device description files, scroll down the
list and check if the file of the device that is actually used is selected.
If a different file is marked, select the option Manual selection and
select the correct file.

6. Repeat steps 4 and 5 for all devices shown.
7. Click on Continue to confirm the assignment.
8. Click on Finish to assign the devices to the field bus master.

9.3 Editing field bus signals

Description

Field bus signals can be edited in WorkVisual. For example, the signal
width can be changed or the byte order can be swapped.

Precondition

• The field bus devices are configured.

Procedure

1. Select the device on the Field buses tab in the I/O Mapping window.
2. In the I/O Mapping window, click on the Edit signals at the provider

button. The Signal editor window is opened. All inputs and outputs of
the device are displayed.
(>>> 9.3.1 "Signal Editor" Page 118)

3. Edit the signals as required.
4. Click on OK to save the changes and close the Signal editor window.
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9.3.1 Signal Editor

In the Signal Editor, the inputs of the selected device are displayed on the
left and the outputs on the right.

Fig. 9-1: Signal Editor

Item Description

1 The left-hand column displays the original configuration of the
inputs or outputs. Each box represents 1 bit.

2 The right-hand column can be edited and always displays the
current configuration of the inputs or outputs. Each box repre-
sents 1 bit.

3 Signal name

(>>> 9.3.5 "Changing signal names" Page 121)

4 Start mark for swapping

(>>> 9.3.3 "Swapping signals (reversing the byte order)"
Page 120)

5 Address at which this signal starts

6 Signal width

(>>> 9.3.2 "Changing the bit width of signals" Page 119)

7 Address to which this bit belongs, and number of the bit
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Item Description

8 The bar indicates that the byte order has been swapped.

9 Boundary between memory segments

10 Data type of this signal

(>>> 9.3.4 "Changing the data type" Page 121)

9.3.2 Changing the bit width of signals

Description

This procedure can be used to change the width of signals. Signals can
be split or grouped. It is also possible to split signals more than once.
The signal boundaries can be moved only as far as the boundaries of the
memory segments. Signal boundaries cannot be moved beyond the boun-
daries of swapped ranges.
Bits that are being edited are indicated in red.

Precondition

• The Signal Editor is open.
• The signals that are to be edited are not mapped.

Procedure

Moving a signal boundary:

1. In the right-hand column, position the mouse pointer over the boun-
dary line between 2 signals. The mouse pointer changes into a
vertical double arrow.

2. Click and hold down the mouse button and move the mouse pointer
up or down. The boundary line is moved.

3. Drag the boundary line to the desired position and let go.

This procedure can be used to reduce a signal down to the size of 1 bit.
Splitting a signal:

1. In the right-hand column, position the mouse pointer over a bit.
2. Click and hold down the mouse button and move the mouse pointer

up or down. A line is displayed over the output bit.
3. Drag the mouse pointer to another bit and let go. A line is also dis-

played over this bit. The two lines are the boundaries of the new sig-
nal.

Grouping signals:

1. In the right-hand column, position the mouse pointer over the first (or
last) bit of a signal.

2. Click and hold down the mouse button and move the mouse pointer
down (or up).

3. Drag the mouse pointer across a signal boundary to another signal
boundary and let go. The intervening signal boundary disappears. The
signals have been grouped.
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9.3.3 Swapping signals (reversing the byte order)

Description

The byte order of signals can be swapped. It is possible to swap 2, 4 or 8
bytes at once. Sub-ranges of signals cannot be swapped. Furthermore, it
is not possible to swap across the boundaries of memory segments.
The bits within a byte always remain unchanged.

The (V)KR C4 robot controller uses the Intel data format. Field bus sig-
nals in Motorola format must be converted to Intel. This is done by
means of swapping.

It is not always clear from the manufacturer’s data sheets whether a
signal needs to be swapped or not. The signals of Siemens devices
generally need to be swapped. The following procedure can provide in-
formation about whether it is necessary to swap an input:
1. Change the voltage on the input slowly and evenly.
2. Observe the values for this signal in the Analog I/O window on the

KUKA.smartHMI.

If the values change abruptly and unevenly or in different directions,
this is an indication that swapping is necessary.

It makes a difference whether a range is swapped as a whole or in parts:

Fig. 9-2: Example 1: Swapping the byte order

Item Description

1 Original order

2 Result of swapping the bytes in two groups (i.e. the first two
bytes are swapped and the second two bytes are swapped
separately.)

Fig. 9-3: Example 2: Swapping the byte order

Item Description

1 Original order

2 Result of swapping all the bytes at once

Precondition

• The Signal Editor is open.

Procedure

1. Position the mouse pointer over a start mark for swapping. The mouse
pointer changes into a vertical double arrow.
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2. Click and hold down the mouse button. Move the mouse pointer
downwards to the signal boundary.

3. A bar is displayed.

• Either: Release the mouse button. The byte order has now been
swapped.

• Or: If a larger range is to be swapped, keep moving the mouse
pointer without letting go. A longer bar is displayed. Release the
mouse button. The byte order has now been swapped.

An end mark for swapping is displayed.

To undo the swapping:

1. Position the mouse pointer over an end mark for swapping. The
mouse pointer changes into a vertical double arrow.

2. Click and hold down the mouse button. Move the mouse pointer up to-
wards the start mark.

3. The bar disappears. The swapping has been undone.

9.3.4 Changing the data type

Description

In the Signal Editor, the data type is displayed by an icon.

Icon Description

Integer data type with sign (depending on the length:
SINT, INT, LINT or DINT)

Integer data type without sign (depending on the
length: USINT, UINT, ULINT or UDINT)

Digital data type (depending on the length: BYTE,
WORD, DWORD or LWORD)

(The exact data type of a signal is displayed in the I/O Mapping window.)
The data type must changed e.g. if a signal needs to be used as an ana-
log output or input but is only designated as a digital data type in the de-
vice description file.

Precondition

• The Signal Editor is open.

Procedure

1. Click on the icon for the sign on the right-hand side of the input or
output column. The icon changes.

2. Click until the desired symbol is displayed.

9.3.5 Changing signal names

Precondition

• The Signal Editor is open.

Procedure

1. Click on the name of the input or output in the right-hand column. The
name can now be edited.

2. Enter the desired name and confirm with the Enter key.
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The name must be unambiguous within the current view of the Signal
Editor.

The changed name is displayed in the I/O Mapping window.

9.4 Mapping the bus I/Os

9.4.1 I/O Mapping window

Overview

Fig. 9-4: I/O Mapping window

Item Description

1 Display of the input/output types and field bus devices. The
two areas to be connected are selected on the left and right
via tabs.

The signals in the areas selected here are displayed in the
windows lower down.

2 Display of the mapped signals.

3 Display of all signals. The inputs/outputs can be mapped here.

(>>> 9.4.3 "Mapping input to output" Page 124)

4 This allows the two signal displays to be collapsed and expan-
ded independently of one another.

5 Displays how many bits the selected signals contain.

Mapped signals are indicated by green symbols.

Multiply mapped signals are indicated by double arrows: 
(>>> 9.4.2 "Buttons in the I/O Mapping window" Page 123)
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Tabs:

Name Description

KR C I/Os Here the analog and digital inputs/outputs of the ro-
bot controller are displayed. There is a KR C I/Os
tab on the left and on the right. This makes it possi-
ble to map inputs and outputs of the robot controller
with each other.

PLC These tabs are only relevant if Multiprog is used.

KR C signals Here the other signals of the robot controller are dis-
played.

Field buses Here the inputs/outputs of the field bus devices are
displayed. There is a Field buses tab on the left
and on the right. Only bus inputs are displayed on
the left, and only bus outputs are displayed on the
right.

From System Software version 8.3, these tabs can
be used to map the inputs and outputs of 2 field
buses.

9.4.2 Buttons in the I/O Mapping window

Filter/ Search

Some of these buttons are displayed in several places. In such cases,
they refer to the side of the I/O Mapping window on which they are loca-
ted.
With some buttons, the tool tip changes depending on whether the signals
they refer to are shown or hidden.

Button Name / description

Filter inputs/Display all input signals: Shows and hides
the inputs.

Filter outputs/Display all outputs: Shows and hides the
outputs.

Filter dialog: The Filter signals window is opened. Enter
filter criteria (name, data type and/or signal range) and
click on the Filter button. Signals that conform to these cri-
teria are displayed.

When a filter is set, the button displays a green check
mark at bottom right. To remove a filter that has been set,
click on the button and, in the Signals window, click on the
Reset button and then on Filter.
Buttons above the “connected signals” window:

Search for the connected signal: Only available if a map-
ped signal is selected.

(>>> 9.4.7 "Searching for assigned signals" Page 127)

Button below the “all signals” window:

Search text: Displays a search box. Here it is possible to
search the signal displays for signal names (or parts of
names), either upwards or downwards.
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Button Name / description
When the search box is displayed, the button displays a
cross at bottom right. To hide the search box again, click
on the button.

Filter connected signals/Display all connected signals

Shows and hides the connected signals.

Filter disconnected signals/Display all unconnected
signals

Shows and hides the unconnected signals.

Mapping

Button Name / description

Disconnect: Disconnects the selected mapped signals. It
is possible to select and disconnect a number of connec-
tions simultaneously.

Connect: Connects signals which are selected in the “all
signals” display. It is possible to select a number of signals
on both sides and connect them at one go. (Only possible
if the same number of signals is selected on both sides.)

Edit

Button Name / description

Creates signals at the provider

Only relevant if Multiprog is used.

Edit signals at the provider

For field bus signals: opens an editor in which the bit as-
signment of the signals can be edited.

(>>> 9.3 "Editing field bus signals" Page 117)

Editing options are also available here for the analog in-
puts/outputs of the KRC and for Multiprog signals.

(>>> 9.4.9 "Editing analog KRC signals" Page 129)

Deletes signals at the provider

Only relevant if Multiprog is used.

Information about Multiprog is contained in the KUKA.PLC Multiprog
documentation.

9.4.3 Mapping input to output

Description

This procedure is used to assign the inputs and outputs of the devices to
the inputs and outputs of the robot controller.
By the same principle, it is also possible to map inputs and outputs of the
robot controller to each other. (In this case, the KR C I/Os tab must be
used in both halves of the window.)

Precondition

• The robot controller has been set as the active controller.
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• The bus configuration in WorkVisual corresponds to the real bus con-
figuration.

• The field bus devices are configured.

Procedure

1. Click on the Mapping editor button. The I/O Mapping window is
opened.

2. On the KR C I/Os tab in the left-hand half of the window, select the
area of the robot controller that is to be mapped, e.g. Digital inputs.
The signals are displayed in the bottom area of the I/O Mapping win-
dow.

3. Select the device on the Field buses tab in the right-hand half of the
window.
The signals of the device are displayed in the bottom area of the I/O
Mapping window.

4. Drag the signal of the robot controller onto the input or output of the
device. (Or alternatively, drag the input or output of the device onto
the signal of the robot controller.)
The signals are now mapped.

Alternative procedure for mapping:

• Select the signals to be mapped and click on the Connect button.
• Or: Select the signals to be mapped and select the Connect option

from the context menu.

Multiple mapping:
It is possible to select a number of signals simultaneously (on both sides)
and connect them at one go. A further possibility is as follows:

1. Select a number of signals on one side and one signal on the other
side.

2. Select the option Connect continuously from the context menu. The
signals are connected (counting upwards), starting from the one selec-
ted signal.

9.4.4 Mapping bus inputs to bus outputs by means of I/O linking (8.2)

Description

With I/O linking, a bus input can be mapped to a bus output (in the same
or a different bus). This is done indirectly. A total of 3 mappings are re-
quired for this.

Procedure

1. Map the bus input to an input of the robot controller.
2. Map the robot controller input to a robot controller output.
3. Map the robot controller output to a bus output.

The input and output of the robot controller are thus multiply mapped in
this case.
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Schematic

Fig. 9-5: Schematic: Mapping bus input to bus output

9.4.5 Mapping bus inputs to bus outputs using the transfer application (8.3
or higher)

Description

With the transfer application, a bus input can be mapped directly to one
or more bus outputs (in the same or a different bus). For this, the Field
buses tab is used in both halves of the window.
A maximum of 2048 bus inputs can be mapped to bus outputs. If one bus
input is mapped to multiple bus outputs, the number of bus outputs is the
determining factor.
If more than 512 bus inputs are to be mapped to bus outputs, the connec-
tions must be made in blocks. With block mapping, both the bus inputs
and the bus outputs of a block must be adjacent, i.e. there must not be
any gaps in between. Furthermore, the bus inputs and outputs of a block
must be within one slot.
Example: In the PROFINET field bus, the signal names contain slots and
index numbers. The index numbers stand for the bits, i.e. index number
0001 = bit 1, index number 0002 = bit 2, etc. If 2 adjacent bits within the
same slot are mapped (e.g. bit 1 and bit 2 of slot 2), this results in 1
block mapping. However, if 2 non-adjacent bits or 2 bits from different
slots are mapped (e.g. bit 4 of slot 1 and bit 5 of slot 3), no block map-
ping results.

In System Software version 8.3 and higher, safe outputs have a yellow
background. These outputs must not be mapped!

Schematic

Fig. 9-6: Schematic: Mapping a bus input to bus outputs

It is possible to use a WorkVisual project with direct bus mappings with
a lower System Software version. However, the mappings have no ef-
fect in the lower version.

KUKA.WorkVisual 5.0

126/230 | www.kuka.com KST WorkVisual 5.0 V7 | Issued: 12.07.2018

Fi
el

d 
bu

s 
co

nf
ig

ur
at

io
n



9.4.6 Multiple mapping or reverse mapping of signals via I/O linking

Possible

Signals can be multiply mapped via I/O linking. Multiply mapped signals

are indicated in the I/O Mapping window by a double arrow: 
The following multiple mapping is possible:

• Map an input (robot controller) to an input (bus).
• Map the same input (robot controller) to one or more outputs (robot

controller).

Fig. 9-7: Multiple mapping possible

The following reverse mapping is possible:

• Map an output (bus) to an input (robot controller).

Fig. 9-8: Reverse mapping possible

Not possible

The following multiple mappings are not possible:

• Map an input (robot controller) to several inputs (bus).
• Map an output (robot controller) to several outputs (bus).

Fig. 9-9: Multiple mapping not possible

9.4.7 Searching for assigned signals

Procedure

1. Select a mapped signal.
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2. In the part of the window in which the signal was selected (left-hand
or right-hand half), click on the button Searches for the connected
signal.

• If a signal is mapped once: the assigned signal is now highlighted
in the other half of the “all signals” window.

• If a signal is multiply mapped: the Search for signal window
opens. All signals connected with the selected signal are shown.
Select a signal and confirm with OK.

Fig. 9-10: Example: Multiply mapped signal

9.4.8 Grouping signals

Description

8 digital inputs or outputs of the robot controller can be grouped together
to form a signal of the data type SINT, USINT or BYTE. Grouped signals
can be recognized by the name extension #G.

Precondition

• The signals that are to be grouped are not mapped.

Procedure

1. Below the KR C I/Os tab, select 8 consecutive signals and right-click
on them.

2. Select Group. A window opens.
3. Select the data type and confirm with OK.

The signals are grouped to a signal of the selected data type. The
name with the lowest index number is taken for the new signal.

To undo the grouping:

1. Right-click on a signal with the name extension #G.
2. Select Ungroup.
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Example

Fig. 9-11: Group signals

Fig. 9-12: A grouped signal

9.4.9 Editing analog KRC signals

Procedure

1. Select the analog signal on the left-hand KR C I/Os tab in the I/O
Mapping window.
It is also possible to select and edit several signals at once: Consecu-
tive signals can be selected using SHIFT + click. A number of individ-
ual signals can be selected using CTRL + click.

2. At the bottom left of the I/O Mapping window, click on the button Edit
signals at the provider. A window opens.

3. Enter the required calibration factor and change the data type if nec-
essary.

4. Click on OK to save the data and close the window.

Box Description

Calibration
factor:

The required calibration factor can be entered here.

Type: Only signals of the same type can be connected.
The data type can be changed here.

9.5 Exporting the bus configuration

Description

The bus-specific configuration can be exported in the form of XML files.
This export makes it possible to check the configuration files if required.

Precondition

• The robot controller has been set as the active controller.
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Procedure

1. Select the menu sequence File > Import / Export. A window opens.
2. Select Export I/O configuration to .XML files and click on Next.
3. Specify a directory. Click on Next.
4. Click on Finish.
5. The configuration is exported to the specified directory. If the configu-

ration was successfully completed, this is indicated by a message.
Close the window.

KUKA.WorkVisual 5.0

130/230 | www.kuka.com KST WorkVisual 5.0 V7 | Issued: 12.07.2018

Fi
el

d 
bu

s 
co

nf
ig

ur
at

io
n



10 Long texts

10.1 Displaying / editing long texts

Precondition

• A robot controller has been added and set as active.

Procedure

1. Select the menu sequence Editors > Symbol Table Editor.
2. The long texts are sorted thematically. In the left-hand column, select

which long texts are to be displayed, e.g. Digital inputs.
3. In the other columns, select the language or languages that are to be

displayed.
4. Edit the long texts, if necessary.

Description

Fig. 10-1: Symbol Table Editor

The long texts of the digital inputs/outputs can also be edited in the I/O
Mapping window via the Edit signals at the provider button.

10.2 Importing long texts

Description

The following file formats can be imported:

• .TXT
• .CSV

Imported long texts overwrite existing long texts.

Precondition

• A robot controller has been added and set as active.

Procedure

1. Select the menu sequence File > Import / Export. A window opens.
2. Select Import Symbol Table and click on Next.
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3. Select the file to be imported and the language of the contained long
texts.

4. If a signal already has a name and the file to be imported does not
contain a name for this signal, the check box Delete existing entries
determines what happens to the existing name.

• Activated: The name is deleted.
• Not activated The name is retained.

Fig. 10-2: Importing long texts

5. Click on Finish.
6. If the import was successful, this is indicated by a message. Close the

window.

10.3 Exporting long texts

Description

Long texts can be exported in the following file formats:

• .TXT
• .CSV

Precondition

• A robot controller has been added and set as active.

Procedure

1. Select the menu sequence File > Import / Export. A window opens.
2. Select Export SymbolTable and click on Next.
3. Specify the path name and format of the file which is to be generated.

Also select the language. Click on Finish.
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Fig. 10-3: Exporting long texts

4. If the export was successful, this is indicated by a message in the win-
dow. Close the window.
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11 Configuring KUKA buses: controller bus, system bus,
extension bus

11.1 Overview

Description

The KUKA buses must be adapted in WorkVisual to the real bus configu-
ration in the following cases:

• A device has been replaced by a device of a different type, e.g. a
KPP0 by a KPP2.

• More than one device has been replaced by a device of a different
type.

• One or more devices have been removed.
• One or more devices have been added.

Information about exchanging devices and about the possible device
combinations is contained in the operating instructions or assembly in-
structions for the robot controller.

Procedure

1. Load the active project from the robot controller.

If settings have already been made in a project in WorkVisual which
are to be transferred subsequently to the robot controller together
with the bus configuration, then the active project must be transfer-
red to WorkVisual using a comparison.
(>>> 14.8 "Comparing projects (and accepting differences)"
Page 186)

2. Carry out the relevant configuration work.
3. Transfer the project to the robot controller and activate it there.

11.2 Configuring the KUKA bus (8.2)

11.2.1 Inserting devices on the KUKA bus (8.2)

Recommendation: Arrange the devices in the buses in the same order
as they are arranged in reality.
The arrangement has no effect on its functionality of the bus, but it is
easier to edit the connections on the Topology tab if the arrangement
already corresponds to reality.

Preparation

Only if devices are to be inserted into the Extension Bus and the node
KUKA Extension Bus (SYS-X44) is not yet present:

1. Right-click on the node Bus structure on the Hardware tab in the
Project structure window.

2. Select Add from the context menu. The DTM selection window is
opened.

3. Select the entry KUKA Extension Bus (SYS-X44) and confirm with
OK.
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Precondition

• The device description files are present.

‒ If devices are to be inserted into the Extension Bus, the files must
be imported beforehand.
(>>> 6.8 "Importing device description files" Page 35)

‒ The files for the controller bus and the system bus are present in
WorkVisual.

• The robot controller has been set as the active controller.

Procedure

1. Right-click on the KUKA bus in the Bus structure node on the Hard-
ware tab in the Project structure window.

2. Select Add from the context menu. The DTM selection window is
opened.

3. Select the device used and confirm with OK. The device is inserted in
the tree structure.

4. If required: Right-click on the device in the tree structure and select
Rename from the context menu. Rename the device.

In a bus, more than one device of the same type may be present.
To distinguish them in the bus structure, WorkVisual automatically
appends a number to the name. It is recommended, however, to
give the devices meaningful names, e.g. by including the abbrevia-
tion for the installation position of the devices.
The names that the devices have here in the bus structure are the
names used in error messages.

5. Repeat steps 1 and 4 for all devices used in the real bus.
6. Check the device settings and change if necessary.

(>>> 11.2.2 "Checking the device settings" Page 136)
7. Check the device connections and change if necessary.

(>>> 11.2.3 "Connecting devices on the KUKA bus" Page 136)
8. Only if the change in the controller bus affects a KPP, or if the control-

ler bus has been complete reconfigured: Insert the wagon driver con-
figuration.
(>>> 11.2.5 "Inserting the wagon driver configuration" Page 138)

Fig. 11-1: Example of a controller bus
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11.2.2 Checking the device settings

Procedure

1. Right-click on the device on the Hardware tab in the Project struc-
ture window.

2. Select Settings… from the context menu. The Settings… window
opens.

3. Select the General tab.
4. Check that the following settings have been made. If not, correct the

settings.

• Check vendor ID: Check box active
• Check product code: Check box active
• Check revision number: OFF

5. Close the window by clicking on OK.

11.2.3 Connecting devices on the KUKA bus

Description

If devices are inserted into the bus, WorkVisual connects the devices au-
tomatically. As WorkVisual does not know the real bus configuration, the
connections must be checked and changed where necessary.

Information about the connector pin allocation of the devices can be
found in the operating instructions for the robot controller.

Procedure

1. Right-click on the bus on the Hardware tab in the Project structure
window.

2. Select Settings… from the context menu. The Settings… window is
opened.

3. Select the Topology tab.
(>>> 11.2.4 "“Topology” tab" Page 137)

4. Select and delete invalid connections. To do this, either press the Del
key, or right-click and select Delete.

5. Insert missing connections. To do this, click on a connection and hold
down the mouse button. Drag the mouse pointer to another
connection and release the mouse button.

6. Mark temporary connections as such. To do this, right-click on the
connection and select Disconnectable from the context menu. The
connection is displayed as a broken line.
A temporary connection is e.g. with the controller bus, the connection
to the Electronic Mastering Device (EMD), because the EMD is not
permanently connected.

7. Click on devices for which the address or alias address is not yet cor-
rect. A window appears. Enter the correct address.
All temporarily connected devices require an alias address. For the
EMD, the alias address 2001 must be entered!

8. If required: Rearrange the devices using Drag&Drop. This serves to in-
crease the clarity of the Topology tab. It has no effect on the bus.

9. Click on OK at bottom right.
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11.2.4 “Topology” tab

Fig. 11-2: “Topology” tab – example of a controller bus

Properties of the “Topology” tab:

• Each device in the bus is represented by 1 rectangle.
• The numbers of the devices specify their physical address.
• To display the name of a device:

Move the mouse pointer onto the device. A tool tip is displayed with
the name of the device.
Or alternatively, select the device. The window on the right displays
the properties of this device, e.g. the name.
The devices in the figure:

Device Name

1001 Cabinet Interface Board (CIB)

1002 Resolver Digital Converter (RDC)

1003 KUKA Power Pack 2 Axes (KPP2)

1004 KUKA Servo Pack Wrist Axes (KSP)

1005 KUKA Servo Pack Main Axes (KSP)

1006 Electronic Mastering Device (EMD)

• To display the name of a connection:
Move the mouse pointer onto the connection. A tool tip is displayed
with the name of the connection.

• Lines shows the connections between the devices.
Solid lines indicate permanent connections. Broken lines indicate tem-
porary connections.

• The devices can be reordered using Drag&Drop. This serves to in-
crease the clarity of the Topology tab. It has no effect on the bus.
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• The window on the right displays the properties of the selected device,
e.g. the address and alias address. Some of the properties can be
changed.
All temporarily connected devices require an alias address. For the
EMD, the alias address 2001 must be entered!

• The message area below the graphic shows if a device has an invalid
address or alias address.

Editing connections:

• Select and delete invalid connections.
To do this, either press the Del key, or right-click and select Delete.

• Insert missing connections.
To do this, click on a connection and hold down the mouse button.
Drag the mouse pointer to another connection and release the mouse
button.

• Mark temporary connections as such.
To do this, right-click on the connection and select Disconnectable
from the context menu. A temporary connection is e.g. the connection
to the Electronic Mastering Device (EMD), because the EMD is not
permanently connected.

11.2.5 Inserting the wagon driver configuration

Description

The wagon driver configuration must be inserted into the WorkVisual
project in the following cases:

• If the controller bus has been completely reconfigured.
• Or if a change has been made to the controller bus which affects a

KPP.

For this, the following configuration files are required:

• CFCoreWaggonDriverConfig.xml
• EAWaggonDriverConfig.xml

These files are automatically installed together with WorkVisual. They are
located in the directory: C:\Program Files (x86)\KUKA\WorkVisual[…]\Wag-
gonDriverConfigurations. They can be found there in the subdirectory for
the relevant controller bus variant.
Which wagon driver configuration should be used for which control-
ler bus?

Controller bus with … Directory

KPP without external axis KPP 600-20
KPP with 1 external axis KPP 600-20-1x40 (1x64)
KPP with 2 external axes KPP 600-20-2x40
KPP with 1 external axis and ServoGun FC
Sensor Box

KPP 600-20-1x40 +
SDC

KPP with 2 external axes and ServoGun
FC Sensor Box

KPP 600-20-2x40 +
SDC

4-axis palletizer with external axis 4Ax_PA_mit_ZA
4-axis palletizer without external axis 4Ax_PA_ohne_ZA
5-axis palletizer with external axis 5Ax_PA_mit_ZA
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Controller bus with … Directory

5-axis palletizer without external axis 5Ax_PA_ohne_ZA
AGILUS sixx 6Ax_CIBsr_KPPsr_KSP

sr

Precondition

• The robot controller has been set as the active controller.

Procedure

1. Expand the node of the robot controller on the Files tab in the Project
structure window.

2. Then open the subordinate nodes: Config > User > Common > Ma-
da.

3. Only if there are already wagon driver files in the Mada directory and
these need to be removed:

• Right-click on a file and select Delete from the context menu.
• Repeat for the second file.

4. Right-click on the Mada folder and select Add external file from the
context menu.

5. A window opens. In the File type box, select the entry All files (*.*).
6. Navigate to the directory in which the files for the wagon driver config-

uration are located, select the files and confirm with Open.
The files are now displayed in the tree structure below the Mada fold-
er. (If not: collapse and expand all the folders in order to refresh the
display.)

11.3 Configuring the KUKA bus (8.3 or higher)

Controller bus

Using the Configuration proposal functionality, the controller bus can be
set up or updated automatically in WorkVisual. Insertion of individual devi-
ces, connection of devices, insertion of wagon driver files, etc., is no lon-
ger necessary.
(>>> 6.19 "Inserting hardware components" Page 45)
The controller bus can still be edited manually if required. The procedure
is the same as for the controller version 8.2.
(>>> 11.2.1 "Inserting devices on the KUKA bus (8.2)" Page 134)

System bus
Extension bus

The procedure is the same as for the controller version 8.2.
(>>> 11.2.1 "Inserting devices on the KUKA bus (8.2)" Page 134)

11.4 Assigning FSoE slave addresses

This functionality is only available for robot controllers with version 8.3.

This description is valid for the controller variant (V)KR C4. For KR C4
compact, please contact KUKA.
(>>> 16 "KUKA Service" Page 219)
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Description

The robot controller is supplied with preconfigured FSoE addresses. The
user needs to assign the addresses via WorkVisual only in the following
cases:

• More than 1 RDC is connected.
On delivery, RDCs are preconfigured with the FSoE address “2”. An
address must not be used more than once on a robot controller.

• Several devices of the same type have been replaced at the same
time.

The assignment of addresses to devices is predefined.
(>>> 11.4.1 "FSoE addresses" Page 142)

Preparation

• Determine the KUKA serial number of the real device.

‒ With KSPs and KPPs, the serial number is given on the rating
plate.
There may be several serial numbers on the Lenze modules. The
KUKA number is the relevant one.
(>>> 11.4.2 "Determining the serial number for the Lenze KSP/
KPP" Page 143)

‒ RDCs have a label with a barcode on the board. The serial num-
ber is specified in encrypted form.
(>>> 11.4.3 "Determining the serial number of the RDC"
Page 143)

• Determine the IP address of the interface via which the WorkVisual
PC is connected to the robot controller:

1. On the robot controller, select Diagnosis > Diagnostic monitor
from the main menu.

2. Select the interface in the Module box: Network interface (Serv-
ice) (for KSI) or Network interface (KLI).
The relevant data for the interface, including the IP address, are
now displayed.

Precondition

WorkVisual:

• The IP address of the WorkVisual PC is in the same subnet as the IP
address of the interface to which it is connected (KSI or KLI).

If DHCP is used, a suitable IP address is assigned automatically.
If a fixed IP address is used in conjunction with a connection via
the KLI, the address depends on the setting of the interface that is
configured as a Windows interface in the KLI. (Default: “virtual5”
with the IP address 172.31.1.147 and the subnet mask 255.255.0.0)
If a fixed IP address is used in conjunction with a connection via
the KSI, the range of suitable IP addresses depends on the settings
of the non-real-time communication. (Default: IP address 172.17.x.x
with subnet mask 255.255.0.0)

• Network connection to the real robot controller
• The configuration in WorkVisual is identical to the real bus architec-

ture.
This can be achieved most reliably by loading the active project of the
real robot controller in WorkVisual.
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• The robot controller has been set as the active controller.
• The affected devices support address assignment by software.

This is defined in the device description file. In certain cases, this fea-
ture may be present in the latest device description file, although the
device was inserted into the bus structure in WorkVisual with an older
version of the file. The new file must then be imported in WorkVisual
and the device must be removed from the bus structure and then rein-
serted.

Real robot controller:

• User group Expert or higher
• Operating mode T1
• The safety controller does not give a drives enable signal.

‒ This status can be brought about in the following way: trigger an
EMERGENCY STOP.

‒ This status can be checked as follows: In the status bar, click on
the Drives status indicator. The Motion conditions window opens.
The box Drives enabled from Safety must be gray. It must not
be green.

Information about the status bar can be found in the operating
and programming instructions for the system software.

Procedure

1. Double-click on the KUKA Controller Bus (KCB) node on the Hard-
ware tab in the Project structure window. The Settings … window
opens.

2. Enter the IP address (KSI or KLI) determined during the preparation
stage. Click on OK to save the entries and close the window.

3. Right-click on the KUKA Controller Bus (KCB) node and select Con-
nect from the context menu.
The node is now displayed in green italics.

4. Right-click on the relevant device under the KUKA Controller Bus
(KCB) node and select Connect from the context menu.
The device description is now displayed in green italics.

5. Right-click again on the device and select Functions > Assign FSoE
slave address... from the context menu. The FSoE slave address
assignment window opens and the currently set FSoE address is dis-
played.

6. Enter the serial number and the new FSoE address. Leading zeros
may be omitted.
WorkVisual recognizes whether the serial number is correct: If it is not,
a red exclamation mark is displayed to the left of the box. This is also
the case during entry, while the number is still incomplete and thus in-
correct.
The red exclamation point disappears as soon as the number is com-
plete and correct.

7. If the serial number is correct, click on Accept. Then click on OK. The
window closes.

8. Right-click again on the device and select Disconnect from the con-
text menu.
The data are now saved on the real device. The real controller bus
cannot yet access the device, however.

9. Right-click on the KUKA Controller Bus (KCB) node and select Dis-
connect from the context menu.
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10. Reconfigure the I/O drivers on the real robot controller.
Once the reconfiguration is complete, the controller bus once again
has access to its devices and to the current addresses.

11.4.1 FSoE addresses

KSP and KPP

Controller variant with 1 row of drive modules

KSP, left

Address: 1022

KSP, middle

Address: 1021

KPP, right

Address: 1020

Controller variant with 2 rows of drive modules

KSP, top left

Address: 1032

KSP, top center

Address: 1031

KPP, top right

Address: 1030
KSP, bottom left

Address: 1022

KSP, bottom center

Address: 1021

KPP, bottom right

Address: 1020

RDC

The following tables display common topologies and how the FSoE ad-
dresses must be assigned to them.

• RDC-Rob = RDC of a KUKA robot (except KR 1000 titan)
• RDC-Titan = RDC of a KR 1000 titan
• RDC-ExAx = RDC for external axes or CKs

The KR 1000 titan has 2 RDCs. These must always have the FSoE ad-
dresses “2” and “3”.

X21, cascaded X21 X21.1, cascaded X21.1

RDC-Rob

Address: 2

--- --- ---

RDC-ExAx

Address: 3

---

RDC-ExAx

Address: 3

RDC-ExAx

Address: 4

X21, cascaded X21 X21.1, cascaded X21.1

RDC-Titan

Address: 2

RDC-Titan

Address: 3

--- ---

RDC-ExAx

Address: 4

---

RDC-ExAx

Address: 4

RDC-ExAx

Address: 5

X21, cascaded X21 X21.1, cascaded X21.1

RDC-ExAx

Address: 2

RDC-Rob

Address: 3

--- ---

RDC-ExAx

Address: 4

---

RDC-ExAx

Address: 4

RDC-ExAx

Address: 5
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Additional components

It is possible to assign FSoE addresses to the following components. In
practice, however, it is not necessary, as they only occur once per robot
controller.

Component Address

smartPAD 13330
SIB 13331
Extended SIB 13332
CIB 1

The addresses for smartPAD, SIB, Extended SIB and CIB must never
be assigned to other components.

11.4.2 Determining the serial number for the Lenze KSP/KPP

Fig. 11-3: Example: Labels on the Lenze KSP/KPP

Item Description

1 KUKA Ser.-Nr.: This is the relevant number.

2 Ser.-Nr.: This number is not relevant.

11.4.3 Determining the serial number of the RDC

Description

RDCs have a label with a barcode on the board. The serial number is
specified in encrypted form. There are 2 types of barcode. The length of
the serial number depends on the type.
If the RDC is located in the RDC box, the box must be opened in order to
read the label.

Information about the RDC and opening the RDC box can be found in
the operating instructions for the robot controller.
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Label on the RDC

Fig. 11-4: Example: open box with RDC

Item Description

1 The relevant label is located in the center of the board.

2 The labels on the EDS memory strip are not relevant.

Encrypted serial number

Fig. 11-5: Example: label on an RDC

Item Description

1 The two leftmost digits specify the type. Possible values are:

• Type 20 (in the example)
• Type 26

2 The two rightmost digits specify the check digit. The check digit
itself is not relevant.

3 To the left of the check digit is the serial number. The number
of figures it comprises is dependent on the type:

• With type 20: 6 digits (in the example: 012406)
• With type 26: 7 digits
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12 RoboTeam

RoboTeams can be configured offline with WorkVisual. The procedure
and all other information about RoboTeams can be found in the
KUKA.RoboTeam documentation.

The “RoboTeam” functionality is not available for projects with VKR C4
robot controllers.
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13 Programming

13.1 Creating a program

Precondition

• With use of a KR C4 controller: the KRL Templates catalog has been
inserted in the Catalogs window.

• With use of a VKR C4 controller: the VW Templates catalog has been
inserted in the Catalogs window.

Procedure

1. Expand the tree structure of the robot controller on the Files tab in the
Project structure window.

2. Select the required template in the KRL Templates or VW Templates
catalog and drag it onto a node in the tree structure. The program file
is inserted in the tree structure.
The file can now be edited with the KRL Editor.

13.2 Importing a program

Description

Files in the formats SRC, DAT, SUB and KRL can be imported.

Procedure

1. Expand the tree structure of the robot controller on the Files tab in the
Project structure window.

2. Right-click on the node in which the program is to be created and se-
lect Add external file from the context menu.

3. Navigate to the directory where the file is located that is to be impor-
ted.

4. Select the file and confirm with Open. The file is inserted in the tree
structure.
The file can now be edited with the KRL Editor.

13.3 Searching and replacing within files

Description

WorkVisual provides a search function which allows the text of all files in
the entire project to be searched. It is also possible to search an individu-
al file or a selected area within a file. The range of the search can be se-
lected in the search window.
Instead of searching, it is also possible to search and replace.
The search (or search and replace) function can be called from any place
in the project, whatever workspace or editor is currently in focus.

Procedure

1. If an individual file is to be searched, this should be opened.
2. If an area within the file is to be searched, this should be selected.
3. Open the Search window: Ctrl+F

Or: Open the window for Search and Replace: Ctrl+H
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4. Make the desired settings and click on Search, or on Replace or Re-
place all.

13.4 KRL Editor

13.4.1 Opening a file in the KRL Editor

Precondition

• This is a file format that can be edited with the KRL Editor.
(>>>  "File formats" Page 147)

Procedure

1. Double-click on a file on the Files tab in the Project structure win-
dow.
Or: Select the file and click on the KRL Editor button.
Or: Select the file and select the menu sequence Editors > KRL Edi-
tor.

2. To close the file: Click on the “X” at top right.

The KRL Editor allows more than one file to be open simultaneously. If re-
quired, they can be displayed side by side or one above the other. This
provides a convenient way of comparing contents, for example.
To display the files side by side:

1. Right-click in the title bar of the file in the KRL Editor. Select New Ver-
tical Tab Group from the context menu.

2. To display the files one behind the other again: Right-click in the title
bar of a file in the KRL Editor. Select Move Next or Move Previous
from the context menu.

To display the files one above the other:

1. Right-click in the title bar of the file in the KRL Editor. Select New
Horizontal Tab Group from the context menu.

2. To display the files one behind the other again: Right-click in the title
bar of a file in the KRL Editor. Select Move Next or Move Previous
from the context menu.

File formats

The KRL Editor is used primarily to edit files containing KRL code:

• SRC
• DAT
• SUB

In addition, the KRL Editor can be used to edit the following file formats:

• ADD
• BAT
• CONFIG
• CMD
• DEL
• INI
• KFD
• KXR
• LOG
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• REG
• TXT
• XML

13.4.2 KRL Editor user interface

Fig. 13-1: KRL Editor user interface

Item Description

1 Program area

The code is entered and edited here. The KRL Editor provides
numerous functions to support the programmer with this.

2 List of the subprograms in this file

To access a subprogram, select it from the list: the cursor then
jumps to the DEF line of this subprogram.

If the file does not contain any subprograms, the list is empty.

3 List of variable declarations

This list always refers to the subprogram that is currently selec-
ted in the list of subprograms. To go to a declaration, select
the variable from the list: the cursor then jumps to the line con-
taining the declaration of this variable.

If there are no variable declarations, the list is empty.

4 Analysis bar

The marks indicate errors or discrepancies in the code.

• Hovering with the mouse over a mark displays a tool tip
with a description of the error.

• Clicking on the mark makes the cursor jump to the relevant
place in the program. An automatic correction is offered for
some errors/discrepancies.
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Item Description
(>>> 13.4.9 "Quickfix correction" Page 157)

5 The square has the color of the most serious error currently
present.

If there are no errors/discrepancies, the square is green.

13.4.3 Zooming in/out

Procedure

1. Click anywhere in the KRL Editor.
2. Hold down the CTRL key and move the mouse wheel.

• Mouse wheel up: zoom in
• Mouse wheel down: zoom out

13.4.4 Configuring KRL Editor

Preparation

Only necessary if it is desirable to see a preview of the effect of the set-
tings:

1. Open a file in the KRL Editor.
2. To see a preview of the colors for the marks: select any point in the

file.
(Nothing can be selected in the file while the Options window is
open.)

Procedure

1. Select the menu sequence Extras > Options.... The Options window
is opened.

2. On the left of the window, open the Text editor folder. In the folder,
select a subitem.
The corresponding settings are now displayed on the right of the win-
dow.

If the mouse pointer is moved over a field, a description is dis-
played for this field at the bottom of the window.

3. Make the desired changes.
The changes can be seen immediately if a file is currently open in the
KRL Editor (e.g. if spaces are shown or hidden).

4. Confirm with OK. The changes are saved.
Or discard the changes with Cancel.

The color settings can be reset to the default settings at any time. The
Reset button for this is situated on the corresponding page in the
Options window. (At the bottom of the page; scrolling is required.)
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13.4.5 Edit functions

13.4.5.1 General edit functions

Select

• To select an area: click where the selection should begin and hold
down the left mouse button. Drag the mouse until the desired area is
selected, and then release the mouse button.

If the ALT key is additionally held down during selection, it is possi-
ble to select a rectangular area.

• To select a line: click on the line number.

Edit

Standard edit functions can be called via the context menu. These in-
clude:

• Cut, Paste, Copy, Delete
• Undo, Redo
• Find … (>>> 13.3 "Searching and replacing within files" Page 146)

In addition, the following commands are available in the context menu.

• Not all commands are available for every file format.
• Commands which refer to a selected area affect the whole file if no

area is selected.

Menu item Description

Edit > Make upper case Converts all the lower-case letters in the selected string
into upper-case letters.

Edit > Make lower case Converts all the upper-case letters in the selected string
into lower-case letters.

Edit > Title case Converts all the initial letters in the selected string into
upper-case letters.

Edit > Convert tabs into
spaces

Replaces the tabs in the selected string with spaces.

Note: The number of spaces corresponding to one tab
can be configured in the parameter Indent size.

Edit > Convert spaces into
tabs

Replaces the spaces in the selected string with tabs.

Edit > Indent Inserts additional spaces at the beginning of every line in
the selected area.

Note: The number of spaces inserted can be configured
in the parameter Indent size.

Edit > Remove leading white-
space

Removes all the leading spaces from the lines in the se-
lected area.

Insert snippet (>>> 13.4.5.2 "Snippets – Fast entry of KRL instructions"
Page 151)

Folds > Expand all Opens all folds in the currently displayed file.

(>>> 13.4.6 "Folds" Page 156)

Folds > Collapse all Closes all folds in the currently displayed file.

(>>> 13.4.6 "Folds" Page 156)
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Menu item Description

Format document Indentations, line breaks, etc. are adapted throughout the
file to conform to the standard. The applicable standard
depends on the file format.

Comment selection Inserts a semicolon at the beginning of the selected line.
The selected row is thus turned into a comment.

Uncomment selection Removes the semicolon from the beginning of the selec-
ted line. The selected row is thus turned into code.

Go to declaration (>>> 13.4.7 "Jumping to the declaration of a variable"
Page 157)

Find usages (>>> 13.4.8 "Displaying all uses of a variable" Page 157)

Refactoring > Rename (>>> 13.4.5.3 "Renaming a variable" Page 152)

Refactoring > Offset points (>>> 13.4.5.4 "Offsetting points" Page 152)

Refactoring > Adapt external
axes

(>>> 13.4.5.5 "Modifying values of external axes"
Page 153)

Refactoring > Modify the tool/
base used

(>>> 13.4.5.6 "Modifying TOOL and BASE coordinate
systems" Page 155)

13.4.5.2 Snippets – Fast entry of KRL instructions

Description

A fast entry function is available in the KRL Editor for common KRL in-
structions.
To program a FOR loop, for example, it is not necessary to enter the en-
tire syntax FOR … = … TO … STEP …. Instead, the instruction can be
selected from the “Auto-complete” list. All that is then required is to fill out
the variable positions in the syntax manually.

Procedure

On starting to type the code, the “Auto-complete” list is shown. The re-
quired instruction is generally already selected.

1. Accept the selected instruction from the “Auto-complete” list using the
TAB key. Or double-click on a different instruction.

The TAB key is configured as standard for accepting an instruction.
Alternatively, the Enter key can be configured: (>>> 13.4.4 "Config-
uring KRL Editor" Page 149).

2. The KRL syntax is inserted automatically. The first variable position is
highlighted in blue. Enter the desired value.

Fig. 13-2: The first variable position is highlighted in blue

3. Press the TAB key to jump to the next variable position. Enter the de-
sired value.

4. Repeat step 3 for all other variable positions.
5. To finish editing, press the Enter key.

The snippet list can also be called separately: Right-click and select
Insert snippet from the context menu.
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It is also possible to enter a snippet as follows: Type in the abbreviation
and press the TAB key.
(The abbreviation can be determined by calling the snippet list. Select the
instruction. A tool tip is displayed. The 2nd line contains the possible ab-
breviations.)

13.4.5.3 Renaming a variable

Description

A variable name can be changed in a single action at all points where it
occurs.
This is also possible if the variable is declared in a DAT file and used in
various SRC files.

Precondition

• The files in which the variable name occurs do not contain any syntax
errors.
Automatic renaming cannot be executed in a file containing syntax er-
rors.

Procedure

1. Select the desired variable at any point.
2. Right-click and select Refactoring > Rename from the context menu.
3. A window opens. Change the name and confirm with OK.

13.4.5.4 Offsetting points

Precondition

• File is opened in the KRL editor.

Procedure

1. Select the desired motion instructions in the program or select all.
2. Right-click and select Refactoring > Offset points from the context

menu. A window opens.
3. Select the coordinate system in which the points are to be offset.
4. Enter the values for the offset.
5. If required, deactivate the check box next to Open all involved files

in an editor..
6. Confirm with OK.
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Fig. 13-3: Offset selected position data window

Item Description

1 Coordinate system in which the points are to be offset

• Cartesian offset - in the tool coordinate system
The offset is carried out in the coordinate system of the
tool assigned to the motion instruction.

• Cartesian offset - in base coordinate system
The offset is carried out in the coordinate system of the
base assigned to the motion instruction.

• Cartesian offset - in the world coordinate system
The transformation is relative to the WORLD coordinate
system.

2 Values by which the points are to be offset

3 The program lines are displayed here. The changes resulting
from the offset are marked. If the check box for a line is deac-
tivated, no change will be made in this line. Information is indi-
cated by means of icons; hovering over an icon with the
mouse displays the information text.

4 Hovering with the mouse on this icon displays a summary of all
the information.

5 • Check box active: All programs affected by this change
are opened. To apply the changes, each individual program
must be saved. This makes it possible to reject the
changes for individual programs.

• Check box not active: The changes are made in all pro-
grams affected by this change.

13.4.5.5 Modifying values of external axes

Precondition

• File is opened in the KRL editor.
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Procedure

1. Select the desired motion instructions in the program or select all.
2. Right-click and select Refactoring > Adapt external axes from the

context menu. A window opens.
3. Select or enter the transformation.
4. If required, deactivate the check box next to Open all involved files

in an editor..
5. Confirm with OK.

Fig. 13-4: Adapt external axes window

Item Description

1 Different types of transformation changes can be selected here.
Alternatively, these or other transformation changes can also
be entered directly in the box.

2 The program lines are displayed here with the changes
marked. If the check box for a line is deactivated, no change
will be made in this line. Information is indicated by means of
icons; hovering over an icon with the mouse displays the infor-
mation text.

3 If information is available, an icon is displayed here. Hovering
with the mouse on this icon displays a summary of all the infor-
mation.

4 • Check box active: All programs affected by this change
are opened. To apply the changes, each individual program
must be saved. This makes it possible to reject the
changes for individual programs.

• Check box not active: The changes are made in all pro-
grams affected by this change.
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13.4.5.6 Modifying TOOL and BASE coordinate systems

Precondition

• File is opened in the KRL editor.

Procedure

1. Select the desired motion instructions in the program or select all.
2. Right-click and select Refactoring > Modify the tool/base used from

the context menu. A window opens.
3. Select the desired TOOL and/or BASE coordinate system.
4. If required, activate the check box next to Retain programmed robot

position.
5. If required, deactivate the check box next to Open all involved files

in an editor..
6. Confirm with OK.

Fig. 13-5: Offset selected position data window

Item Description

1 TOOL and BASE coordinate system to be used

2 • Check box active: The robot position programmed in the
motion instructions is retained.

• Check box not active: The robot position programmed in
the motion instructions is modified in accordance with the
selected coordinate systems.

3 The program lines are displayed here with the changes
marked. If the check box for a line is deactivated, no change
will be made in this line. Information is indicated by means of
icons; hovering over an icon with the mouse displays the infor-
mation text.

4 • Check box active: All programs affected by this change
are opened. To apply the changes, each individual program
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Item Description
must be saved. This makes it possible to reject the
changes for individual programs.

• Check box not active: The changes are made in all pro-
grams affected by this change.

5 If information is available, an icon is displayed here. Hovering
with the mouse on this icon displays a summary of all the infor-
mation.

13.4.5.7 Auto-complete

An auto-complete function is available in the KRL Editor.
When entering code, a list containing the following elements is displayed
automatically:

• KRL keywords
• Known variable names
• Known function names
• Known user-specific data types (STRUC or ENUM)
• Snippets (>>> 13.4.5.2 "Snippets – Fast entry of KRL instructions"

Page 151)

Those elements that are compatible with the characters already entered
are shown at the top of the list. These elements are also prioritized ac-
cording to their frequency of use, i.e. the selection is dynamically adapted
to the user’s actions.
If required, an element in the list can be selected and inserted in the pro-
gram text using the TAB key. This makes it unnecessary to type complex
variable names, for example.

Navigation in the “Auto-complete” list:
• Scrolling
• Or: Type the first letter of the desired element. The marker jumps to

the relevant position.

13.4.6 Folds

Description

The content of the KRL Editor can be structured with folds just like any
normal KRL program.

Fig. 13-6: Closed fold
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Fig. 13-7: Opened fold

Procedure

To open a fold:

• Double-click on the box of the closed fold.
• or: Click on the plus sign.

To close a fold:

• Click on the minus sign.

To open or close all folds:

• Context menu: Folds > Expand all or Collapse all

13.4.7 Jumping to the declaration of a variable

Procedure

1. Place the cursor in the variable name, or directly in front of the first
letter or directly after the last letter.

2. Right-click and select Go to declaration from the context menu.

13.4.8 Displaying all uses of a variable

Precondition

• File is opened in the KRL editor.

Procedure

1. Place the cursor in the variable name, or directly in front of the first
letter or directly after the last letter.

2. Right-click and select Find usages from the context menu.
The Find usages window opens. A tab with the name of the variable
is displayed in this window. All uses are listed there in detail (file with
path, line number, etc.)

3. If required: Double-click on a line in the list. The corresponding posi-
tion in the program is highlighted.
Rename, for example, is now possible.

13.4.9 Quickfix correction

Red text in the code and marks in the analysis bar indicate errors or dis-
crepancies in the code.
For some of these errors/discrepancies, an automatic correction function –
the “Quickfix” – is offered. A Quickfix light bulb is displayed. Using the ar-
row button next to the light bulb, the user can display various possible sol-
utions and select one.
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Fig. 13-8: Quickfix light bulb

13.4.9.1 Correcting or automatically declaring undeclared variables

Description

Undeclared variables are displayed as follows:

• With red text in the code
• With a red mark in the analysis bar

The red color can also refer to a different error, however. If it refers to an
undeclared variable, the following tool tip is displayed if you hover with the
mouse over the wavy line or mark: The declaration of variable [name] was
not found.

Procedure

1. Place the cursor in the red name, or directly in front of the first letter
or directly after the last letter.
Or: Click on the mark in the analysis bar.
The Quickfix light bulb is now displayed next to the variable name.

2. Check if the variable name has been written incorrectly (differently
from in the declaration).

• If so: correct it. The red text/mark disappears. No further steps are
necessary.

• If not: continue with the next step.
3. Move the mouse pointer onto the Quickfix light bulb. An arrow is dis-

played next to the light bulb.
Click on the arrow. The following options are displayed:

• Declare the variable locally
• Create signal '[Name]'
• Declare the variable in the data list
• Create signal '[Name]' in data list
• Suppress with comment
• Suppress message for whole file

4. Click on the desired option.
5. Only with Declare the variable in the data list: The data list is opened.
6. A snippet for the variable declaration has been automatically inserted.

The expected data type is highlighted in blue.

• Accept or change the data type, as required.
• If required, add a comment.

This comment is displayed in the tool tip of the “Auto-complete” list
if the variable is selected there.

13.4.9.2 Removing unused variables

Description

Unused variables are displayed as follows:

• With gray text in the code
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• With a blue mark in the analysis bar

Hovering with the mouse over the gray text or the mark displays a tool tip
with a description.

Procedure

1. Place the cursor in the grayed-out name, or directly in front of the first
letter or directly after the last letter.
Or: Click on the mark in the analysis bar.
The Quickfix light bulb is now displayed next to the variable name.

2. Move the mouse pointer onto the Quickfix light bulb. An arrow is dis-
played next to the light bulb.
Click on the arrow. The following options are displayed:

• Remove declaration of '[Name]'
• Turn declaration of '[Name]' into a comment
• Suppress with comment
• Suppress message for whole file

3. Click on the desired option.

13.4.9.3 Standardizing the upper/lower case in a variable name

Description

If the use of upper/lower case in a variable name is not uniform in the
declaration and in its other occurrences, this is displayed as follows:

• With a green wavy line in the code
• With a green mark in the analysis bar

Hovering with the mouse over the wavy line or mark displays a tool tip
with a description.

Procedure

1. Place the cursor in the name underlined with the wavy line, or directly
in front of the first letter or directly after the last letter.
Or: Click on the mark in the analysis bar.
The Quickfix light bulb is now displayed next to the variable name.

2. Move the mouse pointer onto the Quickfix light bulb. An arrow is dis-
played next to the light bulb.
Click on the arrow. The following options are displayed:

• Change this use to [name as in declaration]
• Change declaration to [name as at this point in the program]
• Change all occurrences to [name as in declaration]
• Change all occurrences to [name as at this point in the program]
• Suppress with comment
• Suppress message for whole file

3. Click on the desired option.
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13.4.10 Creating user-specific snippets

Description

Users can create their own snippets. For this, the required properties must
be saved in a file with the SNIPPET format. This file must then be impor-
ted in WorkVisual. The snippet is then available in the KRL Editor.
A template for a SNIPPET file is provided on the WorkVisual CD in the
DOC directory.

A snippet that has been imported into WorkVisual is also available in
OptionPackageEditor and vice versa. A precondition for this is that
WorkVisual and OptionPackageEditor are running on the same PC and
the same user is logged on.

Procedure

Once the SNIPPET file has been created, it must be imported as follows:

1. Select the menu sequence Extras > Import snippet from file …. A
window opens.

2. Navigate to the directory where the SNIPPET file is located and select
it. Click on Open.
The snippet is now available in the KRL Editor.

Example 1

A snippet is to be created to insert the following code structure:

Fig. 13-9: Code to be inserted by the snippet

The snippet is to have the name “User” in the snippet list, and the tool tip
should contain the information shown here:

Fig. 13-10: Desired snippet

The SNIPPET file must have the following format:
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Fig. 13-11: Structure of the SNIPPET file

Line Description

3 … 48 Section for 1 snippet

A SNIPPET file may contain a number of these sections, i.e. a number of differ-
ent snippets.

7 Title displayed in the tool tip

10 Name displayed in the snippet list

Note: The “Auto-complete” function reacts to this character string, i.e. if this
string is entered in the program, the “Auto-complete” list is shown and the corre-
sponding snippet is selected.

13 … 15 Shortcuts for this snippet

18 The snippet is only displayed in the list in files with this extension

21 Description displayed in the tool tip

24 Name of the author displayed in the tool tip

27 … 30 This defines the ways in which the snippet can be inserted.

• Expansion: The snippet is inserted at the current cursor position.

KUKA.WorkVisual 5.0

KST WorkVisual 5.0 V7 | Issued: 12.07.2018 www.kuka.com | 161/230

P
ro

gr
am

m
in

g



Line Description

• SurroundsWith: Before the snippet is inserted, program lines can be selec-
ted in the KRL Editor. The snippet is then automatically inserted so that it
surrounds these lines. The exact position of these lines within the snippet is
defined by the placeholder $selection$.

37 Placeholder occurring in lines 43 … 45, to which lines 38 and 39 refer

38 Tool tip displayed for this placeholder

39 Default value for the placeholder

43 … 45 Program text inserted by the snippet

The text consists of hard text and/or placeholders.

• $selection$: See description for SurroundsWith.
• $end$: This placeholder defines the position of the cursor after insertion of

the snippet has been completed with the Enter key.

Example 2

An example of the <Snippet> section only:

Fig. 13-12: Code inserted by the snippet

Fig. 13-13: Structure of the SNIPPET file

13.5 Working online with the KRC Explorer

This functionality is only available for robot controllers with KUKA Sys-
tem Software version 8.3.15 or higher or with VW System Software ver-
sion 8.3.11 or higher.
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With the KRC Explorer, changes can be made directly on the file system
of the robot controller without a project having to be transferred for this
purpose.
For the editing procedure, WorkVisual creates a local copy of the file sys-
tem; this is where the changes are carried out. The changes can be
synchronized with the robot controller at any time; this includes individual
changes.
The file system of the robot controller is referred to below as the working
directory.

13.5.1 Opening the working directory in the KRC Explorer

Precondition

• Network connection to the real robot controller
• The real robot controller and the KUKA smartHMI are running.
• Programming and diagnosis workspace

Procedure

1. Click on the Create connection button.
Alternatively: Right-click in the empty space in the KRC Explorer and
select Create connection from the context menu.
A window for selecting the robot controller is opened. In this window, it
is possible to filter by type and version of the controller. There is also
a search function available, which allows a search for the name of the
controller to be carried out.

2. Select the desired robot controller and confirm with OK. The working
directory of the robot controller is loaded and displayed in the KRC
Explorer.
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13.5.2 KRC Explorer user interface

Fig. 13-14: KRC Explorer user interface

Item Description

1 Working directory of the robot controller

2 The icon indicates the current status of the folder or file. Hov-
ering with the mouse over the icon displays a tool tip with a
description of the status. Additional information is displayed for
certain statuses. If a file has been moved, for example, the
original path is displayed in the tool tip.

(>>> 13.5.2.2 "Icons in KRC Explorer" Page 165)

3 Button bar

(>>> 13.5.2.1 "Button bar in KRC Explorer" Page 164)

4 The search box can be used to search for file and folder
names.

13.5.2.1 Button bar in KRC Explorer

Button Description

Shows or hides deleted files and folders.

Monitors changes on the file system of the robot controller.
This icon is displayed after the name of modified files.

Module view

Shows SRC and DAT files combined as a module, like on
the robot controller.
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Button Description

Shows all subprograms of a module in the working directory.
Double-clicking on a subprogram shows the point in the edi-
tor at which the subprogram was defined.

Expands the selected node and all subnodes.

Collapses the selected node and all subnodes.

13.5.2.2 Icons in KRC Explorer

Icon Description

The file has been changed.

Module containing an SRC file and/or a DAT file.

Subprogram in an SRC file

The file or folder is unchanged.

The file or folder has been renamed.

The file has been renamed and changed.

The file or folder has been moved.

This icon is also displayed if the file was renamed before or
after being moved.

The file or folder has been deleted.

A file that has been deleted can no longer be changed.

The file or folder has been added to the working directory.

This icon is also displayed if the file was changed, renamed
or moved after being added.

The file has been changed.

The file has been moved and changed.

Icons in the module view:

Icon Description

The module has been changed and moved.

The module has been changed and renamed.

The SRC or DAT file has been changed and the other one
has been deleted.

The SRC or DAT file has been changed and the other one
remains unchanged.

The SRC or DAT file has been deleted and the other one re-
mains unchanged.

The SRC or DAT file has been moved and the other one re-
mains unchanged.

The SRC or DAT file has been renamed and the other one
remains unchanged.
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Icon Description

The SRC or DAT file has been changed and the other one
has been renamed and changed.

The SRC or DAT file has been changed and renamed and
the other one remains unchanged.

Icons in the debugging mode:

Icon Description

The program is linked.

The program is not selected.

The program has been selected and terminated.

The program has been selected and is being executed.

The program has been selected and stopped.

The program has been selected and reset.

13.5.3 Configuring KRC Explorer

Procedure

1. Select the menu sequence Extras > Options.... The Options window
is opened.

2. On the left of the window, in the Online workspace folder, select the
subitem KRC Explorer.
The corresponding settings are now displayed on the right of the win-
dow.

3. Select the directory in which working directories are to be saved by
default.

4. Click on OK to confirm. The settings are saved.

13.5.4 General edit functions

Standard edit functions can be called via the context menu. These in-
clude:

• Cut, Copy, Paste, Rename, Delete

In addition, the following commands are available in the context menu.

Menu item Description

Editor Opens the file in the KRL Editor.

Open with... Opens the file in the selected program.

Start debugging Starts the debugging mode.

Stop debugging Ends the debugging mode.

Open in Windows Ex-
plorer

Opens the selected directory or the directory
of the selected file in Windows Explorer.

Add... Creates a file in the format of the selected
template under the selected folder.
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Menu item Description
(>>> 13.5.5 "Creating a new file with tem-
plate" Page 167)

Save as template Saves the selected file as a template.

Disconnect Terminates the connection to the robot con-
troller. The working directory is deleted.

New folder... Creates a new folder under the selected
folder.

Compare with control-
ler version

Compares the selected file with the file on
the robot controller.

Merge with controller
version

Accepts the data from the file on the robot
controller.

Compare with... (>>> 13.5.9 "Comparing files" Page 169)

Merge with... (>>> 13.5.10 "Copying data from a file to the
working directory" Page 170)

13.5.5 Creating a new file with template

Procedure

1. In the working directory, right-click on the folder in which the file is to
be created.

2. Select Add... from the context menu. The Select template window
opens.

3. Select the desired template.
The KUKA templates, templates from installed option packages and
the templates of the current robot controller are available for choice as
the template.

4. Enter a name in the Name box and confirm with OK.

13.5.6 Transferring changes to the robot controller

Description

This procedure is used to transfer all changes or only selected changes in
the working directory from WorkVisual to the real robot controller.

Precondition

• Network connection to the real robot controller
• The real robot controller and the KUKA smartHMI are running.
• User group “Expert”
• T1 or T2 mode
• Programming and diagnosis workspace

Procedure

1. To transfer all changes: Select the root node of the working directory.
To transfer selected changes: Select the file or folder that is to be
transferred.

2. Click on the Transfer changes to the controller. button.
Alternatively: Right-click and select Transfer changes from the context
menu.
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The changes are checked for conflicts. A message is displayed if con-
flicts are detected. Conflicts must be resolved; otherwise, the changes
cannot be transferred. If there are no conflicts, the changes are shown
in an overview.

If a file contains different changes in the working directory in Work-
Visual and on the real robot controller, there are 3 possibilities:
‒ Make no changes
‒ Overwrite the file on the real robot controller with the file in the

working directory
‒ Merge the files

An external editor is required to merge the files.
(>>> 6.37.4 "Configuring additional editors" Page 97)

3. If you do not wish to transfer all the displayed changes: Deactivate the
check boxes of the relevant changes.

4. Confirm with OK. The KUKA smartHMI displays the request for confir-
mation The user […] has requested remote access to this controller.
Do you want to allow remote access?.

5. Answer the query with Yes. The changes will be transferred. The mes-
sage The user […] has remote access to this controller. is displayed
on the smartHMI. This access remains active until the message is ac-
knowledged with Revoke.

NOTICE
After changes have been transferred, all programs must be tested in T1
mode. Damage to property may otherwise result.
This applies particularly if the transfer procedure was interrupted and
not all changes were carried out.

13.5.7 Loading changes from the robot controller

Description

This procedure is used to load all changes or only selected changes from
the robot controller. Changes in the working directory that have not yet
been transferred to the robot controller are displayed and can be undone.

Precondition

• Network connection to the real robot controller
• The real robot controller and the KUKA smartHMI are running.
• Programming and diagnosis workspace

Procedure

1. Either: Right-click on the root node of the working directory and select
Load files from controller. All the changes are shown in an over-
view.
Or: Right-click on a folder in the working directory and select Load
files from controller. The selected folder, the files contained in it and
the changes to them are shown in an overview.

2. Activate or deactivate the check boxes of the changes as desired and
confirm with OK. The selected changes will be carried out.
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13.5.8 Restoring the state of the robot controller

Description

This procedure is used to discard all local changes in the working directo-
ry and to restore the state of the robot controller.

Precondition

• Network connection to the real robot controller
• The real robot controller and the KUKA smartHMI are running.
• Programming and diagnosis workspace

Procedure

1. Right-click on the root node of the working directory and select Estab-
lish controller state.

2. Answer the request for confirmation with Yes. The state of the real ro-
bot controller is restored and all changes are overwritten.

13.5.9 Comparing files

Description

This procedure is used to compare a file in the working directory in Work-
Visual with the same file on the robot controller. The file can also be com-
pared with a file on the local hard drive.

Any appropriate software can be used for the comparison. It must be
installed and configured in WorkVisual, however.
(>>> 6.37.4 "Configuring additional editors" Page 97)

Precondition

• Programming and diagnosis workspace

Only for comparison with the robot controller:

• Network connection to the real robot controller
• The real robot controller and the KUKA smartHMI are running.

Procedure

Comparison with the file on the robot controller:

• Either: Right-click on the file in the working directory and select Com-
pare with controller version from the context menu. The files are
opened with the editor that has been configured as the default editor
for comparisons.

• Or: Select Compare with... > File on controller from the context
menu and select the desired editor. The files are opened with the de-
sired editor.

Comparison with a file on the local hard drive:

1. Right-click on the file in the working directory, select Compare with...
> Local file from the context menu and select the desired editor. A
window opens.

2. Navigate to the path where the file for comparison is located.
3. Select the file and confirm with Open. The files are opened with the

desired editor.
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13.5.10 Copying data from a file to the working directory

Description

This procedure can be used to copy data from a file on the robot control-
ler or local hard drive to the working directory.

Any software can be used for this. It must be installed and configured
in WorkVisual, however.
(>>> 6.37.4 "Configuring additional editors" Page 97)
In the case of DAT files, WorkVisual can also be used:
(>>> 13.5.11 "Copying data from a DAT file to the working directory
with WorkVisual" Page 170).

Precondition

• Programming and diagnosis workspace

Only for comparison with the robot controller:

• Network connection to the real robot controller
• The real robot controller and the KUKA smartHMI are running.

Procedure

Copying data from a file on the robot controller:

1. Open the files:

• Either: Right-click on the file in the working directory and select
Merge with controller version from the context menu. The files
are opened with the editor that has been configured as the default
editor for merging files.

• Or: Select Merge with... > File on controller from the context
menu and select the desired editor. The files are opened with the
desired editor.

2. The differences are displayed. Accept the desired differences and
save the file.

3. Close the editor or click on Exit in WorkVisual.

Copying data from a file on the local hard drive:

1. Right-click on the file in the working directory, select Merge with... >
Local file from the context menu and select the desired editor. A win-
dow opens.

2. Navigate to the path where the file from which the data are to be cop-
ied is located.

3. Select the file and confirm with Open. The files are opened with the
desired editor.

4. The differences are displayed. Accept the desired differences and
save the file.

5. Close the editor or click on Exit in WorkVisual.

13.5.11 Copying data from a DAT file to the working directory with WorkVisual

Description

This procedure can be used to copy data from a DAT file on the robot
controller or local hard drive to the working directory.
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Precondition

• Programming and diagnosis workspace

Only for comparison with the robot controller:

• Network connection to the real robot controller
• The real robot controller and the KUKA smartHMI are running.

Procedure

Copying data from a DAT file on the robot controller:

1. Right-click on the DAT file in the working directory and select Merge
with... > File on controller > WorkVisual in the context menu. The
files are compared and a window with an overview of the differences
is displayed: (>>> Fig. 6-13).

2. For each difference, select whether to retain the data of the file in the
working directory or to copy the data from the file on the robot control-
ler. This does not have to be done for all the differences at one go.

3. Click on Merge to accept the selected changes.
4. Once all desired differences have been accepted, close the [Merge]

window.

Copying data from a DAT file on the local hard drive:

1. Right-click on the DAT file in the working directory and select Merge
with... > Local file > WorkVisual in the context menu. A window
opens.

2. Navigate to the path where the file from which the data are to be cop-
ied is located.

3. Select the file and confirm with Open. The files are compared and a
window with an overview of the differences is displayed:
(>>> Fig. 6-13).

4. For each difference, select whether to retain the data of the file in the
working directory or to copy the data from the local file. This does not
have to be done for all the differences at one go.

5. Click on Merge to accept the selected changes.
6. Once all desired differences have been accepted, close the [Merge]

window.

13.6 Debugging programs

WorkVisual provides a debugging mode with which errors can be found in
running programs. Programs with subprograms can also be debugged.
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13.6.1 Overview of the debugging mode

Fig. 13-15: Debugging mode

Item Description

1 Working directory in the debugging mode

2 Program running in the debugging mode

3 Current position of the block pointer

4 Current position of the advance run pointer

5 Monitoring window

(>>> 13.6.3 "Monitoring variables" Page 174)

6 Debugging window

(>>> 13.6.2 "Starting the debugging mode" Page 173)

Point-
er

Description

Block pointer

The end point is being approached.

Advance run pointer

The block pointer is located in a subprogram.

The block pointer and advance run pointer are located in the
same line. The end point has been reached with exact posi-
tioning.
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Point-
er

Description

The block pointer and advance run pointer are located in the
same line. The end point is being approached.

Block pointer

The end point has been reached with exact positioning.

The block pointer is located in a program line higher up in the
program.

The block pointer is located in a program line lower down in
the program.

The block pointer is located in a subprogram. The current pro-
gram line is located higher up in the program.

The block pointer is located in a subprogram. The current pro-
gram line is located lower down in the program.

Button Description

Starts the debugging mode.

Ends the debugging mode.

The following buttons are only available when an OPS is used:

Button Description

Starts the program.

Stops the program.

Resets the program.

13.6.2 Starting the debugging mode

Precondition

• Network connection to the real robot controller
• The real robot controller and the KUKA smartHMI are running.
• User group “Expert”
• T1 or T2 mode
• Programming and diagnosis workspace
• The working directory is open in the KRC Explorer and the state cor-

responds to that of the real robot controller.

Procedure

1. Only if the Debugging window is not yet displayed: Display it by se-
lecting the menu sequence Window > Debugging.

2. Right-click on the working directory in the KRC Explorer and select
Start debugging.

Alternatively: Click on the  button.
3. Select and start the desired program on the smartHMI.
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Fig. 13-16: “Debugging” window

Item Description

1 The robot controllers whose working directory has been loaded
into WorkVisual are displayed here.

2 The current program run mode is displayed here. A different
program run mode can be selected. This setting is only rele-
vant if an OPS is used.

3 These lines indicate the programs and lines in which the block
pointer and advance run pointer are currently located.

4 List of calls

These lines indicate which programs or functions within pro-
grams are called. Double-clicking on a line jumps directly to
the relevant point in the program.

In this example, a function is called in line 283 in the program
h50.SRC. From this function, a function or a program in the
program palette.SRC is called in line 338.

Button Description

Starts the debugging mode.

Ends the debugging mode.

Indicates the block pointer in the editor.

Indicates the advance run pointer in the editor.

Indicates in the editor that the block pointer is located in a
subprogram.

Scrolls automatically to the point in the program at which the
block pointer is located.

Indicates subprograms already opened in the foreground if
the block pointer is located in them.

Opens an editor for each subprogram called.

13.6.3 Monitoring variables

Description

During debugging, the state of variables in the program can be monitored.
There are 2 monitoring windows available for this. Mathematical calcula-
tions (e.g. variable + 5) and expressions as well as nested structures and

KUKA.WorkVisual 5.0

174/230 | www.kuka.com KST WorkVisual 5.0 V7 | Issued: 12.07.2018

P
ro

gr
am

m
in

g



arrays are also evaluated in these windows. If a value changes, it is dis-
played in red for a few seconds in the monitoring window.
The following variables can be monitored:

• Variables that have been declared globally (in the file $CONFIG.DAT
or in a DAT file containing the keyword PUBLIC)

• Variables that have been declared locally in the DAT file (globally for
the module)

• Variables that have been declared locally in the SRC file while the ad-
vance run pointer is located in the same program as the declaration
(runtime data)

Precondition

• The debugging mode has been started.

Procedure

1. Display the monitoring window by selecting the menu sequence Win-
dow > Monitoring window 1 or Monitoring window 2.

2. Right-click on the desired variable in the program and select Monitor.
Alternatively: Click on an empty row in the Name column and enter
the name of the desired variable. During entry, variables are sugges-
ted that are contained in the current program or have been globally
defined.

Fig. 13-17: Monitoring window

Item Description

1 The robot controllers for which the debugging mode has been
started are displayed here.

2 All the groups of variables present in the monitoring window
are displayed here. A filter can be set for each group.

Button Description

Loads variables in the ConfigMon.INI format

Saves variables in the ConfigMon.INI format

Icon Description

Variables that have been declared in either the DAT file or
the SRC file

Signals (e.g. inputs and outputs)

Mathematical calculations and expressions
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13.6.4 Ending the debugging mode

Procedure

• Right-click on the working directory in the KRC Explorer and select
Stop debugging.

Alternatively: Click on the  button.
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14 Transferring and activating a project

14.1 Generating code

Description

When a project is transferred to the robot controller, the code is always
generated first. This procedure can be used to generate the code sepa-
rately and thus to check in advance whether generation runs without error.
The code is displayed on the Files tab of the Project structure window.
Automatically generated code is displayed in pale gray.

Any changes in the configuration are only transferred to the file struc-
ture during code generation. For this reason, manual changes can no
longer be present in the files after the code has been generated.

It is recommended that all option packages contained in the project are
also installed in WorkVisual before code generation.

Fig. 14-1: Example of code generation: before – after

Procedure

• Select the menu sequence Extras > Generate code.

The code is generated. When the process is finished, the following mes-
sages are displayed in the message window: The project <"{0}" V{1}>
has been compiled. The results can be seen in the file tree.
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14.2 Pinning a project

Description

Projects that are present on the robot controller can be pinned. A project
can be pinned directly on the robot controller or in WorkVisual.
Pinned projects cannot be changed, activated or deleted. They can be
copied or unpinned, however. A project can thus be pinned, e.g. to pre-
vent it from being accidentally deleted.

Procedure

Pinning in WorkVisual:

1. Select the menu sequence: File > Browse for project. The Project
Explorer is opened. On the left, the Search tab is selected.

2. In the Available cells area, expand the node of the desired cell. All
the robot controllers of this cell are displayed.

3. Expand the node of the desired robot controller. All projects are dis-
played. Pinned projects are indicated by a pin symbol.

4. Select the desired project and click on the Pin project button. The
project is pinned and labeled with a pin symbol in the project list.

Information about pinning on the robot controller can be found in the
Operating and Programming Instructions for System Integrators for
the KUKA System Software.

14.3 Assigning the robot controller to the real robot controller

Description

This procedure is used to assign every robot controller in the project to a
real robot controller. The project can then be transferred from WorkVisual
to the real robot controller.

Precondition

• A robot controller has been added in WorkVisual.
• Network connection to the real robot controller
• The real robot controller and the KUKA smartHMI are running.

If the project is subsequently to be transferred and also activated:

• The user group “Expert” or higher is selected on the real robot control-
ler.
Restriction: If the activation would cause changes in the area Safety-
relevant communication parameters, the user group “Safety recov-
ery” or higher must be selected.

• If the operating mode AUT or AUT EXT (KR C4) or EXT (VKR C4) is
selected on the real robot controller:
The project contains only settings that affect KRL programs. If the
project contains settings that would cause other changes, it cannot be
activated.

Procedure

1. Click on the Deploy… button in the menu bar. The WorkVisual
Project Deployment window is opened. The virtual robot controller
from the project is displayed on the left-hand side. The target control-
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ler is displayed on the right-hand side. It is grayed out when a control-
ler has not yet been selected.

Fig. 14-2: Assigning the robot controller to the cell

2. Set the check mark in the check box of the virtual cell on the left-hand
side. This cell must now be assigned to the real robot controller.

3. Click on the … button. A window opens. The filter is automatically set
to only display controllers of the same type and version as the virtual
controller. This setting can be changed.

Fig. 14-3: Assigning a real robot controller to the virtual controller

4. Select the real robot controller and click on the Ok button. The real ro-
bot controller is assigned to the virtual robot controller. Once it is as-
signed, the real robot controller is displayed in color and with its name
and IP address.
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Fig. 14-4: Overview

5. If the project contains more than one robot controller, repeat steps 3
and 4 for the other robot controllers.

6. Click on Next. The assignment is checked for conflicts. A message is
displayed if conflicts are detected. Conflicts must be resolved; other-
wise, the project cannot be transferred. If no conflicts are present, the
code is generated automatically.

7. The project can now be transferred to the robot controller.
Alternatively, the project can be transferred at a later point in time. To
do this, click on Cancel: The assignment is saved and the WorkVisu-
al Project Deployment window is closed.

14.4 Transferring the project to the robot controller

Description

This procedure is used to transfer the project from WorkVisual to the real
robot controller.

If a project was transferred to the real robot controller at an earlier time
and has not yet been activated then this will be overwritten if a further
project is transferred.
Transferring and activating a project overwrites a project of the same
name that already exists on the real robot controller (after a request for
confirmation).

Precondition

• The project has been assigned to the real robot controller.
• Assignment conflicts have been resolved.
• Network connection to the real robot controller
• The real robot controller and the KUKA smartHMI are running.

If the project is also to be activated:
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• The user group “Expert” or higher is selected on the real robot control-
ler.
Restriction: If the activation would cause changes in the area Safety-
relevant communication parameters, the user group “Safety recov-
ery” or higher must be selected.

• If the operating mode AUT or AUT EXT (KR C4) or EXT (VKR C4) is
selected on the real robot controller:
The project contains only settings that affect KRL programs. If the
project contains settings that would cause other changes, it cannot be
activated.

If one of the options KUKA.SafeOperation or KUKA.SafeRangeMonitor-
ing is installed on the robot controller, different user groups may apply.
Information can be found in the documentation for these options.

If a project is transferred containing an option package that has been
inserted into the project without a window showing the changes being
displayed, then the following procedure must be observed:
1. Transfer the project to the robot controller, but DO NOT activate it!
2. Install the option package on the robot controller.

Installation is performed in the normal manner. Information about
this can be found in the documentation for the option package.

3. Transfer the active project from the robot controller to WorkVisual
and carry out the user configuration.

4. Transfer the project back to the robot controller.
5. Activate the project on the robot controller.

Procedure

1. Click on the Deploy... button in the menu bar. The WorkVisual
Project Deployment window is opened.

Fig. 14-5: Overview

2. Click on Next. Program generation begins.
3. Click on Next. The project is transferred.
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If a project has been transferred containing an option package that
was inserted into the project without a window showing the changes
being displayed:
Do not activate the project, i.e. do not continue with the next step!
Observe the note about projects with option packages at the begin-
ning of this section!

4. Click on Next.

WARNING
In the operating modes AUT and AUT EXT (KR C4) and in the op-
erating mode EXT (VKR C4), the project is activated without any re-
quest for confirmation if there are only program changes.

5. Only in operating modes T1 and T2: The KUKA smartHMI displays the
request for confirmation Do you want to activate the project […]?. In
addition, a message is displayed as to whether the activation would
overwrite a project, and if so, which one.
If no relevant project will be overwritten: Confirm with Yes within
30 minutes.

6. An overview is displayed of the changes which will be made in com-
parison to the project that is still active on the robot controller. The
check box Details can be used to display details about the changes.

WARNING
If changes are listed in the overview under the heading Safety-rele-
vant communication parameters, this means that the behavior of
the Emergency Stop and “Operator safety” signal may have
changed compared with the previous project.
After activation of the project, the Emergency Stop and the “Opera-
tor safety” signal must be checked for safe functioning. If the
project is activated on several robot controllers, this check must be
carried out for every robot controller. Failure to carry out this check
may result in death, injuries or damage to property.

7. The overview displays the request for confirmation Do you want to
continue?. Confirm with Yes. The project is activated on the robot con-
troller. A confirmation is displayed in WorkVisual.

Fig. 14-6: Confirmation in WorkVisual
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If an option package has been installed through project activation,
the project must then be loaded from the robot controller. Continued
work on the project may otherwise result in file inconsistency, thus
making project redeployment no longer possible.

8. Close the WorkVisual Project Deployment window by selecting Fin-
ish.

9. If the request for confirmation on the robot controller is not answered
within 30 minutes, the project is still transferred, but is not activated
on the robot controller. The project can then be activated separately.
(>>> 14.5 "Activating a project" Page 183)

WARNING
After activation of a project on the robot controller, the safety configura-
tion must be checked there! If this is not done, the robot will possibly
be operated with incorrect data. Death, injuries or damage to property
may result.
(>>> 14.6 "Checking the safety configuration of the robot controller"
Page 185)

WARNING
If the activation of a project fails, an error message is displayed in
WorkVisual. In this case, one of the following measures must be
carried out:

• Rectify the fault and restart the activation by clicking on the  but-
ton.

• Or activate a different project.
• Or reboot the robot controller with a cold restart.

If the error cannot be eliminated, the deployed project can be deleted
from the robot controller again:

1. Click on the  button.
2. Answer the request for confirmation with Yes.
3. Close the window.

14.5 Activating a project

• A project can be activated on the robot controller from within WorkVi-
sual.
(>>> 14.5.1 "Activating a project (in WorkVisual)" Page 183)

• A project can be activated directly on the robot controller.

Information about activation on the robot controller can be found in
the Operating and Programming Instructions for System Inte-
grators for the KUKA System Software.

14.5.1 Activating a project (in WorkVisual)

Precondition

• Network connection to the real robot controller
• The real robot controller and the KUKA smartHMI are running.
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• The user group “Expert” or higher is selected on the real robot control-
ler.
Constraints:

‒ If the activation would cause changes in the area Safety-relevant
communication parameters, the user group “Safety recovery” or
higher must be selected.

‒ If the activation would cause changes to the brake test configura-
tion, the user group “Safety maintenance” or higher must be selec-
ted.

• If the operating mode AUT or AUT EXT (KR C4) or EXT (VKR C4) is
selected on the real robot controller:
The project can only be activated if this affects only KRL programs. If
the project contains settings that would cause other changes, it cannot
be activated.

If one of the options KUKA.SafeOperation or KUKA.SafeRangeMonitor-
ing is installed on the robot controller, different user groups may apply.
Information can be found in the documentation for these options.

If a project has been transferred containing an option package that was
inserted into the project without a window showing the changes being
displayed:
Do not activate the project! For such projects, the procedure differs
from the usual procedure for transfer and activation. Further information
can be found in the section on project deployment.
(>>> 14.4 "Transferring the project to the robot controller" Page 180)

Procedure

1. Select the menu sequence File > Browse for project. The WorkVisu-
al Project Explorer opens. On the left, the Browse tab is selected.

2. In the Available cells area, expand the node of the desired cell. All
the robot controllers of this cell are displayed.

3. Expand the node of the desired robot controller. All projects are dis-
played. The active project is indicated by a small green arrow.

4. Select the desired project and click on the Activate project button.
The Project deployment window opens.

5. Click on Next.

WARNING
In the operating modes AUT and AUT EXT (KR C4) and in the op-
erating mode EXT (VKR C4), the project is activated without any re-
quest for confirmation if there are only program changes.

6. Only in operating modes T1 and T2: The KUKA smartHMI displays the
request for confirmation Do you want to activate the project […]?. In
addition, a message is displayed as to whether the activation would
overwrite a project, and if so, which one.
If no relevant project will be overwritten: Confirm with Yes within
30 minutes.

7. On the KUKA smartHMI, an overview is displayed of the changes
which will be made in comparison to the project that is still active on
the robot controller. The check box Details can be used to display de-
tails about the changes.
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WARNING
If changes are listed in the overview under the heading Safety-rele-
vant communication parameters, this means that the behavior of
the Emergency Stop and “Operator safety” signal may have
changed compared with the previous project.
After activation of the project, the Emergency Stop and the “Opera-
tor safety” signal must be checked for safe functioning. If the
project is activated on several robot controllers, this check must be
carried out for every robot controller. Failure to carry out this check
may result in death, injuries or damage to property.

8. The overview displays the request for confirmation Do you want to
continue?. Confirm with Yes. The project is activated on the robot con-
troller. A confirmation is displayed in WorkVisual.

9. In WorkVisual, close the Project deployment window with Exit.
10. Click on Refresh in the Project Explorer. The active project is now

indicated by a small green arrow. (The small green arrow disappears
from the project that was active before.)

WARNING
After activation of a project on the robot controller, the safety configura-
tion must be checked there! If this is not done, the robot will possibly
be operated with incorrect data. Death, injuries or damage to property
may result.
(>>> 14.6 "Checking the safety configuration of the robot controller"
Page 185)

WARNING
If the activation of a project fails, an error message is displayed in
WorkVisual. In this case, one of the following measures must be
carried out:

• Rectify the fault and restart the activation by clicking on the  but-
ton.

• Or activate a different project.
• Or reboot the robot controller with a cold restart.

If the error cannot be eliminated, the deployed project can be deleted
from the robot controller again:

1. Click on the  button.
2. Answer the request for confirmation with Yes.
3. Close the window.

14.6 Checking the safety configuration of the robot controller

Description

The safety configuration of the robot controller must be checked in the fol-
lowing cases:

• After activation of a WorkVisual project on the robot controller
• Generally after changes to the machine data (independent of WorkVi-

sual).
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WARNING
If the safety configuration is not checked and updated where necessary,
it may contain incorrect data. Death, injuries or damage to property
may result.

Information about checking the safety configuration and the safe axis
monitoring functions is contained in the Operating and Programming In-
structions for System Integrators.

14.7 Loading the project from the robot controller

Description

On every robot controller to which a network connection is established, a
project can be selected and loaded in WorkVisual. This is also possible if
this project is not yet present on this PC.
The project is saved in the directory: …\WorkVisual […]\Downloaded
Projects.

Precondition

• Network connection to the real robot controller

Procedure

1. Select the menu sequence File > Browse for project. The WorkVisu-
al Project Explorer opens. On the left, the Search tab is selected.

2. In the Available cells area, expand the node of the desired cell. All
the robot controllers of this cell are displayed.

3. Expand the node of the desired robot controller. All projects are dis-
played.

4. Select the desired project and click on Open. The project is opened in
WorkVisual.

14.8 Comparing projects (and accepting differences)

Description

A project in WorkVisual can be compared with another project. This can
be a project on a robot controller or a locally saved project. The differen-
ces are clearly listed. The user can decide for each individual difference
whether to leave the state as in the current project or to transfer the state
from the other project.

Precondition

• The project that is to be compared is open in WorkVisual.

If the other project to be compared is located on a robot controller:

• The real robot controller is running.
• Network connection to the real robot controller

Procedure

1. In WorkVisual, select the menu sequence Extras > Compare
projects. The Compare projects window opens.
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2. Select the project with which the current WorkVisual project should be
compared, e.g. the project of the same name on the real robot control-
ler.

Fig. 14-7: Selecting a project for “Compare”

3. Click on Next. A progress bar is displayed. (If the project contains
more than one controller, a bar is displayed for each one.)
(>>>  "Progress bars" Page 187)

4. When the progress bar is full and the message Ready for merge is
displayed: Click on Show differences. The differences between the
projects are displayed in an overview.
(>>>  "Comparison" Page 188)
If no differences were determined, this is indicated in the message
window. Continue with step 8. After this, no further steps are necessa-
ry.

5. For each difference, select whether to retain the state of the current
project or to adopt the state of the comparison project. This does not
have to be done for all the differences at one go.
If suitable, the default selection can also be accepted.

6. Press Merge to transfer the changes to WorkVisual.
7. Repeat steps 5 to 6 as required. This makes it possible to work

through the different areas bit by bit.
Once all the differences have been reconciled, the following message
is displayed: No further differences were detected.

8. Close the Compare projects window.
9. Save the project.

Progress bars

Fig. 14-8: Example: progress bar

This view shows all the robot controllers which are contained in the
project. A separate bar is displayed for each of these robot controllers.
For each bar, the real robot controller to which the project was last trans-
ferred is also specified. The check boxes are used to select for which ro-
bot controllers the comparison should be carried out.
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If additional robot controllers were added or removed in WorkVisual after
deployment, these robot controllers are also displayed here. They are
marked as invalid, however, and cannot be selected.

Comparison

The differences between the projects are displayed in an overview. For
each difference, the user can select which state to accept. The default
setting is as follows:

• For all elements that are present in the open project, the state of this
project is selected.

• For all elements that are not present in the open project, the state of
the comparison project is selected.

Exception: For projects with a VKRC 4 controller, the state of the com-
parison project is always selected for the long texts.

Fig. 14-9: Example: overview of differences

Item Description

1 The node for the robot controller. The various project areas are represented by
subnodes. The nodes can be expanded to display the comparisons.

If several robot controllers are present, these are listed one after the other.

• In each line, place a check mark in the box for the value that should be trans-
ferred.

• A check mark next to Not available means that the element will not be trans-
ferred, or that it will be deleted from the project if already present.
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Item Description

• If a check box is activated for a node, the check boxes for all subordinate ele-
ments are also automatically activated.
If a check box is deactivated for a node, the check boxes for all subordinated
elements are also automatically deactivated.
The subordinate elements can also be edited individually, however.

• A filled-in box means: at least one of the subordinate elements is selected, but
not all.

2 State of the project that is open in WorkVisual

3 State of the comparison project

4 Back arrow: The focus in the display jumps to the previous difference.

Forward arrow: The focus in the display jumps to the next difference.

Collapsed nodes are automatically expanded.

5 Check box active: Detailed information is shown for the selected line in the over-
view.

6 Filter

7 Transfers the selected changes to the open project.

14.9 Copying data from a different project

Description

This procedure is used to apply data from a different project to the open
project. This can be a project on a robot controller or a locally saved
project. The differences are categorized and clearly listed. For each cate-
gory, the display indicates whether it contains changes. If so, the number
of changes is also shown. Within a category, the user can decide for each
individual difference whether to leave the state as in the open project or
to apply the state from the other project.

Precondition

• The project to which the data are to be applied has been opened in
WorkVisual.

If the other project is located on a robot controller:

• The real robot controller is running.
• Network connection to the real robot controller

Procedure

1. Right-click on the robot controller on the Hardware tab in the Project
structure window.

2. Select Compare/merge controller in the context menu. The Com-
pare/merge controllers window opens.

3. Select whether a project from the robot controller or a local project is
to be used:

• Project from controller: All projects on the controller are dis-
played. Select the desired project and click on Next. The project is
loaded from the robot controller and compared with the project that
is open in WorkVisual.

• Local project:
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1. Click on … and navigate to the directory in which the project is
located.

2. Select the project and click on Open.
3. Click on Next. The project is opened and compared with the

project that is open in WorkVisual.

A window with an overview of the differences is displayed.

Fig. 14-10: Overview of differences

4. Select a category and click on Next. A window opens. This varies
slightly according to the category selected.
(>>> Fig. 14-11)

5. For each difference, select whether to retain the data of the open
project or to apply the data of the selected project. This does not have
to be done for all the differences at one go.

6. Click on Merge to apply the selected changes to the open project.
7. Repeat steps 5 and 6 for the other categories.
8. Once all desired differences have been accepted, close the Compare/

merge controllers window.
9. Save the project.
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Fig. 14-11: Editor of the category “Field bus I/O mappings”

Item Description

1 Button bar

(>>>  "Button bar" Page 192)

2 State of the project that is open in WorkVisual

3 Only in the categories Field bus I/O mappings and Files: Detail view

Field bus I/O mappings: If a device is selected in the structure, the I/O mappings
of the device can be compared here.

Files: If a file is selected in the file structure, the individual differences within this
file can be compared here.

Lines that differ are marked.

4 Only in the category “Field bus I/O mappings” Buttons in the detailed view

(>>>  "Button bar" Page 192)

5 Overview of changes

• Always activate the check box of the value that is to be accepted.

Only in the categories Tools and Bases, Machine data configuration, Field bus
configuration, Field bus I/O mappings and Files:

• If a check box is activated for a higher-level element, the check boxes for all
subordinate elements are also automatically activated.
If a check box is deactivated for a higher-level element, the check boxes for all
subordinate elements are also automatically deactivated.
The subordinate elements can also be edited individually, however.

• A filled-in box means: at least one of the subordinate elements is selected, but
not all.

6 Status in the selected project

7 Only in the categories Field bus I/O mappings and Files: Arrow keys
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Item Description
(>>>  "Arrow keys" Page 192)

8 Transfers the selected changes to the open project.

9 Back to overview of categories

Button bar

Button Description

Accepts all data from the open project

Accepts all data from the selected project

Displays all elements that are identical in both projects

Displays all elements that are different in both projects

Displays all elements that are not present in the open project

Displays all elements that are not present in the selected
project

• In the button bar: long texts are included when the data
are transferred

• In the detailed view: displays the long texts

Filter

Compares files with an external editor

Note: This button is only active if at least one external editor
is installed.

Merges files using an external editor

Note: This button is only active if at least one external editor
is installed.

The focus in the display jumps to the previous difference.

The focus in the display jumps to the next difference.

Arrow keys

Key Description

The focus in the display jumps to the first difference.

The focus in the display jumps to the previous difference.

The focus in the display jumps to the next difference.

The focus in the display jumps to the last difference.

14.10 Updating the project

Description

If a project differs on the robot controller and in WorkVisual, the project in
WorkVisual can be updated. The project does not have to be loaded from
the controller again for this. For a project with several robot controllers, it
is possible to only update the projects of specific controllers. The current
project in WorkVisual can also be updated using a local project.
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If there are multiple robot controllers in a robotic cell, it is only necessary
to load the project from one robot controller. The project can then be up-
dated with the data of the other robot controllers. The collected data are
loaded from the other robot controllers and inserted into the current
project. As long as the data have not been loaded, the other robot control-
lers are grayed out in the Project structure window and in the Cell con-
figuration window.

Precondition

• Network connection to the real robot controller

Procedure

1. Right-click on the robot controller on the Hardware tab in the Project
structure window.
Or: Right-click on the robot controller in the Cell configuration win-
dow.

2. Select Update in the context menu. Then select the desired option:

• With active project: If the current project in WorkVisual is to be
updated using the current project on the robot controller. The
projects are saved. Continue with step 3.

• With a user-selected version: If the current project in WorkVisual
is to be updated using another project found on the robot control-
ler.
A window opens. Select the desired project from the list and click
on Update. Continue with step 3.

• With local project: If the current project in WorkVisual is to be up-
dated using a project found on the local computer.
A window opens. Navigate to the desired project and click on
Open. Continue with step 3.

• Load missing controllers: If the current project in WorkVisual is
to be updated with the data of the other robot controllers located
in the same robotic cell. The data are loaded and inserted into the
current project. Continue with step 6.

3. The Compare projects window opens. The projects are compared
and a progress bar is displayed. Once the comparison is completed,
the differences between the projects are displayed in an overview. For
each difference, select which state to accept.

4. Click on Merge. The desired changes are saved.
5. Close the Compare projects window.
6. Save the project.
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15 Diagnosis

15.1 Project analysis

15.1.1 Analyzing a project automatically for errors

Description

In WorkVisual, it is possible to analyze the current project continuously in
the background. If configuration errors are detected, WorkVisual alerts the
user. In addition, an automatic correction is offered for many errors.
An icon in the bottom right corner of the user interface indicates the
status of the project analysis.

Icon Color Description

Green WorkVisual has not detected any errors.

Yellow WorkVisual has detected a discrepancy. The discrep-
ancy will not prevent the project from running on a
real robot controller. However, the discrepancy is
probably not intended or desired by the user.

Red WorkVisual has detected an error. The project is un-
able to run on a real robot controller in this state.
The error would come to light during code
generation or, at the very latest, on the real robot
controller.

Gray The analysis is deactivated.

The project analysis detects a wide range of errors and gives the user
valuable support. A green icon cannot guarantee that the project is free
from configuration errors, however.

Precondition

• Project analysis is activated.

Procedure

1. Depending on the configuration:

• The WorkVisual project analysis window opens automatically if
the icon is red or yellow.

• Or: Click on the icon to open the WorkVisual project analysis
window.

2. The window displays a brief description of the error. Often one or
more possibilities for correction are displayed beneath the description.
Click on the desired correction proposal.

KUKA.WorkVisual 5.0

194/230 | www.kuka.com KST WorkVisual 5.0 V7 | Issued: 12.07.2018

D
ia

gn
os

is



Fig. 15-1: Example: WorkVisual project analysis, with correction pro-
posal

15.1.2 Configuring the project analysis function

Procedure

1. Select the menu sequence Extras > Options. The Options window is
opened.

2. On the left of the window, select the Project analysis folder.
The corresponding settings are now displayed on the right of the win-
dow.

3. Make the desired settings. Confirm with OK.

Description

Setting options in the Project analysis folder:

Item Description

Analysis activated • Check box active: The project is analyzed
continuously. If errors or discrepancies are
detected, these are displayed in the Work-
Visual project analysis window.

• Without: The project is not analyzed and
no messages are displayed.

Automatic notifica-
tion activated

• Check box active: The WorkVisual
project analysis window opens automati-
cally whenever an error or discrepancy is
detected.

• Without: The WorkVisual project analy-
sis window opens only when the icon is
clicked.

15.2 Trace

Trace recordings are an important diagnostic tool during start-up of the in-
dustrial robot and during troubleshooting. They are also used for optimiza-
tion of the machine data. The trace function can be used to record differ-
ent variables with the program running, e.g. actual current, setpoint cur-
rent, states of inputs and outputs, etc. The recording can then be dis-
played using the oscilloscope.
In WorkVisual it is possible to configure trace recordings and transfer
them to the robot controller. The recording can also be started in WorkVi-
sual. In addition, trace configurations can be imported from the robot con-
troller to WorkVisual. The results of trace recordings can also be imported
to WorkVisual. The oscilloscope function is also available here for display
and evaluation.
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15.2.1 Configuring and starting the trace recording

Description

During configuration, the data to be recorded are specified. The robot con-
troller saves the recording in the directory: C:\KRC\ROBOTER\TRACE.

Precondition

• Programming and diagnosis workspace

Procedure

1. Select the menu sequence Editors > Trace configuration. The Trace
configuration window opens.

2. Select a configuration or create a new configuration on the General
tab. Edit the configuration if required.
(>>> 15.2.5 "“Trace configuration” window" Page 198)

3. If the configuration is only to be transferred to one robot controller: On
the General tab, click on the Save button.
If the configuration is to be transferred to multiple robot controllers:

a. On the General tab, click on the Save as button. A window opens.
b. Select the robot controllers and confirm with Save.

4. Click on the Start trace button to start the recording. The recording is
started in accordance with the defined trigger.
Or: Click on Trigger. The recording starts immediately.
The State box jumps from Trace ended to either Wait or Trigger trig-
gered.

5. The recording is ended when the State box displays the value Trace
ended again.

15.2.2 Importing a trace configuration

Description

Trace configurations can be imported. They are then available in the Con-
figuration box in the Trace configuration window.

Procedure

1. The import/export function can be accessed in one of the following
ways:

• Select the menu sequence Editors > Trace configuration. The
Trace configuration window opens.
On the General tab, click on the Import / Export button.

Or:

• Select the menu sequence File > Import / Export. A window
opens.
Select Import/export trace configurations and click on Next.

2. Select the Import option.
3. If the desired directory is not displayed in the Source directory box:

Click on Browse and navigate to the directory where the configura-
tions are located. Select the directory and confirm selection with OK.
The configurations located in the directory are displayed.

4. Specify whether existing data are to be overwritten.
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5. Click on Finish.
6. The data are imported. If the import was successful, this is indicated

by a message in the window. Close the window.

15.2.3 Exporting a trace configuration

Procedure

1. The import/export function can be accessed in one of the following
ways:

• Select the menu sequence Editors > Trace configuration. The
Trace configuration window opens.
On the General tab, click on the Import / Export button.

Or:

• Select the menu sequence File > Import / Export. A window
opens.
Select Import/export trace configurations and click on Next.

2. Select the Export option. All configurations stored locally are dis-
played.

3. If the desired directory is not displayed in the Target directory box:
Click on Browse and navigate to the desired directory. Select the di-
rectory and confirm selection with OK.

4. Specify whether existing data are to be overwritten.
5. Click on Finish.
6. The data are exported. If the export was successful, this is indicated

by a message in the window. Close the window.

15.2.4 Modifying default settings of the trace configuration

Procedure

1. Select the menu sequence Extras > Options.... The Options window
is opened.

2. On the left-hand side of the window, select the Trace folder. The cor-
responding settings are now displayed on the right of the window.

3. Make the desired settings. Confirm with OK.

Description

Setting options in the Trace folder:

Box Description

Standard pretrig-
ger

The value that is preset as standard in the Pre-
trigger box on the General tab can be modified
here.

Trigger limitation
is active

• Check box active: Only one trigger can be
added for each module instance.

• Check box not active: Any number of trig-
gers can be added for each module instance.
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15.2.5 “Trace configuration” window

15.2.5.1 “General” tab

Fig. 15-2: “General” tab

Item Description

1 • local: The predefined and the locally saved configurations are available for se-
lection in the Configuration box.

• [Robot controller]: All the configurations saved on this robot controller are availa-
ble for selection in the Configuration box.

2 Only if the entry local is selected in the Source box:

The version of the System Software to which the configuration refers must be selec-

ted here. The selection must be confirmed with , otherwise only the configuration
templates of the previously selected version are displayed.

3 A configuration can be selected here. The configuration can be edited on the tabs
and then saved locally or as a user-defined configuration on a robot controller.

4 Opens a window in which a name for a new configuration can be entered. The emp-
ty template New or an existing configuration can be selected as a template for the
new configuration. If a configuration with the same name already exists, it can be
overwritten. On confirming the entries with OK, the new configuration is inserted in
the list under Own configurations.

If the entry local is selected in the Source box, the System Software version can

be changed. The change must be confirmed with , otherwise only the configura-
tion templates of the previously selected version are displayed.

5 Deletes the configuration displayed in the Configuration box.
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Item Description

6 Saves either locally or on a robot controller the configuration displayed in the Con-
figuration box. The path depends on which entry is selected in the Source box.
The settings on the tabs are accepted.

7 Opens a window for selection of the robot controllers on which the configuration dis-
played in the Configuration box is to be saved.

8 Opens a window for the import/export of trace configurations.

9 Name for the recording. The name can be changed. The robot controller adds ex-
tensions to the end of the name, indicating what data have been recorded.

Example: If the recording was called "Tracedef1", the saved files are called "Trace-
def1_NextGenDrive", "Tracedef1_KRCIpo", etc.

10 Duration of the recording. Only whole numbers can be entered. Maximum value:
9999 s

11 The position of the time phase displayed in the recording relative to the trigger. The
value refers to the duration of the recording.

Examples:

• 0: The displayed time phase starts at the trigger.
• 30: 30% of the displayed time phase comes before the trigger, 70% after the

trigger.
• 100: The displayed time phase ends at the trigger.

All of the following elements are only displayed if a robot controller is selected in the Source
box.

12 Starts the recording with the configuration displayed under Trace file. This button is
only displayed if no recording has been started yet.

13 Stops the recording. This button is only displayed if a recording has been started.

14 Starts the recording. This button is only displayed if a recording has already been
started.

Strictly speaking, data are recorded as soon as the Start trace button is pressed.
The trigger merely controls which time phase of the recording is then displayed in
the trace files.

15 Trace configuration that is currently active on the robot controller.

16 State of the recording

• Wait: The recording is started and is waiting for the trigger.
• Trigger triggered: The recording continues for the time defined by the trace

length and trigger.
• Trace ended: No recording is running.

15.2.5.2 “Trigger” tab

Triggers can be selected here. Triggers control when data is recorded.
Strictly speaking, data are recorded as soon as the Start trace button is
pressed. The trigger merely controls which time phase of the recording is
then displayed in the trace files.
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Fig. 15-3: “Trigger” tab

Item Description

1 A module can be selected here. The modules contain numerous predefined triggers.

The modules are loaded by the selected robot controller as long as they are KSS
8.3.20 or VSS 8.3.12 or higher. In the case of older versions, the modules saved lo-
cally are loaded and WorkVisual displays a message to this effect.

2 In this box, it is possible to select the instances to which the triggers are to refer.

Instance = axis or drive

3 Here it is possible to search for triggers. The search is a full-text search.

4 All the triggers for this module are displayed here. Exception: If a limit has been
configured for the triggers, only one trigger can be inserted per module instance.

RIGHT ARROW copies triggers selected here to the Selected triggers box. (Alter-
natively: double-click on a trigger.)

5 Depending on the entry selected under Available triggers, filters are available here
for this entry.

6 Here the triggers are inserted that are to be used for the current configuration.

LEFT ARROW removes the triggers selected here. (Alternatively: double-click on a
trigger.)

DOUBLE LEFT ARROW clears this box.

7 Group combines all entries of the same type into a single entry. This gives greater
clarity to the display. It has no effect on the recording.

Ungroup undoes the grouping.

15.2.5.3 “I/O” tab

Here you can select which inputs or outputs are to be recorded.
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Fig. 15-4: “I/O” tab

Item Description

1 All the available inputs/outputs are displayed here.

2 Here a number range can be specified from the entry selected under Available
channels.

3 Select the desired recording rate.

4 Here the inputs/outputs are inserted that are to be recorded with the current config-
uration.

RIGHT ARROW transfers all the inputs/outputs selected via Available channels
and From ID […] to ID […] to this box. LEFT ARROW removes the inputs/outputs
selected here. (As an alternative to these arrow keys: double-click on a channel.)

DOUBLE LEFT ARROW clears this box.

5 Group combines all entries of the same type into a single entry. This gives greater
clarity to the display. It has no effect on the recording.

Ungroup undoes the grouping.

15.2.5.4 “Configuration” tab

The settings on the Advanced configuration tab are also displayed on
the Configuration tab, and vice versa.
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Fig. 15-5: “Configuration” tab

Item Description

1 It is possible to select here how many instances are displayed in the Available
channels display.

Instance = axis or drive

2 Here you can select the channels that are to be recorded.

• To select a channel for individual instances, check the box for the relevant in-
stances.

• To check or uncheck all the boxes in one row, double-click on the row.

Channels that are not specifically for axes or drives have only one check box.

3 All the selected channels are displayed here.

Note: It is possible that channels may be displayed here which cannot be selected
on the Configuration tab. This is the case if these channels have been selected on
the Advanced configuration tab.

15.2.5.5 “Advanced configuration” tab

The Advanced configuration tab contains the same modules as the
Configuration tab, but with more channels and more detailed selection
options. Advanced configuration is particularly suitable for expert users.
The settings on the Advanced configuration tab are also displayed on
the Configuration tab, and vice versa.
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Fig. 15-6: “Advanced configuration” tab

Item Description

1 A module can be selected here. The modules contain different channels.

2 Here it is possible to search for channels. The search is a full-text search.

3 All the channels for the selected module are displayed here.

4 This box is only displayed if the selected module refers to robot axes or drives. It is
possible to select the robot axes or drives to which the channels are to refer.

5 Here the channels are inserted that are to be recorded with the current configura-
tion.

RIGHT ARROW transfers all the entries selected under Available channels to this
box. LEFT ARROW removes the entries selected here. (Alternative to these arrow
keys: double-click on an entry.)

DOUBLE LEFT ARROW clears this box.

6 Select the desired recording rate.

7 Group combines all entries of the same type into a single entry. This gives greater
clarity to the display. It has no effect on the recording.

Ungroup undoes the grouping.

15.2.6 Importing a trace recording

Description

To be able to display a trace recording in WorkVisual, it must first be im-
ported.

Precondition

• The recording was created with KSS or VSS 8.1 or higher, or with 5.4.
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Procedure

1. The import/export function can be accessed in one of the following
ways:

• Select the menu sequence Editors > Trace Analysis (Oscillo-
scope). The Trace Analysis (Oscilloscope) window opens.
On the Channelstab, click on the Import / Export button.

Or:

• Select the menu sequence File > Import / Export. A window
opens.
Select Import trace results and click on Next.

2. Click on Browse and navigate to the directory where the results are
located. Select the directory and confirm selection with OK.
All trace files located in the directory are displayed.

3. Select the traces to be imported.
4. Specify whether existing data are to be overwritten.
5. Select the appropriate entry in the Format box.
6. Click on Finish.
7. The data are imported. If the import was successful, this is indicated

by a message in the window. Close the window.

15.2.7 Displaying a trace recording

Precondition

• Programming and diagnosis workspace
• The recording has been imported to WorkVisual.

Procedure

1. Select the menu sequence Editors > Trace analysis (oscilloscope).
The Trace Analysis (Oscilloscope) window opens.

2. On the Channels tab, select a recording.
(>>> 15.2.8.1 "“Channels” tab" Page 205)

3. Select the channels to be displayed.
4. The channels are displayed on the Oscilloscope tab. Adapt the dis-

play, if necessary (e.g. zoom or change the colors of the traces).
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15.2.8 “Trace Analysis (Oscilloscope)” window

15.2.8.1 “Channels” tab

Fig. 15-7: “Channels” tab

Item Description

1 • Local: All the locally saved recordings are available for selection in the Trace
recording box.

• [Robot controller]: All the recordings saved on this robot controller are available
for selection in the Trace recording box. (In addition to those under local.)

Robot controllers are only displayed in the Source box if they are selected in the
Cell view window.

2 A recording can be selected here.

3 All the channels contained in the selected recording are displayed here.

4 Detailed information about the selected recording is displayed here.

5 Only active if a robot controller is selected in the Source box:

Creates a local copy of the selected recording.

6 Only active if the entry Local is selected in the Source box:

Deletes the recording selected in the Trace recording box.

7 A recording can be imported or exported here.

8 Here the channels are inserted that are to be displayed in the oscilloscope. It is
possible to insert entries from different recordings in this box.

RIGHT ARROW moves all the entries selected under Available channels to this
box. LEFT ARROW removes the entries selected here. (Alternative to these arrow
keys: double-click on the entry.)

DOUBLE LEFT ARROW clears this box.
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15.2.8.2 “Oscilloscope” tab

Fig. 15-8: “Oscilloscope” tab

Item Description

1 Oscilloscope

2 Data for every recorded point are displayed here. If the check box has been acti-
vated for a point, this point is displayed in the oscilloscope.

Check box Description

Show settings Check box active: The columns Active, Trace name, etc., are dis-
played.

Display cursor co-
ordinates

Check box active: The X and Y coordinates of the mouse pointer po-
sition are displayed in the diagram.

Scale automatically Check box active: The curves are adapted to one another in size so
that they are easier to compare visually.

The proportions between the curves then usually no longer corre-
spond to reality. The current factor is displayed under Autoscale fac-
tor, however.

Move automatically Check box active: The midpoints of the curves are aligned.

This option makes it possible to compare curves which lie far apart
on the Y axis. The Y values then usually no longer correspond to re-
ality. The current factor is displayed under Move factor, however.

Synchronized dis-
play

Check box active: The curves are displayed synchronized to the ac-
tual recording time.

Show legend Check box active: The diagram displays which channel name be-
longs to which trace color.

Column Description

Active Check box active: The curve is displayed in the oscilloscope.
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Column Description
Check box not active: The curve is not displayed in the oscilloscope.

Trace name Name of the trace

Module name Name of the module

Channel name Name of the channel

Unit Unit for the Y axis of the oscilloscope display (can be different for
each curve)

MathFunc Mathematical functions that can be applied to the curve. The graph
for the function is displayed in a similar color to that of the curve.

Thickness Line thickness of the curve (unit: point)

Scaling This selection box allows the amplitude to be increased or decreased
in steps. In this way, it is also possible to make curves more visible
which only have a low amplitude or which are hidden by other
curves.

Autoscale factor Factor resulting from the option Scale automatically.

Move factor Factor resulting from the option Move automatically.

Color Color of the curve

Points Active: The motion blocks of the robot are displayed. Start and end
are shown for each block.

Values Active: The individual values which make up the curve are displayed
as points.

RMS Active: The RMS value is shown. Note: The RMS value refers to the
phase of the recording represented in the oscilloscope.

In electrical engineering, the RMS value is the root-mean-square val-
ue of a signal that changes over time.

RMS = Root Mean Square

Steps Active: The curve runs horizontally on the X plane from one value
until it reaches the Y value of the next value. From there it runs ver-
tically up to this Y value.

Inactive: The curve takes the shortest path from one value to the
next.

Offset X axis Offsets this curve on the X axis by the specified value.

Offset Y axis Offsets this curve on the Y axis by the specified value.

Min The minimum value of the curve, with reference to the currently visi-
ble segment

Max The maximum value of the curve, with reference to the currently visi-
ble segment

15.2.9 Panning and zooming the oscilloscope display

Procedure

Panning:

1. Click in the display and hold down the mouse button.
2. Drag with the mouse. The display moves with the mouse.

Zooming:

1. Click into the display.
2. Scroll with the mouse wheel.
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Scroll down: Zoom gets smaller. Scroll up: Zoom gets larger.

Enlarging a section:

1. Hold down the SHIFT key.
2. Click in the display and hold down the mouse button.
3. Move the mouse over the desired section. A gray rectangle is dis-

played. The size can be changed by moving the mouse. (The aspect
ratio cannot be changed.)

4. Release the mouse button. The contents of the gray rectangle are dis-
played in enlarged form.

In this procedure, the aspect ratio of the selected section is adapted to
the oscilloscope display:

1. Hold down the CTRL key.
2. Click in the display and hold down the mouse button.
3. Move the mouse over the desired section. A gray rectangle is dis-

played. The size and the aspect ratio can be changed by moving the
mouse.

4. Release the mouse button. The contents of the gray rectangle are dis-
played in enlarged form.

Restoring the default view:

1. Right-click in the display.
2. Select Fit to view from the context menu.

15.2.10 Creating a screenshot of the oscilloscope display

Procedure

Creating a screenshot in the clipboard:

1. Right-click in the display.
2. Select Copy screenshot from the context menu.

Creating and saving the screenshot:

1. Right-click in the display.
2. Select Save screenshot from the context menu. A window opens in

which the target directory can be selected. The screenshot is saved
there as a PNG file.

15.3 Recording network traffic

This functionality is only available for robot controllers with version 8.3
or higher.

Description

WorkVisual can record the communication data of the Ethernet-based in-
terfaces of the robot controller, e.g. PROFINET, EtherCAT and EtherNet/IP.
WorkVisual saves the recording in a PCAP file. The default directory is C:
\User\Username\My Documents. The directory and file name may be
changed.
PCAP files can be displayed using software for the analysis of network
communication connections (“sniffer” software). Sniffer software is not in-
cluded in the scope of supply of WorkVisual.
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Precondition

• Network connection to the real robot controller
• The active project has been loaded from the real robot controller.
• The robot controller has been set as the active controller in WorkVisu-

al.

Procedure

1. If desired: in the bus structure of the project, select the element
whose interface data are to be recorded. The interface is then auto-
matically preselected later.

2. Click on the Perform network capture... button. The Select the net-
work interface window is opened.
(>>> Fig. 15-9)

3. Select the desired interface, if not already preselected.
4. If required: select the filter criteria.
5. Click on Next >.
6. To start recording, click on Start.

A progress bar and a counter display the quantity of data recorded.
The memory capacity is limited to 5 MB. If more data are recorded,
the ring buffer is activated, i.e. the oldest data is progressively discar-
ded and replaced by the newest incoming data.

• As the memory fills for the first time, the progress bar grows to
visualize how full the memory is.

• When the ring buffer is activated, the text Ring buffer active is
displayed. A green light now moves along the progress bar.

7. To stop recording, click on Stop.
If required, recording can be started again via Restart. The existing
data are then discarded.

8. To save the recording, click on Next > after stopping. The target direc-
tory and file name are displayed. The directory and file name may be
changed.

9. Click on Next >. The recording is saved and the text Import success-
ful is displayed.

10. Click on Close.

Select the network interface

Fig. 15-9: “Select the network interface” window
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Box Description

Network interface Select the interface whose communication da-
ta are to be recorded.

Ethertype Here the data to be recorded can be limited to
a particular type. If no limit is desired, select
All.

Protocol This box is only displayed if either IPv4 or
IPv6 is selected under Ethertype.

Here the data to be recorded can be limited to
a particular protocol. If no limit is desired, se-
lect All.

MAC address The data to be recorded can be limited to a
particular MAC address. If no limit is desired,
leave the box blank.

15.4 Displaying messages and system logs of the robot controller

This functionality is only available for robot controllers with version 8.3
or higher.

Description

The messages displayed in the message window on the smartHMI can al-
so be displayed in WorkVisual. Messages generated by PROFINET or its
field bus devices contain links in WorkVisual. These so-called “diagnostic
links” guide the user to other areas of WorkVisual and help to trace the
cause of the message.
In addition, the system logs of the robot controller can be displayed, i.e.
the entries in the log memory. A search function and numerous filters are
available here.

Precondition

• Network connection to the real robot controller
• The real robot controller and the KUKA smartHMI are running.
• Programming and diagnosis workspace

Procedure

1. In the Cell view window, select the desired robot controller by activat-
ing the check box. It is also possible to select more than one control-
ler.

2. Select the menu sequence Editors > Log view. The Log view win-
dow opens. An entry is displayed for each robot controller selected.

3. Click on an entry to expand it. The following tabs are now displayed:

• MessageLogs: Displays the messages of this robot controller.
(>>> 15.4.1 "MessageLogs tab" Page 211)

• SystemLogs: Displays the log entries of this robot controller.
(>>> 15.4.2 "“SystemLogs” tab" Page 212)
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15.4.1 MessageLogs tab

Fig. 15-10: Log view with “MessageLogs” tab

Item Description

1 Click here (or on any part of the gray area) to expand or col-
lapse the entry.

The MessageLogs and SystemLogs tabs are visible when the
entry is expanded.

2 Message counter

The message counter indicates how many messages of each
message type are active.

3 Information about the robot controller and the active project

While the connection to the robot controller is being establish-
ed, a lamp flashes next to the name of the active project. It
disappears when the connection is established.

4 Status of the lamp:

• Green: A connection has been established to the real robot
controller.

• Red: The connection to the real robot controller is termina-
ted.

5 The messages displayed in the message window on the
smartHMI are displayed here.

• If a message is acknowledged in the message window, it is
also acknowledged here in MessageLogs.

• If a message is acknowledged here in MessageLogs, it is
not acknowledged in the message window!

Messages may contain diagnostic links.

Diagnostic links

Messages generated by PROFINET or its field bus devices contain links
in WorkVisual. These so-called “diagnostic links” guide the user to other
areas of WorkVisual and help to trace the cause of the message.
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For the links Online device diagnosis and Profinet device list, the fol-
lowing applies:

• If the active project has not yet been loaded from the robot controller,
this is now done automatically. This is preceded by a request for con-
firmation.

• If another project is open, this is closed. If it contains unsaved
changes, a dialog is displayed, asking whether these changes should
be saved.

Diagnostic link Description

Diagnostic monitor The link opens the diagnostic monitor. The device from which
the message comes is automatically selected in the module
overview.

Online device diagnosis The link sets the device causing the error to “Connected”,
opens the Diagnosis… window and displays the Device di-
agnosis tab.

Profinet device list The link sets the PROFINET node to “Connected”, opens the
Device list and PROFINET names... window and displays
the Available devices tab.

Information about the above-mentioned windows can be found in the
documentation KR C4 PROFINET.

15.4.2 “SystemLogs” tab

Fig. 15-11: SystemLogs

Item Description

1 Here the system logs can be searched for one or more search
terms. Upper and lower case are ignored. The order in which
the search terms are entered in the search box is irrelevant. It
is not necessary to search for complete words.

Examples:

• tick syst also finds entries containing system tick.
• tick tick also finds entries in which tick occurs only once.

2 Filter: severity of the entry

To set or remove a filter, expand the selection box and activate
or deactivate the check boxes.

3 Filter: origin of the entry
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Item Description
To set or remove a filter, expand the selection box and activate
or deactivate the check boxes.

4 • Display none: Removes all filters.
• Show all: Sets all filters.

This button has no effect on the search box.

5 System logs of the robot controller

15.5 Displaying diagnostic data about the robot controller

Description

The diagnostic functionality makes it possible to display a wide range of
diagnostic data concerning numerous software modules of a robot control-
ler. The parameters displayed depend on the selected module. The dis-
play includes states, fault counters, message counters, etc.

Examples of modules:

• Motherboard driver
• smartPAD driver
• Network system

“Lamps” indicate the status of the parameters, etc.:

• Green: Status OK
• Yellow: Status critical, could be faulty
• Red: Error

Precondition

• Network connection to the real robot controller
• The real robot controller and the KUKA smartHMI are running.
• Programming and diagnosis workspace

Procedure

1. In the window Cell view, activate the check box for the desired robot
controller. It is also possible to select more than one controller by acti-
vating the check boxes.

2. Select the menu sequence Editors > Diagnostic monitor. The Diag-
nostic monitor window opens.

3. An entry is displayed for each robot controller selected. Click on an
entry to expand it.

4. Select a module on the right side under Module. Diagnostic data are
displayed for the selected module (>>> Fig. 15-12).
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Fig. 15-12: Diagnostic monitor

Item Description

1 Click here (or on any part of the gray area) to expand or collapse the entry.

2 Information about the robot controller and the active project

While the connection to the robot controller is being established, a lamp flashes
next to the name of the active project. It disappears when the connection is estab-
lished.

3 This lamp indicates the status of the robot controller:

• Red: When the status of at least one module is red.
• Yellow: When the status of at least one module is yellow and no module is red.
• Green: When the status of all modules is green.

4 Exports the chronological series of values to a LOG file. The values are sorted by
time stamp. The time stamps start from the time at which the Diagnostic monitor
was opened.

5 Module overview. Lamps indicate the status of the modules:

• Red: When the status of at least one parameter is red.
• Yellow: When the status of at least one parameter is yellow and no parameter is

red.
• Green: When the status of all parameters is green.

6 Graphic display of values over time

Values to which a color has been assigned are displayed. If a different module is
marked, the curves of the previous module are retained in the diagram. This makes
it possible to compare graphs from different modules.

The Clear all button resets all color settings to Transparent and removes all curves
from the diagram.
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Item Description
If the mouse pointer is moved over the diagram, the X and Y coordinates of the
mouse pointer position are displayed. A context menu is available in the diagram,
allowing the following actions:

• Adapting the size of the diagram so that the entire curve is displayed
• Creating a screenshot in the clipboard
• Saving the screenshot
• Opening the help function

The help function contains useful information about zooming and keyboard short-
cuts.

7 Diagnostic data about the selected module. Lamps indicate the status of the param-
eters:

• Red: If the value lies outside of the range defined in the red box in the Limit
values column.

• Yellow: If the value lies outside of the range defined in the yellow box in the
Limit values column.

• Green: If the value lies within the range defined in the yellow box in the Limit
values column.

Diagnostic data:

Column Description

Name Diagnosed parameter

Value Current value of the diagnosed parameter

Extreme val-
ues

• Upper value: Maximum diagnosed value
• Lower value: Minimum diagnosed value

The extreme values refer to the time since the diagnosis window was
opened, unless the user clicks on the Refresh button (= green double ar-
row): determination of the extreme values then starts again.

Unit If there is a unit associated with a parameter, this is displayed here. In
some cases, the units can be changed (e.g. from seconds to milliseconds).

Limit values This column partly contains default values. The values can be changed/
specified by the user.

Yellow box:

• Upper value: If this value is exceeded, the parameter is marked yellow.
• Lower value: If the current value falls below this value, the parameter is

marked yellow.

Red box:

• Upper value: If this value is exceeded, the parameter is marked red.
• Lower value: If the current value falls below this value, the parameter is

marked red.

Color Color of the curve

15.5.1 Diagnostic data for the transfer application module

Name Description

Initialized • Yes: The transfer application is connected to all con-
nected field buses. Data exchange is taking place.
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Name Description

• No: No configured field bus device is present.

Number of transferred bits Number of bits configured

Cycle time of the transfer data
[ms]

Current cycle time of the transfer application

Processor load [%] CPU load caused by the transfer application

Driver name Name of the driver

Bus name Name of the field bus

Bus status • OK: Status OK
• Error: The field bus has an error

Bus connected • Yes: The connection to the field bus is established
• No: No connection to the field bus

15.6 Displaying online system information

Precondition

• Programming and diagnosis workspace

Procedure

1. In the Cell view window, activate the check box for the desired robot
controller. The robot controller is now selected. It is also possible to
select more than one robot controller.

2. Select the menu sequence Editors > System information editor.
The Online system information window opens. An entry is displayed
for each robot controller selected.

Description

Fig. 15-13: “Online system information” window

Column Description

Controller Info Information about the robot controller is displayed
here.

Robot info Information about the robot is displayed here.

Controller sta-
tus

Shows the status of the Submit interpreter and robot
interpreter and the operating mode.

The status displays correspond to the status displays
on the KUKA smartHMI. Information about this can
be found in the operating and programming instruc-
tions for the KUKA System Software (KSS).
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Column Description

Project Info Information about the active project is displayed
here.

Options The installed option packages are displayed here.

Option packages for which the check box is activa-
ted can be downloaded to any directory using the
command Download selected options.

Commands Edit: Opens the Device properties window.

Create archive: Opens the Generate archives win-
dow. (The data for this robot controller can be ar-
chived.)

Download selected options: Opens a window in
which the path to the selected option packages can
be selected. Clicking on OK saves the option pack-
ages at the selected location.

Button Description

Archive all Create archive: Opens the Generate archives win-
dow. (The data for all robot controllers selected in
the Cell view window can be archived.)

Device properties window:

Fig. 15-14: “Device properties” window

Item Description

1 The name of the robot controller can be changed here.

2 The name of the robot can be changed here.

3 A description can be entered here for information purposes.

4 Check box active: If OK is pressed, the RDC data are trans-
ferred to the RDC memory from D:\BackupAll.zip.

Generate archives window:

Fig. 15-15: “Generate archives” window
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Item Description

1 The name of the robot controller is displayed here.

If the window was opened via the Archive all button, all the
robot controllers selected in the Cell view window are dis-
played here.

2 Check box active: The log data are also archived.

Check box not active: The log data are not archived.

3 A target directory for the archive can be selected here.

A ZIP file is generated as an archive for each robot controller.
The name of ZIP file always contains the name of the robot
and the robot controller.
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16 KUKA Service

16.1 Requesting support

Introduction

This documentation provides information on operation and operator con-
trol, and provides assistance with troubleshooting. For further assistance,
please contact your local KUKA subsidiary.

Information

The following information is required for processing a support re-
quest:

• Description of the problem, including information about the duration
and frequency of the fault

• As comprehensive information as possible about the hardware and
software components of the overall system
The following list gives an indication of the information which is rele-
vant in many cases:

‒ Model and serial number of the kinematic system, e.g. the manip-
ulator

‒ Model and serial number of the controller
‒ Model and serial number of the energy supply system
‒ Designation and version of the system software
‒ Designations and versions of other software components or modifi-

cations
‒ Diagnostic package KRCDiag

Additionally for KUKA Sunrise: Existing projects including applica-
tions
For versions of KUKA System Software older than V8: Archive of
the software (KRCDiag is not yet available here.)

‒ Application used
‒ External axes used

16.2 KUKA Customer Support

Availability

KUKA Customer Support is available in many countries. Please do not
hesitate to contact us if you have any questions.

Argentina
Ruben Costantini S.A. (Agency)
Luis Angel Huergo 13 20
Parque Industrial
2400 San Francisco (CBA)
Argentina
Tel. +54 3564 421033
Fax +54 3564 428877
ventas@costantini-sa.com
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Australia
KUKA Robotics Australia Pty Ltd
45 Fennell Street
Port Melbourne VIC 3207
Australia
Tel. +61 3 9939 9656
info@kuka-robotics.com.au
www.kuka-robotics.com.au

Belgium
KUKA Automatisering + Robots N.V.
Centrum Zuid 1031
3530 Houthalen
Belgium
Tel. +32 11 516160
Fax +32 11 526794
info@kuka.be
www.kuka.be

Brazil
KUKA Roboter do Brasil Ltda.
Travessa Claudio Armando, nº 171
Bloco 5 - Galpões 51/52
Bairro Assunção
CEP 09861-7630 São Bernardo do Campo - SP
Brazil
Tel. +55 11 4942-8299
Fax +55 11 2201-7883
info@kuka-roboter.com.br
www.kuka-roboter.com.br

Chile
Robotec S.A. (Agency)
Santiago de Chile
Chile
Tel. +56 2 331-5951
Fax +56 2 331-5952
robotec@robotec.cl
www.robotec.cl

China
KUKA Robotics China Co., Ltd.
No. 889 Kungang Road
Xiaokunshan Town
Songjiang District
201614 Shanghai
P. R. China
Tel. +86 21 5707 2688
Fax +86 21 5707 2603
info@kuka-robotics.cn
www.kuka-robotics.com
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Germany
KUKA Deutschland GmbH
Zugspitzstr. 140
86165 Augsburg
Germany
Tel. +49 821 797-1926
Fax +49 821 797-41 1926
Hotline.robotics.de@kuka.com
www.kuka.com

France
KUKA Automatisme + Robotique SAS
Techvallée
6, Avenue du Parc
91140 Villebon S/Yvette
France
Tel. +33 1 6931660-0
Fax +33 1 6931660-1
commercial@kuka.fr
www.kuka.fr

India
KUKA India Pvt. Ltd.
Office Number-7, German Centre,
Level 12, Building No. - 9B
DLF Cyber City Phase III
122 002 Gurgaon
Haryana
India
Tel. +91 124 4635774
Fax +91 124 4635773
info@kuka.in
www.kuka.in

Italy
KUKA Roboter Italia S.p.A.
Via Pavia 9/a - int.6
10098 Rivoli (TO)
Italy
Tel. +39 011 959-5013
Fax +39 011 959-5141
kuka@kuka.it
www.kuka.it
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Japan
KUKA Japan K.K.
YBP Technical Center
134 Godo-cho, Hodogaya-ku
Yokohama, Kanagawa
240 0005
Japan
Tel. +81 45 744 7531
Fax +81 45 744 7541
info@kuka.co.jp

Canada
KUKA Robotics Canada Ltd.
6710 Maritz Drive - Unit 4
Mississauga
L5W 0A1 
Ontario
Canada
Tel. +1 905 670-8600
Fax +1 905 670-8604
info@kukarobotics.com
www.kuka-robotics.com/canada

Korea
KUKA Robotics Korea Co. Ltd.
RIT Center 306, Gyeonggi Technopark
1271-11 Sa 3-dong, Sangnok-gu
Ansan City, Gyeonggi Do
426-901
Korea
Tel. +82 31 501-1451
Fax +82 31 501-1461
info@kukakorea.com

Malaysia
KUKA Robot Automation (M) Sdn Bhd
South East Asia Regional Office
No. 7, Jalan TPP 6/6
Taman Perindustrian Puchong
47100 Puchong
Selangor
Malaysia
Tel. +60 (03) 8063-1792
Fax +60 (03) 8060-7386
info@kuka.com.my
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Mexico
KUKA de México S. de R.L. de C.V.
Progreso #8
Col. Centro Industrial Puente de Vigas
Tlalnepantla de Baz
54020 Estado de México
Mexico
Tel. +52 55 5203-8407
Fax +52 55 5203-8148
info@kuka.com.mx
www.kuka-robotics.com/mexico

Norway
KUKA Sveiseanlegg + Roboter
Sentrumsvegen 5
2867 Hov
Norway
Tel. +47 61 18 91 30
Fax +47 61 18 62 00
info@kuka.no

Austria
KUKA CEE GmbH
Gruberstraße 2-4
4020 Linz
Austria
Tel. +43 732 784 752 0
Fax +43 732 793 880
KUKAAustriaOffice@kuka.com
www.kuka.at

Poland
KUKA Roboter CEE GmbH Poland
Spółka z ograniczoną odpowiedzialnością
Oddział w Polsce
Ul. Porcelanowa 10
40-246 Katowice
Poland
Tel. +48 327 30 32 13 or -14
Fax +48 327 30 32 26
ServicePL@kuka-roboter.de

Portugal
KUKA Robots IBÉRICA, S.A.
Rua do Alto da Guerra n° 50
Armazém 04
2910 011 Setúbal
Portugal
Tel. +351 265 729 780
Fax +351 265 729 782
info.portugal@kukapt.com
www.kuka.com
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Russia
KUKA Russia OOO
1-y Nagatinskiy pr-d, 2
117105 Moskau
Russia
Tel. +7 495 665-6241
support.robotics.ru@kuka.com

Sweden
KUKA Svetsanläggningar + Robotar AB
A. Odhners gata 15
421 30 Västra Frölunda
Sweden
Tel. +46 31 7266-200
Fax +46 31 7266-201
info@kuka.se

Switzerland
KUKA Roboter CEE GmbH
Linz, Zweigniederlassung Schweiz
Heinrich Wehrli-Strasse 27
5033 Buchs
Switzerland
Tel. +41 62 837 43 20
info@kuka-roboter.ch

Slovakia
KUKA CEE GmbH
organizačná zložka
Bojnická 3
831 04 Bratislava
Slovakia
Tel. +420 226 212 273
support.robotics.cz@kuka.com

Spain
KUKA Iberia, S.A.U.
Pol. Industrial
Torrent de la Pastera
Carrer del Bages s/n
08800 Vilanova i la Geltrú (Barcelona)
Spain
Tel. +34 93 8142-353
comercial@kukarob.es
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South Africa
Jendamark Automation LTD (Agency)
76a York Road
North End
6000 Port Elizabeth
South Africa
Tel. +27 41 391 4700
Fax +27 41 373 3869
www.jendamark.co.za

Taiwan
KUKA Automation Taiwan Co. Ltd.
1F, No. 298 Yangguang ST.,
Nei Hu Dist., Taipei City, Taiwan 114
Taiwan
Tel. +886 2 8978 1188
Fax +886 2 8797 5118
info@kuka.com.tw

Thailand
KUKA (Thailand) Co. Ltd.
No 22/11-12 H-Cape Biz Sector Onnut
Sukhaphiban 2 road, Prawet
Bangkok 10250
Thailand
Tel. +66 (0) 90-940-8950
HelpdeskTH@kuka.com

Czech Republic
KUKA Roboter CEE GmbH
organizační složka
Pražská 239
25066 Zdiby
Czech Republic
Tel. +420 226 212 273
support.robotics.cz@kuka.com

Hungary
KUKA HUNGÁRIA Kft.
Fö út 140
2335 Taksony
Hungary
Tel. +36 24 501609
Fax +36 24 477031
info@kuka-robotics.hu
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USA
KUKA Robotics Corporation
51870 Shelby Parkway
Shelby Township
48315-1787 
Michigan
USA
Tel. +1 866 873-5852
Fax +1 866 329-5852
info@kukarobotics.com
www.kukarobotics.com

UK
KUKA Robotics UK Ltd
Great Western Street
Wednesbury West Midlands
WS10 7LL
UK
Tel. +44 121 505 9970
Fax +44 121 505 6589
service@kuka-robotics.co.uk
www.kuka-robotics.co.uk
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Auto-complete...............................................156

B
BASE coordinate systems..............................57
BASE coordinate systems, changing the num-
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Button bar, KRC Explorer............................ 164
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Catalog scan...................................................36
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Cell configuration (window)............................30
Cell definition, configuring..............................66
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Cells, editing...................................................66
Changes, loading..........................................168
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CK................................................................... 11
Close, project..................................................35
Close, WorkVisual.......................................... 35
Code generation...........................................177
Code generation, configuring.........................98
Communication parameters, safety-relevant....
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Comparison, configuring.................................97
Comparison, safety configuration.................112
Configuration, devices.................................. 116
Configuration, field bus master.................... 115
Configuration, KRC Explorer........................166

Configuring keyboard shortcuts..................... 96
Configuring, KRL Editor............................... 149
Connecting, with robot controller................. 100
Controller bus............................................... 134
Copy, project...................................................34

D
Data format...................................................120
Data, copying (from a different project)...... 189
Data, copying (with additional editor)....63, 170
Data, copying (with WorkVisual)........... 64, 170
Debugging.....................................................171
Debugging mode.......................................... 171
Debugging mode, ending.............................176
Debugging mode, overview......................... 172
Debugging mode, starting............................173
Defining cells online....................................... 65
Device settings, checking.............................136
Devices from option package, adding........... 73
Devices, configuration.................................. 116
Devices, inserting into bus...........................116
Diagnosis...................................................... 194
Displaying/hiding windows..............................21
DTM................................................................ 11

E
Editing, long texts.........................................131
EDS file.................................................... 32, 36
Element, inserting...........................................38
Element, removing..........................................39
Export, bus configuration............................. 129
Export, long texts......................................... 132
Export, safety configuration (SCG)..............109
Export, safety configuration (XML)...............112
Export, subproject...........................................94
Exporting, trace configuration...................... 197
External axes..................................................47
External axes, modifying values.................. 153

F
Fast entry, KRL............................................ 151
Fast Measurement inputs, option.................. 42
Field bus master, add...................................115
Field bus master, configuration....................115
Field bus, set-up...........................................114
Files, comparing (in KRC Explorer).............169
Files, comparing (in the project)....................63
Filtering, signals............................................123
Finding a declaration, variable.....................157
Finding uses, variable.................................. 157
Firmware version............................................41
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FSoE address...............................................139
FSoE slave address.....................................139
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Graphical user interface.................................20
Graphical user interface, overview................ 20
Graphics card................................................. 16
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H
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I
I/O Mapping (window)..........................122, 123
Import, device description files...................... 35
Import, long texts..........................................131
Import, safety configuration (SCG).............. 109
Import, safety configuration (XML)...............110
Importing, subproject......................................94
Importing, trace configuration.......................196
Importing, trace recording............................ 203
Inserting, external axis................................... 47
Inserting, robot................................................41
Insertion, devices into bus........................... 116
Inspection plan, creating................................ 76
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Installation, WorkVisual.................................. 16
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K
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Kinematic system, exporting.......................... 54
Kinematic systems, comparing...................... 51
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KRC Explorer, configuring............................166
KRC Explorer, creating a file....................... 167
KRC Explorer, edit functions........................166
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KUKA Customer Support............................. 219
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Machine data, parameters............................. 51
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Measurement data, copying...........................62
Measurement data, pasting............................62
Menu bar........................................................ 20
Messages (window)................................. 21, 28
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Multiprog.................................................16, 123

N
Network traffic, recording............................. 208
Number of I/Os...............................................41

O
Object, exporting............................................ 61
Object, importing............................................ 62
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Objects, repositioning.....................................30
Open source................................................... 11
Operation........................................................ 32
Operator safety acknowledgement......102, 103
OPS.................................................................11
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Option package, uninstalling..........................70
Option package, updating.............................. 70
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Option profile, activating.................................69
Option profile, creating...................................69
Option profiles................................................ 67
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Overview, graphical user interface................ 20

P
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Peripheral contactor.............................102, 103
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Printing, I/O connections................................99
Printing, information about the configuration.99
Printing, long texts..........................................99
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KUKA.WorkVisual 5.0

228/230 | www.kuka.com KST WorkVisual 5.0 V7 | Issued: 12.07.2018

Index
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Project information, saving.............................34
Project structure (window)....................... 20, 29
Project, new....................................................33
Project, open.................................................. 32
Project, saving................................................34
Project, transferring to the robot controller. 180
Project, updating...........................................192
Properties (window)........................................21

Q
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R
RAM................................................................ 16
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Robot controller, inserting.............................. 39
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S
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Safety configuration, resetting......................113
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Searching, signals........................................ 127
Setting to active, robot controller...................40
Setting to inactive, robot controller................40
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Snippets........................................................ 151
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Standstill monitoring..................................... 104
Start-up......................................................... 100
Starting, WorkVisual....................................... 32
Subproject.......................................................94
Support request............................................219
System requirements, PC.............................. 16
System requirements, robot controller...........16
System requirements, software......................16

T
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TOOL coordinate systems, editing................ 55
TOOL coordinate systems, importing............ 60
TOOL coordinate systems, modifying..........155
TOOL coordinate systems, updating............. 60
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Tool/base management, opening...................55
Trace.............................................................195
Trace configuration, modifying default settings
...................................................................... 197
Trace, configuration......................................196
Trace, displaying data.................................. 204
Trace, starting...............................................196
Trace, state...................................................199
Trademarks..................................................... 11
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Transfer application, diagnostic data........... 215
Transfer application, setting the cycle time...42
Transformer, option........................................ 42

U
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Update bundle, adding and configuring instruc-
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Update bundle, adding and configuring option
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Update bundles, changing settings............... 88
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User interface, KRL Editor...........................148

V
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